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Contacting the Sonardyne Support Team

24-hour Emergency Telephone Helpline: +44 (0) 1252 877600

The Sonardyne 24-hour helpline is answered at the UK Headquarters during normal office hours
(08:00 to 17:00). Outside these hours, your call is automatically transferred to an agency, which logs
the details of your emergency and alerts the appropriate Sonardyne personnel.

Our aim is to make sure emergency requests are dealt with immediately during office hours, and are
responded to within 30 minutes at all other times.

Please note the helpline is for emergency use only.

If you require non-emergency product support, please contact your nearest Sonardyne office.
Alternatively, contact the Sonardyne Head Office:

Sonardyne International Ltd
Blackbushe Business Park
Yateley

Hampshire

GU46 6GD

United Kingdom

Telephone: +44 (0) 1252 872288
Fax: +44 (0) 1252 876100

Email: support@sonardyne.com

Note
Email and telephone support is available during normal UK office hours (08:00 to 17:00).
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Section 1 — Introduction

1.1 Scope of this Manual

This user manual defines the safe installation, operation and maintenance of the 3™ generation Type
8084 SPRINT system when operated with SPRINT software. If the SPRINT 300/500/700 is to be
integrated within a subsea vehicle for ROV/AUV control, refer to the IM-8084 Integration Guide for
Lodestar and SPRINT products.

1.2 Purpose of this Manual

This user manual contains information for anyone involved in SPRINT INS/AHRS operations. This
manual includes technical information to configure, operate and maintain SPRINT INS/AHRS and
specific information concerning SPRINT 300/500/700 inertial systems supplied by Sonardyne.

To make sure the safety of the installer and operator is maintained it is important that all warnings and
cautions in Section 2 "Safety” of this manual and in any additional manuals are read and fully
understood.

1.3 U.S. Department of Commerce License

This product contains U.S. Department of Commerce controlled items. As such the SPRINT
300/500/700 must not be removed from the housing, be disassembled or repaired, outside of the
terms and conditions detailed in the U.S. Department of Commerce Re-Export Licence under which
the product was sold. If any servicing or repair of the SPRINT 300/500/700, or SPRINT 300/500/700
component of the product is required, consult your nearest Sonardyne office for advice.

1.4 Related Publications

To make sure the equipment is operated safely, a Sonardyne Safety Manual is supplied with this user
manual. Itis important that the Sonardyne Safety Manual is read and fully understood before
proceeding with any activity on the equipment.

Table 1-1 Related Publications

Publication Title

Sonardyne Safety Manual Operational and Safety Precautions

UM-8084-101 Lodestar Hardware Manual

UM-8084-109 Lodestar AHRS Messages

UM-8084 Integration Guide for Lodestar and SPRINT

UM-8025 User Manual for Fusion LBL

UM-0250 User Manual for Marksman

UM-8251 User Manual for Ranger 2

UM-8254 Acoustically Aided INS QC and Post Processing Tool
UM-8300-099 User Manual for 6G Terminal Lite

1.5 Conventions

Table 1-2 Conventions used in this Manual

Format Conventions

Section 1 — Introduction 1
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Table 1-2 Conventions used in this Manual (continued)

Boldface Type User Input, Menu Options, Keys, e.g. Click OK
Italic Type References to Figures, Tables, Sections and other internal/external source
Arrow (>) Selection of an additional menu item e.g. File>Save

Section 1 — Introduction 2
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Section 2 — Safety

2.1 Introduction

Before any activity is carried out on this system, it is recommended that the included Sonardyne Safety
Manual and all warnings and cautions in this manual are read and fully understood.

Itis recommended that the operator complies with the Health and Safety Regulations applicable to the
vessel and the region before operating this equipment.

Operators and service personnel must be familiar with the normal operating and safety procedures for
the subsea equipment being operated.

Documentation must be consulted whenever a A or A warning symbol is found on the equipment,
in order to determine the nature of the potential hazard and any actions which must be taken.

If any additional equipment is used with this system, any warnings and cautions in the equipment user
manual must be read and fully understood.

If the equipment is used in a manner not specified by the manufacturer, the protection provided by the
equipment may be impaired.

The safety of any system incorporating this equipment is the responsibility of the assembler of the
system.

2.2 Safety Procedures
2.2.1 Warnings

A Personal protection. Appropriate protective equipment such as protective footwear, hard hat and
gloves must be worn when handling or carrying out any procedures involving Sonardyne and other
equipment.

A Heavy equipment. Many Sonardyne products and equipment types, such as transponders,
transceivers, cable drums etc. require Manual Handling Equipment (MHE) for lifting due to their heavy
weight. If MHE is not available, it is the responsibility of the operator to perform a manual handling
risk assessment prior to carrying out manual lifting/handling. Refer to the individual equipment
documentation for weight specifications.

A Risk of crush injury. Do not stand underneath suspended equipment.

A Dismanting. This instrument must only be accessed internally and dismantled by qualified
Sonardyne personnel.

Risk of toxic gases and Corrosive Liquids. Do not stand in direct line with the end of the unit
when operating the pressure relief vent valve. Sudden release of high pressure gases could cause
injury to personnel. Wear Personal Protective Equipment such as goggles when operating the
pressure relief vent valve.

A High internal pressure. Make sure the Pressure Relief Vent Valve is manually operated to release
any internal pressure before attempting to dismantle the equipment.

A Ensure the work environment is well ventilated. Toxic gases may be released when operating the
pressure relief vent valve.

A High internal pressure. Due to the high internal pressure risk, dismantling the sub-sea equipment
must only be carried out by trained personnel.
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A Risk of burns. Do not carry out maintenance if the housing is hot. Lower the instrument into cold
water and wait for the housing to cool.

A Lithium-ion Battery Pack. This instrument contains a backup lithium-ion battery pack. Refer to
the Sonardyne Safety Manual for safety information for lithium-ion batteries.

2.2.2 Cautions

A Risk of equipment damage. All instruments must be maintained according to their individual
operating manuals. Failure to follow recommended procedures could result in instrument failure, and
loss of system integrity.

A Molykote 44 is a mild irritant. When lubricating the connector faces, personal protective
equipment such as gloves and goggles must be worn.

A Incorrect Power Supply. Make sure the SPRINT 300/500/700 is supplied with 24 V dc only. Do not
use an ac power supply.

A Damage to connectors. Failure to clean sand or silt correctly could result in damage to the
connectors and O-ring seals.

A SPRINT 300/500/700 mounting angles. It is strongly recommended the SPRINT 300/500/700
mounting angles are not modified while the SPRINT 300/500/700 is in operation as an AHRS device.
When any changes are applied the user will be prompted to reset the SPRINT 300/500/700 AHRS
algorithm and it will be several minutes before the Lodestar output is settled.

A Restoring factory settings. If factory settings are restored all previous user defined settings in
SPRINT 300/500/700 will be lost. It is recommended to note any required settings before restoring
factory settings.

A If connected to the SPRINT 300/500/700 via the Ethernet port and you wish to change the IP
address or subnet mask, it is strongly recommended that after changing the values the configuration
application is closed. Reconnect using the new IP address by adding it in the Ethernet Connection
Settings and then click "Connect". It also recommended that the SPRINT 300/500/700 is restarted.

A Risk of equipment malfunction. Mandatory software, embedded software and firmware update
notices must be applied as soon as practically possible.

Section 2 — Safety 4



UM-8253-SPRINT
Issue A3

User Manual for Type 8253 SPRINT 3rd Generation

Section 3 — Technical Description

3.1 Introduction

Sonardyne International Limited has applied its comprehensive experience in producing advanced
and dependable marine solutions to the development of the SPRINT 300/500/700 Attitude and
Heading Reference System (AHRS)/Inertial Navigation System (INS).

The SPRINT 300/500/700 is a solid state AHRS/INS that includes three Ring Laser Gyroscopes
(RLGs) and three linear accelerometers. These inertial-grade components provide raw data to the
Sonardyne-developed gyrocompass algorithm, which uses them to produce a full range of accurate
real-time motion and attitude measurements in all sea states.

Developed originally to provide accurate heading and attitude measurements for Sonardyne’s family
of acoustic positioning systems, SPRINT 300/500/700 is equally suited to a variety of other
applications where the accuracy of heading and attitude measurements is of critical importance.
SPRINT 300/500/700 can operate either as a stand-alone AHRS or as part of an integrated system.

The SPRINT 300/500/700 provides the following as standard:
« Battery backup to maintain uninterrupted operation in the event of brief power failure
« 8 GB of internal memory.

« Upgrade capability to a full INS that provides additional outputs of position, velocity, orientation
and angular velocity at high update rates.

« Fast follow-up speed of 900° per second.

« Support for all industry standard telegrams.

o MTBF inertial sensors (RLG and Accelerometer) > 400,000 hours

« Flexible mounting arrangements

» Heave measurement accuracy the greater of 5 cm or 5% of measured heave.
« Robust heave algorithm.

» Data output through RS232 serial, RS485 serial or Ethernet interfaces.

The SPRINT 300/500/700 has undergone independent and exhaustive testing against an industry-
recognised reference and has proved capable of delivering accurate measurements in highly dynamic
marine environments.

The SPRINT 300/500/700 benefits from Sonardyne’s world-class manufacturing, support and training
organisation, which has a well-established record for providing trusted solutions.

3.2 Inertial Navigation

The Inertial Navigation System (INS) sensor outputs are combined mathematically to compute the
position, velocity and attitude of the vehicle. The output is extremely low noise and very accurate in the
short term but slowly degrades over time. Therefore it is necessary to seamlessly aid the INS with
complimentary acoustic positioning and other aiding sources.

Acoustic Aiding with Sonardyne’s latest Sixth Generation (6G®) vessel-based transceivers and
subsea beacons maximise the benefits of the system by providing the most precise and reliable
acoustic aiding input.
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Depending on the functionality level of the SPRINT system being used, various aiding options will be
available, whilst others may be disabled:

. USBL

. DVL

» Pressure Depth

» External Position

« Zero Velocity (ZUPT)
« LBL

3.2.1 USBL Aiding

The vessel-mounted USBL transceiver determines the range and bearing to an acoustic beacon fitted
to the subsea vehicle. Using vessel DGPS for position and VRU/MRU/AHRS for vessel motion
compensation, an absolute position for the vehicle mounted beacon is calculated by the USBL system.

This position is fed into the SPRINT system as an absolute positioning aiding input. Additionally, the
USBL system is synchronised to Coordinated Universal Time (UTC) to provide an accurate
timestamp. Whilst the use of Sonardyne USBL provides a tighter acoustic / inertial integration and the
best possible USBL positioning performance, the SPRINT system can accept position aiding from any
USBL system that uses correct time-stamped positions in an industry standard telegram. Although the
SPRINT system improves USBL system precision and short term accuracy, it will not resolve any
inherent systematic errors that are present. Users must therefore make sure the USBL system they
are using is correctly calibrated and recommended operating practices are observed, for example,
using regular sound velocity profiles.

3.2.2 Sparse LBL Aiding

In Sparse LBL operations, two or more (instead of four or five) beacons are deployed on the seabed
and their positions derived using ‘box-in’ or other top-down calibration techniques. With a known
beacon position, the INS can navigate in Sparse LBL mode using the ranges from one or more
seabed deployed beacon to acoustically aid the INS and constrain error growth in the absolute
position output. In this configuration, the vehicle mounted LBL transceiver (ROVNav 6)
communications will be routed to the vessel via the SPRINT 300/500/700 for optimal time stamping of
acoustic range data.

3.2.3 ZUPT (Zero Velocity) Aiding

In certain operational situations the subsea vehicle will be static (e.g. during average position fixes). In
these situations, particularly if there is risk of loss of other aiding, it is beneficial to be able to aid the INS
with ‘zero velocity’ updates to estimate inertial sensor errors. This feature is available in the

SPRINT system and is easily activated from the main user interface.

3.2.4 Vehicle-Mounted Sensor Aiding

The SPRINT system has the ability to use vehicle-mounted aiding sensors such as Doppler velocity
logs (DVL) and pressure/depth sensors. The use of these sensors provides further benefits for subsea
navigation such as the ability to provide precise and continuous navigation output even if external
acoustic positioning is lost for periods of time.

The SPRINT system does not need to be physically co-located with the Doppler Velocity Log or
integrated into the same housing. Only ‘coarse’ alignments and offsets from the INS to the DVL are
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needed from the user. Fine offsets and misalignments are then calculated in the field using a
calibration routine. This approach allows for more flexible mounting configurations to be considered.

3.3 Theory of Operation
3.3.1 Inertial Navigation

Inertial navigation is the computation of velocity, position and orientation from measurements of
acceleration and rotation.

Acceleration (velocity change) is measured by an orthogonal triad of accelerometers. Rotation
(angular change) is measured by an equally orthogonal triad of gyroscopes; see Section 3.3.2. The
composite mechanical structure is called the Inertial Sensor Assembly (ISA). An Inertial Measurement
Unit (IMU) is composed of the ISA and a processor that performs various forms of compensation
using e.g. factory calibration coefficients. The outputs of an IMU are compensated delta angles and
delta velocities typically at a rate of 100-200 Hz.

Inertial navigation is based on the dead-reckoning principle. INS velocity is computed from an initial
value by integration (see Figure 3—1) of acceleration over time. Similarly, position is computed from
velocity and orientation (attitude and heading) is computed from integration of measured rotation
(angular change).

Figure 3-1 Computation of Velocity via integration of Acceleration (1D example)**

acceleration

=> velocity
time

It can be imagined how a fixed error (bias) in acceleration when integrated will cause an error in
velocity that grows proportionally with time giving rise to quadratic with time error in position.

This simplified description of the inertial navigation process match fairly well in the short term
especially for stable platform INS where the accelerometers were physically pointed in fixed directions
(e.g. North, East and Down). In practise, the 3D vector mathematics are somewhat more involved,
especially for modern strap-down INS where the sensors are strapped onto the vehicle body.

**Velocity at time ‘' is the sum of the areas under the acceleration curve (yellow counts as negative)
plus the initial velocity at time t.

3.3.2 Inertial Sensors

Accelerometer

Most accelerometers used for inertial navigation are of the force-feedback pendulous type illustrated
in Figure 3—2. A proof mass at the end of a pivoted or flexible arm is balanced via feedback control
keeping its deflection close to zero. The coil current generating the counter acting force is a measure
of acceleration along the single axis of free movement.
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Figure 3-2 Force Feedback Pendulous Accelerometer

Pivot
; Torque Coils

WJ

O
Itis impossible to distinguish between true kinematic acceleration (velocity change relative to the
Earth) and gravity. A stationary accelerometer with its sensitive axis pointed up will measure +1g

even though it is obviously not moving anywhere. The term specific force is the sum of kinematic
acceleration and gravity and has been coined to express what an accelerometer really measures.

Gyroscope

Modern gyroscopes are based on a variety of different physical principles. Most navigation grade
gyroscopes are currently based on optics using the “Sagnac” effect to sense rotation, e.g. the Ring
Laser Gyro (RLG; see Figure 3-3):

Laser beams are made to travel in both opposite directions within a cavity (“ring”) formed by typically 3
or 4 mirrors. When the cavity rotates relative to inertial space one beam has to travel further than the
other. A part of the laser light is allowed to escape via a semi-transparent mirror and is used to form a
fringe pattern. Optical sensors count the direction and number of fringes passed which is a precise
(digital) measure of how much RLG has rotated relative to inertial space.

In a Fibre Optic Gyroscope (FOG) light travels through loops of optic fibre rather than a closed path.
Both RLG’s and FOG’s can achieve very high performance.

Other commonly used gyro technologies are:
» Conventional spinning metal gyroscope
« “Dynamically Tuned Gyro” (DTG). Ingenious compact mechanical strap down device.

« Hemispherical Resonator Gyro (HRG). Resonant device made of very high Q quartz (“Wine
glass”) — Coriolis force device

« Micro Electro-Mechanical Devices (MEMS) based gyros (Coriolis force)
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Figure 3-3 Ring Laser Gyroscope Principle of Operation
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3.3.3 Strap-down Inertial Navigation

The process of strap-down inertial navigation is shown in Figure 3—4. Vehicle orientation relative to the
Earth is maintained within the navigation computer via integration of measurements from the
gyroscope triad and is compensated for Earth rotation and vehicle motion over the surface of the
Earth. Known orientation is used to transform accelerometer specific force into a navigation frame
(often North-East-Down —NED).

Specific force is compensated for gravity and Coriolis force to obtain kinematic acceleration. Gravity is
computed using a mathematical model and is dependent on vehicle position on the Earth, most
importantly latitude and depth/height. Coriolis force is a “mathematical artefact” that arises and
requires compensations because the navigation frame rotate with the Earth and is therefore not a true
inertial frame (fixed relative to the stars). Finally, acceleration is integrated to obtain velocity and
velocity is integrated into position.

Typically the strap-down computations are set to execute at 100-200 Hz whereas the inertial sensors
may be sampled at several kHz. The raw rate is reduced using a coning and sculling algorithm that
e.g. very precisely takes into account the non-commutativity of rotations (sequence of rotations
matter).
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Figure 3—4 “Strap-Down” Inertial Navigation
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3.3.4 Errors in Inertial Navigation

The sources and error propagations in inertial navigation are complex and not always intuitive. The
initial part of Section 3.3. 1 describes how a constant error in acceleration would cause error in position
to grow with time squared. In a real INS with external aiding (as described in Section 3.3.8) a fixed
accelerometer bias would primarily cause an error in roll/pitch which would make gravity couple into
the horizontal plane by just enough to counteract the position drift.

Simulation techniques and tools are available for accurately predicting INS performance in various
scenarios and taking all significant error sources into account. Somewhat counter intuitively,
gyroscope errors in general play a more significant role than accelerometer errors.

3.3.5 Reference frames
A number of reference frames are used within inertial navigation.

Vehicle frame

Axes are along the vehicle axis, typically forward, starboard and down. The vehicle frame is typically
used for navigation outputs (e.g. roll, pitch and heading) and for defining various sensor lever arms
(“offsets”) and mounting angles.

IMU frame

Axes are along the inertial sensor axes as typically marked on the IMU/INS housing. IMU frame is
used for many INS internal computations.

Navigation frame

Frame used for the inertial navigation computation of position and velocity (most often local level e.g.
North, East and Down).

Inertial frame

Non-rotating frame (relative to inertial space).

Section 3 — Technical Description 10



UM-8253-SPRINT
Issue A3

User Manual for Type 8253 SPRINT 3rd Generation

Note

Definitions of SPRINT system(and SPRINT 300/500/700) specific reference frames are provided in
Appendix A "SPRINT 300/500/700 Angle Definitions " and Appendix B "Reference Frames and
Angular Conventions”.

3.3.6 Gyrocompassing — North Finding

An AHRS can determine its orientation (roll, pitch and heading) relative to the Earth by
“gyrocompassing”. Basically the direction of up/down and the Earth spin axis can be sensed using the
AHRS sensors.

For a slow moving (i.e. marine) vehicle, the measured acceleration (specific force) vector will point
“up”, i.e. the measured vector will be parallel with the local gravity vector (down). In practise,
measured acceleration is averaged (filtered) to cancel out effect of vehicle motion.

The local gravity vector will follow the rotation of Earth relative to inertial space; see Figure 3-5. The
direction of East can be determined by tracking the systematic change in the direction of the gravity
vector relative to inertial space over time. Knowing the direction of down and East allows the direction
of North and full orientation to be determined.

Figure 3-5 Earth Rotation

N Earth spin axis,
T (15 deg/hour)

The Earth rotates by just 15 deg/hour and the gyroscopes used for tracking the change of direction of
gravity must be accurate to considerably better values. Furthermore, it can be shown that the local
gravity vector direction changes only by the cosine of Latitude part of Earth rotation, i.e. change is
reduced towards the Poles. This explains why heading accuracy is typically specified as x.xxx degrees
* Secant Lat (secant = 1/ cosine).

Vehicle position change in the N/E direction (from, e.g. steaming) will cause the gravity vector to
change in this direction also and not be pure E/W. This will bias the gyro-compassing determined
heading if not compensated for by e.g. measurements from a GPS receiver.
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An inertial based Attitude and Heading Reference System use the described principles to generate
robust roll, pitch and heading.

3.3.7 Heave, Surge and Sway

The heave, or vertical motion of the vehicle in the Earth up direction, is determined by the double
integration of the vertical acceleration. A high pass filter is used to zero the systematic biases of the
vertical position, which are a characteristic of the internal sensors. Similarly, the horizontal motions of
the vehicle with zero mean in the forward and starboard axes respectively are surge and sway. Heave
is output with respect to the earth frame, rather than the vehicle frame; see Figure 3—6.

Figure 3-6 Heave Definition

UP

Heave is positive in the up
direction with respect to
the earth frame (RED).

It is not measured with
respect to the vertical (2)
axis of the vehicle
frame (BLUE in the
example of the vessel
below)

Some instruments on the vehicle may require heave compensation. Itis likely that few, if any, of these
instruments are installed very close to the centre of the vehicle frame, and so measurements of heave
with respect to the vehicle CRP or the SPRINT 300/500/700 may not be valid for those instruments.

If the SPRINT 300/500/700 has information about the offset distances to a remote instrument, then it
can calculate and supply measurements of remote heave for that instrument using remote vectors.
The remote output will resemble what would be output if the SPRINT 300/500/700 was installed in the
remote location. Note that the closer to the remote location the SPRINT 300/500/700 is situated, the
more accurate the output will be.
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3.3.8 Aided INS

The drift of a typical commercial airplane inertial system is in the order of 1 NMPH (Nautical Mile Per
Hour). This is adequate for guidance from one airport to another and e.g. crossing the Atlantic but
hardly useful for navigation of slow moving marine vehicles intended to do e.g. seabed mapping.

Improved performance can be achieved by Aiding the INS with measurements from one or more
external sensors; see Figure 3—7. IMU data feeds into two separate algorithms: AHRS and AINS. The
AHRS is used as a convenience for providing the AINS with initial estimates of attitude/heading
thereby simplifying its design.

The INS block is described in Section 3.3.3 and provides the position, orientation and velocity output.
The role of the error state Kalman filter is to estimate and compensate errors in the inertial navigation
and thereby constantly keep the INS on track, while monitoring the correction feed.

The Kalman filter determines INS errors from external sensor measurements. The difference
between a measurement (observation) and its expected value (based on the INS) is fed into the
Kalman filter and is used to refine its state vector and covariance matrix. The state vector is composed
of INS errors in position, orientation and velocity and often also key inertial sensor errors such as
gyroscope and accelerometer bias. Errors in external sensors can also be modelled for improved
performance.

The covariance matrix is the “memory” of the Kalman filter and it holds the uncertainty of each state
and the correlation between states. Useful performance metrics such as expected positioning
accuracy is extracted directly from the covariance matrix.

The Kalman filter manages asynchronous data and the considerable latency often found in acoustic
observations. An Aided INS is often referred to as a “hybrid inertial system”.

The combination of a DVL and INS provides accurate heading/attitude and the ability to perform dead-
reckoning to an accuracy of just a few meters per hour. This functionality is extremely useful for
subsea navigation. Further combination with USBL or (sparse) LBL provides absolute positioning that
is considerably more accurate and robust than acoustic positioning by itself.

Figure 3-7 SPRINT system Acoustically Aided INS Functional Block Diagram
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The INS aiding options available in SPRINT system are listed in Table 3—1. Only certain position
aiding inputs, such as USBL can be used to initialise Inertial Navigation and that these aiding inputs
must be UTC time synchronised.

Table 3-1 SPRINT INS Aiding Options

Aiding Aiding Type Aiding Considerations

Source
Position Aiding Velocity |Depth Aiding External Time Sync  |Can be used to
(Horizontal) Aiding (Vertical) Required? Initialise INS?

USBL v x v x v

LBL v x x x x

External v x v x v

Position

DVL x v x x x

Zero x v x x x

Velocity

Pressure x x v x x

Depth

External x x v x x

Depth

3.4 System Architecture

3.4.1 Architecture

The architecture of the SPRINT system is shown in Figure 3-8.
Figure 3-8 Logical SPRINT system Architecture

Navigation PC (192.168.179.100 |
Factory
Conflgurallon
User

Conflgurallon

SPRINT
Log Files

External Device(s) '

External Device(s) ‘

192.168.179.50

SD Card
Log File

The Navigation PC runs the SPRINT system software which comprises two components:
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« User Interface, which provides configuration, control and monitoring of the SPRINT
300/500/700 and SPRINT system.

« SPRINT system Server, which routes all communications between the SPRINT 300/500/700,
User Interface and any other topside external devices. The SPRINT server also logs all data
from the SPRINT 300/500/700 on the Navigation PC, including raw sensor feeds.

The optional Lodestar Communications Hub (LCH) is a serial device server and Ethernet hub used by
the Navigation PC. An Ethernet link is provided between the Navigation PC and the LCH (ports). For
this reason IP Addresses and Ports are used to specify serial as well as Ethernet devices connected to
the LCH. The IP addresses of each of the main system components are shown above but note that
the SPRINT 300/500/700 IP address will only be used if the SPRINT 300/500/700 is to be connected
to the topside components using an Ethernet connection.

External devices may be connected directly to the SPRINT 300/500/700 and Navigation Computer as
well as tothe LCH.

The SPRINT system stores the configuration of the SPRINT 300/500/700 and Software/Server. A
Factory (default) Configuration is provided as a starting point for setup. Thereafter a User
Configuration is stored by the software every time a configuration change is made or by user request.
Ifthe SPRINT 300/500/700 used by the SPRINT system is swapped, the software will prompt the
user to re-apply the User Configuration to the new SPRINT 300/500/700 to continue operation as
before.

As well as storing the log files in real time on the Navigation PC, the SPRINT 300/500/700 also stores
a rolling backup of all the log files on its onboard SD card. The size of the log data is variable
depending on the number/update rate of aiding sensors and also the number of outputs specified.
Typically for a USBL/DVL/Depth aided system, the log files are populated at the rate of 0.5 MB per
minute, which will provide over 10 days continuous onboard storage. The log files on the SPRINT
300/500/700 SD card can be retrieved offline using the PC Ultility software.

3.5 Physical Layout
A typical 4000 m SPRINT 300/500/700 with 4 x Seacon connectors is shown in Figure 3-9.
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Figure 3-9 Typical SPRINT 300/500/700 Layout

Alternate housing types and connector options are available; see Section 14 "Technical
Specifications'for descriptions of all versions.

3.6 Power

The SPRINT 300/500/700 is powered from an external 20 to 50 V dc power supply through the CP
port (26 V dc for FMC Schilling Seanet Connector variants). A power supply is not provided with the
SPRINT 300/500/700. See Section 14 "Technical Specifications" for power requirements.

3.7 Power Pass Through

The SPRINT 300/500/700 is capable of passing through input power (20 to 50 V dc from an external
power supply) to sensors connected to the SPRINT 300/500/700 C1, T1 and T2 ports. Each port can
support output of up to 3 A. There is over-current and short circuit protection in the Power Pass
Through ports and if tripped the SPRINT system alerts the operators with an option to re-enable pass
through.

3.8 Battery

The SPRINT 300/500/700 contains a backup lithium-ion battery to cope with short external power
interruptions and has a life of approximately five minutes with no external power. The battery is
charged from the external power supply and when depleted, takes approximately twenty minutes to
reach full charge.
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3.9 Connector Ports

3.9.1 Standard Ports

The standard SPRINT 300/500/700 is provided with 4 x Seacon connector ports as shown in Figure
3—10. The connector port functions are described in Table 3-2.

Figure 3-10 SPRINT 300/500/700 Connector Ports

Table 3-2 SPRINT 300/500/700 Connector Port Type and Functions

Port Standard Connectors
Type Function

CP/E1 |Seacon RS232 and RS485 Full Duplex Communications and Input Power
MINL-16FCR/L Ethernet (100 Mbit/s) Communications and Input Trigger.

C1 Seacon RS232 Communications, Input Trigger and Power Pass Through.
MING-7-FCR

T1 Seacon RS232 and RS485 Half Duplex Communications, Output Trigger and
MING-7-FCR Power Pass Through.

T2 Seacon RS232 and RS485 Half Duplex Communications, Output Trigger and
MING-7-FCR Power Pass Through.
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CP/E1 Pin out Functions
The SPRINT 300/500/700 CP/E1 cable connector pin functions are shown in Table 3-3.

Face view
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Table 3-3 SPRINT 300/500/700 CP/E1 Pin Out

Seacon Pin No. Function

1 DCOV

2 DCIn

3 Comms/Trig Ground

4 Screen

6 Trigger In

7 SPRINT Ethernet TD -

8 RS232/485 Select
Connect to 0 V1/Pin3 for RS232
Do not connect for RS485

9 Not Connected

10 SPRINT Ethernet RD -

11 RS232 Rx/ RS485 Tx +

12 SPRINT Ethernet TD +

13 RS232 Tx / RS485 Tx -

14 RS485 Rx -

15 SPRINT Ethernet RD +

16 RS485Rx +
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C1 Pin out Functions

The SPRINT 300/500/700 C1 cable connector pin functions are shown in Table 3—4.

face view

Table 34 SPRINT 300/500/700 C1 Pin Out

Seacon Pin No. Function

Screen

Comms / Trig Ground

Trigger In
DCOV
RS232 Tx
RS232 Rx
DC +~0.5V

N Ol W|IN| -~

T1/T2 Pin out Functions
The SPRINT 300/500/700 T1/T2 cable connector pin functions are shown in Table 3-5.

face view

Table 3-5 SPRINT 300/500/700T1/T2 Pin Out

Seacon Pin No. Function

1 Screen

2 Comms / Trig Ground
3 Trigger Out

4 DCoOV

5 Tx Tx -
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Table 3-5 SPRINT 300/500/700T1/T2 Pin Out (continued)

Seacon Pin No. Function
6 Rx Tx +
7 DC +~0.5V

3.9.2 Seacon CS-MSAJ-9 Ports

SPRINT 300/500/700 used on Oceaneering ROVs are provided with 4 x Seacon CS-MSAJ-9
connector ports as shown in Figure 3—11. The connector port functions are described in Table 3—6.

Figure 3-11 SPRINT 300/500/700 Connector Ports

Table 3—6 Seacon CS-MSAJ-9 Connector Port Type and Functions

Port Oceaneering Connectors
Type Function
CP/E1 Seacon RS232 Communications
CS-MSAJ-9 Input Power
Ethernet (100 Mbit/s)
C1 Seacon RS232 Communications,
CS-MSAJ-9 Input Trigger,
Power Pass Through
T Seacon RS232 RS485 Half Duplex Communications, Output
CS-MSAJ-9 Trigger and Power Pass Through
T2 Seacon RS232 and RS485 Half Duplex Communications,
CS-MSAJ-9 Output Trigger and Power Pass Through
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CP/E1 Pin out Functions
The Seacon CS-MSAJ-9 CP/E1 connector pin functions are shown in Table 3—7.
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Table 3—7 Seacon CS-MSAJ-9 CP/E1 Pin Out

Seacon Pin No. Function
DCIn

Comms Ground
Rx

Tx

DCOV
Ethernet TD -
Ethernet RD -
Ethernet TD +
Ethemet RD +

Ol | N[O B[ W|IN| -

C1 Pin out Functions
The Seacon CS-MSAJ-9 C1 connector pin functions are shown in Table 3-8.

(MALE FACE VIEW)
v

1
g @@@ 2
6@@@43

Table 3-8 Seacon CS-MSAJ-9 C1 Pin Out

Seacon Pin No. Function

1 Rx

2 DC Out

3 Comms Ground
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Table 3-8 Seacon CS-MSAJ-9 C1 Pin Out (continued)

Seacon Pin No. Function

6 Tx

7 DCOV

9 Chassis Ground

T1/T2 Pin out Functions
The Seacon CS-MSAJ-9 T1/T2 connector pin functions are shown in Table 3-9.

Table 3-9 Seacon CS-MSAJ-9 T1/T2 Pin Out

Seacon Pin No. Function

DC Out

Comms / Trig Ground
Tx

Rx

DCOV

Trigger Out

Ol || WIN| =

3.9.3 FMC Schilling Seanet Ports

The Seanet SPRINT 300/500/700 is provided with 4 x FMC Schilling Seanet connector ports as
shown in Figure 3—15. The connector port functions are described in Table 3—10.

Description

The Seanet FMC Schilling connector has a transparent housing to allow the confirmation LEDs to be
viewed. The connector is locked onto the connector port using a locking bail arm; see Figure 3—12.
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Figure 3-12 Seanet FMC Schilling Connector

Item |Description

1 Locking Bail Arm

2 Push-Button Release x2

3 Transparent Connector Body

The connector pins and face are self-lubricated by means of an internal plunger on the connector face
that is compressed and releases the lubricant when the connector is locked onto the port; see Figure
3-13.

Figure 3-13 FMC Schilling Seanet Connector Underside

Item |Description

1 Connector Pins

2 Self-Lubricating Plunger
3 Locking Clamp x2

The Seanet FMC Schilling connectors are manufactured by FMC Technologies Ltd. Contact the
manufacturer for more information.
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Covers

Seanet FMC Schilling connector covers must be fitted to any unused connector ports before the unit is
operated subsea.

The cover has two push-button releases that must be pressed to unlock and remove the cover; see

Figure 3—14.
Figure 3-14 Seanet FMC Schilling Connector Cover
Item |Description
1 Push-Button Release x 2
Figure 3-15 Seanet FMC Schilling Seanet Connect Ports
Table 3-10 Seanet FM Schilling Connector Port Functions
Seanet FM Schilling Port Function
CP RS232 Communications and Input Power
E1 Ethernet (100 Mbit/s) Communications
C1 Input Trigger
T1 RS232 Communications

Pin out Functions
The Seanet FM Schilling connector pin functions are shown in Figure 3—16.
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Figure 3-16 Seanet FM Schilling Connector Pin Out

Seanet Port Pin

Function

1

+24 V (do not exceed 8 Amps)

2 24V Return / Trigger In Ground
3 N/A
RS-232 Ethernet Trigger
4 N/A RD- N/A
5 Tx RD+ Trigger In
6 Rx TD- N/A
7 N/A TD+ N/A

3.9.4 Trigger Input

The SPRINT 300/500/700 trigger input characteristics are shown in Table 3—11.
Table 3-11 SPRINT 300/500/700 Trigger Input

Parameter Specification

Voltage Recommended ov-5Vv
Minimum 0vV-3.6V

Pulse Width Recommended 10 ms
Minimum 5us

3.10 Pressure Relief Vent Valve

A pressure relief vent valve is provided to stop a build-up of gas inside the SPRINT 300/500/700

housing caused by the charging process or a failing battery.

The pressure relief vent valve must be checked before installing and operating the SPRINT

300/500/700; see Section 9.7 "Pressure Relief Vent Valve".
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Figure 3-17 Pressure Relief Vent Valve

Item

Description

Pressure Relief Vent Valve

Note

If using Type 8084-000-458X/658X-C, see UM-8084-Lodestar-Nav Issue A2 for Standalone DVL

connection instructions.
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Section 4 — Planning

4.1 Navigation Scenario

Interface* Navigation Scenario

Construction |Dynamic ROV Guidance
SPRINT 300/500/700 Connection Either:
Ethernet (100 Mbit only) v v
Serial RS232 115,200 baud v v
LCH v v Optional
Time Synchronisation** Either:
GPZDA UTC message with configurable latency to 1 PPS v x Optional
GPZDAUTC message & 1PPS sentto SPRINT 300/500/700 v v
None Optional
USBL Aiding*** Either:
PSIMSSB message (UTC time, WGS 84 Lat/Long Radians) v v v
USBL GGA message (UTC time, WGS 84 Lat/Long Degrees) v v v
Sonardyne External Position (UTC time, WGS 84 Lat/Long Degrees) v v v
DVL Aiding*** | Either:
RDI Binary PD4/5 Message (Recommended) v v v
RDI Binary PDO Message v v v
Pressure Depth Aiding | One Of:
DigiQuartz kPA/PSI/Metres v v v
Valeport Midas SVX2 v v v
NMEA DPT message v x v
Sonardyne SONDEP message v x v
Tritech Winson (processed) message) v x v
Sonardyne External Depth v v v
LBL Aiding |
Fusion 6G LBL 1.11.04 (or later) with appropriate dongle v v x
INS Position Output (with UTC timestamp) | Either:
From SPRINT topside (LCH) v v Optional
From SPRINT 300/500/700 (ROV) v v v
AHRS Attitude Output (No UTC timestamp) | Either
From SPRINT topside (LCH) v x v
From SPRINT 300/500/700 (ROV) v v v
Notes

*See Appendix D "INS Message Definitions" for all message formats.

** |t is assumed that in either mode of time synchronisation that the GPZDA message is received no
faster than 1 Hz (once a second) otherwise the system may not be able to synchronise.

*** All USBL aiding inputs must be raw/measured and should not be subject to any filtering.

**** See Section 6.4.8 "Depth Aiding"for supported DVL configurations.

Prior to installation it is important to consider the navigation scenario to determine the optimum system
configuration and interfaces. Typically the scenario is defined by the positioning (or attitude) accuracy
specifications of a mission or project but equally important is the timeliness (or latency) of positioning
or attitude provided by the SPRINT system.
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Two common navigation scenarios are explained below. The recommended configuration for each
navigation scenario is explained in the installation and configuration sections. If there is uncertainty as
to which scenario is to be supported it is recommended that ‘Dynamic Survey’ is selected.

4.1.1 Construction Survey

In this scenario the SPRINT 300/500/700 ROV will be used to position subsea structures or pipelines
that are slow moving. The positioning and attitude accuracy tolerances can be high but the timeliness
requirements of the outputs is relatively low, typically less than 0.5 seconds, as the ROV is often
moving very slowly or performing static fixes during critical positioning phases.

4.1.2 Dynamic Survey

In this scenario the SPRINT 300/500/700 ROV will be used to perform dynamic, high accuracy
surveys such as multibeam pipeline out-of-straightness. The positioning and attitude accuracy
tolerances are high and so is the timeliness of the outputs as the ROV motion must be compensated
correctly when processing multibeam data. Any significant latency in ROV position or attitude will
result in errors or artefacts in the final multibeam terrain model. In this scenario accurate alignment
and instrument offsets will be more critical than in the ‘construction’ survey.

4.1.3 ROV Guidance

In this scenario the SPRINT 300/500/700 will be used to provide ROV guidance, providing orientation
at all times and INS position when the INS is available. The INS can be initialised using either USBL
or manual (external) positions. In this scenario, the SPRINT system can provide accurate ROV
guidance either mid water with USBL or at the seabed using DVL-INS “dead reckoning” without
USBL.

4.2 Interfaces

Prior to installation the following interfaces should be planned according to the SPRINT 300/500/700
navigation scenario (v'indicates a supported interface, “x” indicates a non-supported interface):

4.3 Connections

To guarantee the successful operation of theSPRINT system, the system connectivity must be
considered at the installation planning stage. A suggested system connectivity diagram for the
‘construction survey’ configuration is shown in Figure 4—1.
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Figure 4-1 Construction Survey Interface Diagram
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A suggested system connectivity diagram for the ‘ROV guidance’ configuration is shown in

Figure 4-3.
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4.4 Cabling

The system cabling must be carefully planned prior to installation to avoid issues. Subsea cables can
be costly and time consuming to correct or replace during the installation phase.

441 Topside

The majority of topside interfaces will be serial. Consideration should be given for any serial cable run
length, as this could lead to data corruption if the length exceeds RS232/485 limits, particularly the
serial connection between the SPRINT 300/500/700 LCH and the SPRINT 300/500/700 (if used). If
the distance between the SPRINT 300/500/700 LCH and the ROV (de) multiplexer is excessive for an
115,200 baud rate RS232 serial link then alternate interfaces should be planned to make sure the data
is not corrupted, such as Serial to Ethernet or RS232 to RS422/485 converters. Alternatively an
Ethernet connection to the SPRINT 300/500/700 could be considered.

4.4.2 Subsea

A typical cabling diagram for all the required subsea connections to and from the SPRINT
300/500/700 on the vehicle is shown in Appendix F "SPRINT 300/500/700 Wiring Diagram”. This
diagram should be used to produce vehicle and sensor specific SPRINT 300/500/700 cables prior to
installation. If required, there are also individual cable pin-outs for each specific SPRINT 300/500/700
port available in the UM-8084-101 "Lodestar Hardware Manual".

4.5 Time Synchronisation

The SPRINT 300/500/700 will be time synchronised to UTC by receiving a ZDA message and
optionally a 1PPS timing pulse from a GNSS receiver. The SPRINT system will be interfaced to other
systems, such as USBL, Survey Software or Multi-beam that are also time synchronised to UTC using
connections to GNSS receivers. A common source of perceived INS position error is inconsistent time
synchronisation across the various systems interfaced with the SPRINT system.

There are three fundamentally different types of GNSS ZDA/1PPS time synchronisation:
« ZDA arrives before its associated 1PPS
o ZDA arrives after its associated 1PPS (most common)

« 1PPS and ZDA are asynchronous (seen with many modern GNSS systems)

Different models and configurations of GNSS receiver may use any of the three types listed above.

Itis very important that the type of synchronisation used by each GNSS receiver is understood prior to
the SPRINT 300/500/700 installation to avoid timing issues. This may require consultation with the
GNSS manufacturer. If possible, the use of a common GNSS receiver for time synchronising all
systems will greatly reduce the risk of issues.

4.6 Depth

The SPRINT system supports either pressure or depth aiding input to determine the depth of the INS.
There are several factors that should be considered during the planning phase.

4.6.1 Pressure to Depth Conversion

In the case of a pressure aiding input the SPRINT 300/500/700 performs a simple pressure to depth
(metres) conversion. The pressure to depth conversion scale factors are provided in Appendix H
"Pressure to Depth Conversion".
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If there is a requirement for a different pressure to depth conversion calculation to be used, the
operator can either:

« Convert the pressure sensor data to metres using the required conversion and pass this to the
SPRINT 300/500/700 as a depth (m) aiding message.

o Apply a pressure depth offset to the SPRINT system at operating depth so the INS depth is
consistent with the intended depth datum.

« Convertthe INS depth output from the system to another datum using the provided conversion
calculations.

4.6.2 Surface Pressure

Most pressure sensors will measure ambient air pressure at the surface. This is the equivalent of
approximately 10 metres of water depth. The SPRINT system allows the operator to measure the
surface pressure on deck and remove it from any subsequent depth calculation. Depending on project
requirements surface pressure may be removed as described above or the INS depth could also
include surface pressure — this should be decided at the planning stage.

4.6.3 LBL References

Whichever method or configuration of SPRINT system pressure depth is used, the INS depth should
always be consistent and relatively accurate to any LBL reference depths.

4.7 (Sparse) LBL Array Planning

4.7.1 Features and Operational Guidelines

The INS can be aided by LBL range observations from a Fusion 6G system.

Due to its DVL-inertial dead-reckoning capability, the INS can manage with less than the 4 or 5
beacons traditionally required for acoustic LBL tracking, hence the term ‘Sparse’ LBL.

Consider the following features and operational guidelines for sparse LBL.:

« The minimum number of beacons at one site is two. Use of three beacons will support loss of
acoustics to any single beacon and INS integrity if there is an error with aiding from any single
beacon. For this reason the recommended number of beacons for a sparse array is three.

« In specific scenarios with favourable vehicle dynamics / trajectory the INS can be aided with
range observations from just a single beacon. Additional operational guidelines should be
considered — contact Sonardyne for advice.

« The INS can be actively aided by up to 6 beacons but can record LBL aiding observations for
up to 10 beacons for analysis and post processing.

« Acoustic update rate to each beacon should be faster than 10 seconds — this is primarily for
screening of observations prior to INS use.

« Pressure depth provided to the INS and beacon depths should be consistent. Relative depth
errors will cause error in INS positioning if line of sight is not horizontal.

« Sound velocity in Fusion must be correct. Make regular updates if change is expected (> 0.5
m/s).

« LBL (range) aiding must be used in conjunction with DVL aiding, particularly in very sparse
arrays. Contact Sonardyne for specific guidance if DVL is not available.
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« Ensure placement of LBL aiding beacons provides adequate acoustic line of sight and good
geometry to the LBL transceiver during planned operations.

4.7.2 Sparse Array Geometry

The reference beacons in the sparse array should be placed so the line of sight to at least two of the
beacons is approximately orthogonal to reduce the error in opposing directions.
An example of good geometry is shown below in Figure 4-4 and examples of poor array geometry are
shown below in Figure 4-5.

Figure 44 Example of Good Sparse Array Geometry
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4.7.3 First Use of ‘Sparse’ LBL Aided INS
Itis recommended that with first use of ‘Sparse LBL Aiding’, full LBL array navigation is also available
to provide an independent position reference. Refer to the procedure detailed below:

1. Deploy afull LBL array.

2. Run full LBL acoustic tracking in Fusion.

3. Use SPRINT with LBL aiding from two or more of the array beacons (depending on operational

requirements).
4. Compare the positioning performance of SPRINT sparse LBL against full acoustic LBL.
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Gross difference between the two positions will indicate an issue for investigation/resolution; see
Section 12.11 "LBL Aidingfor troubleshooting advice.

4.8 Planning Check List

Use the list below to assist in making sure the planning for the SPRINT system is complete prior to
system installation:

No |[Action Manual Section Checked
(Sign and Date)
1 Plan navigation scenario Section 4.1
2 Plan (and prepare) required interfaces Section 4.2
3 Plan system connections Section 4.3
4 Plan system cabling Section 4.4
5 Plan system time synchronisation Section 4.5
6 Plan system depth Section 4.6
7 Plan sparse LBL array(s) if required Section 4.7
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Section 5 — Installation

5.1 Introduction

Before installing the equipment, ensure Section 2 — Safety is read and fully understood.
This section explains how to install the SPRINT 300/500/700 before deployment. .

5.2 Unpacking and Inspecting

The SPRINT 300/500/700 includes a number of delicate and sensitive electronic components. In
particular, the accelerometers and RLGs that form the Inertial Measurement Unit (IMU) are sensitive
to shock and vibration. If damaged, these components cannot be replaced in the field, and the
complete SPRINT 300/500/700 must be returned to the factory for repair and recalibration.

Note

Always handle the SPRINT 300/500/700 with care. Store the unit in the shipping container until it is
ready to be installed in the prepared location.

Inspect the SPRINT 300/500/700 and all the supplied parts on receipt and check the shipment
includes all the items listed on the shipping documents. Inform Sonardyne immediately if there are any
parts missing, or if any of the supplied parts show signs of damage.

5.3 Installation Location

The SPRINT 300/500/700 can be installed at any convenient location on the vehicle. However, to gain
optimal performance from the system, identify a location to install the SPRINT 300/500/700 that
conforms as closely as possible to the following criteria:

« The location must not be subject to excessive vibration or impulse shock.

« The location must not exceed the environmental limits for temperature defined in Section 14
"Technical Specifications".

« The location must provide a mounting surface that is of sufficient strength to support the weight
of the SPRINT 300/500/700 safely and without flexing.

« The location must provide access for power and communication connections.
« There must be sufficient space to allow easy access to install the SPRINT 300/500/700.

« Do not store tools, equipment or chemicals where they can damage the SPRINT 300/500/700
or the connection cables.

o Make sure the SPRINT 300/500/700 and its connection cables do not cause an obstruction to
personnel operating in the area.

» Do not use a location where the connection cables are likely to suffer damage from mechanical
stresses or chemical attack.

5.4 Mounting
5.4.1 Site Preparation

The SPRINT 300/500/700 can be installed in any convenient orientation with respect to the vessel's
body frame. Compensate for any misalignment between the SPRINT 300/500/700 and the vessel by
carefully measuring the mounting angles and entering them in the AHRS or SPRINT system; see
Section 5.5 "Vehicle Alignment".
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5.4.2 Mounting Holes and Dowels

The SPRINT 300/500/700 has a set of eight mounting holes on the underside of the unit. In addition
there are two sets of three-dowel alignment holes and four alignment flats. The mounting holes, dowel
alignment holes and alignment flats are shown in Figure 5-1.

Note
The forward direction is UP in Figure 5-1.

Figure 5-1 SPRINT 300/500/700 Mounting and Alignment

8 off M8x1.25 Mounting Holes

12.0 Min Full Thread

Equi-Spaced on a 155.00 PCD
Recommend using Titanium Fixings
(not supplied)

3 off Dowel
Alignment Holes
@8.00+40.05
5.00 Deep

Flat bottomed

99 TYP

50,00

30,00
_-h‘
—

60.00
25,00
"

K
3 off Dowel

Alignment Holes
@6.00+0.012
6.00 Deep

Flat bottomed
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5.5 Vehicle Alignment

The nominal alignment of the SPRINT 300/500/700 to the vehicle frame (FWD and STBD) is
engraved on the top endcap as shown in Figure 5-2.

Figure 5-2 Endcap Alignment Markings

Item |Description
1 FWD and STBD Endcap Alignment Markings

Four flats machined into the base plate serve as alignment references.

Ifitis not possible to mount the SPRINT 300/500/700 within the limits described above for coarse
alignment or if you wish to mount the SPRINT 300/500/700 at other angles with respect to the
reference axes on the vessel, ROV or platform, the mounting angles must be measured and
configured.

5.5.1 Alignment

For the SPRINT 300/500/700 to provide accurate attitude and positions with respect to the vehicles
reference frame, any misalignment between the SPRINT 300/500/700 and vehicle reference frame
must be corrected by determining and applying mounting angles in the SPRINT system software. A
definition for the SPRINT 300/500/700 reference frame including mounting angle convention is
described in Appendix B "Reference Frames and Angular Conventions”. Typically there are two
stages in determining the SPRINT 300/500/700 mounting angles.

First determine the initial ‘coarse’ mounting angles. If the SPRINT 300/500/700 mounting is at the
default as described in Appendix B "Reference Frames and Angular Conventions"then the SPRINT
300/500/700 mounting angles will all be zero. If the SPRINT 300/500/700 mounting is non-standard
(e.g. the SPRINT 300/500/700 is mounted horizontally) then the mounting angles must be applied in
the SPRINT system. A selection of SPRINT 300/500/700 mounting orientations and related mounting
angles are provided in Appendix C "SPRINT 300/500/700 Mounting Angle Examples".
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After the (coarse) mounting angles of the SPRINT 300/500/700 have been determined using the
guidance provided above, the angles can be refined using existing methods for ‘Gyro to ROV’
calibration.

These methods may include:

« Manual calculation using traditional survey methods such as a dimensional control survey
(usually performed in a static environment onshore).

» Automated calculation provided by Survey software using comparison of ROV gyro against
vessel reference gyro (can be performed offshore in a dynamic environment).

Ensure the results of any additional mounting angle calculation match the conventions listed in
Appendix C "SPRINT 300/500/700 Mounting Angle Examples" before they are applied to the
SPRINT system.

5.5.2 SPRINT Instrument Frame

The SPRINT system has two types of lever arm and mounting angle measurement references -
vehicle frame and instrument frame:

« Vehicle frame: SPRINT and sensor lever arms and mounting angles relative to Vehicle
CRP/Frame (from vehicle CRP/Frame).

« Instrument frame: sensor lever arms and mounting angles relative to SPRINT IMU (from
measurement point of the sensor assembly).

SPRINT instrument frame is recommended for pre-calibrated co-located SPRINT 300/500/700 and
Syrinx DVL systems. This measurement frame simplifies the process of aligning SPRINT and aiding
sensors to the vehicle CRP / Frame with minimum user interaction by auto calculating lever arms and
mounting angles of DVL with respect to the vehicle’s CRP / Frame (instrument frame lever arms and
mounting angles must be applied prior to entering SPRINT vehicle measurements).

To configure the SPRINT system using instrument frame:

1. To Configure DVL: import the DVL Calibration file (.ccl) or manually input DVL calibration values
with From IMU lever arms and Mounting angles selected; see Section 6.4.9 "DVL Aiding" for

sensor configuration.
DVL Calibration Report e
Scale Factor.  0.000 B = Latency:  -0.003 3| Seconds
Settings:
Lever arms relative to | PO ) | Staboard | Down ) DVL Calibration Settings
My Vechicle (CRP) 0 0 o
USBL Vechicle (CRP) 0 0 0 DVL Mounting
DVL Vechicle (CRP) 0 0 0.202 (O From Vehicle CRP
: ———————
Results: e —r— g Angic
DVL param: (roli] b ch headir Later
2 2t (PRENIT |0 (headha) (1] " error i) ner ol Foward: (0000 |2 Metres Heading: [0.176 2] Degrees
Before 0 D- 0- 1] 0
Calculated 0.715 0.127 0.176 [ -0.009 Staboard: 0000 |2 Metres Resutting Ptch: |0.127 2. Degrees
Calculated Accuracy o0& Ulm D-CHI Uim
Down: [0202  [2] Metres Resulling Roll: [0.715 12 Degrees

2. Applythe SPRINT lever arms and mounting angles from the Vehicle CRP; the figure below
shows an example of the automatically calculated DVL and Depth from vehicle CRP/Frame

values.
DVL Mounting
ST oo ® From Vehice CRP |~ O From IMU
Lever Arms (From Vehicle CRP) Mounting Angles {(From Vehicle Frame) 1 ==, Wi ing Angle
- om0 |2 ing: =
Forward: o bl Hpank 3410500 (- Muormes Forward: |0.901 | Metres Heading: |0.676 %| Degrees
Starboard: 0600 34 Metres Resutting Pitch: |0.200 |+ Degrees Starboard: 0600 12| Metres Resuiting Pitch: 0,327 =] Degres
Down: [0.300 34 Metres Resuting Roll: -0.010 |2 Degrees Down: 0,098 1= Metres Resuting Rol: 0,706 =] Degres
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Note

See Section 6.4.3 "SPRINT System Configurations” and Section 14 "Technical Specifications” unit
dimensions (measurement point).

5.6 Preparing the SPRINT 300/500/700 for use

The following checks and procedures must be carried out to make sure the SPRINT 300/500/700 is
serviceable and ready for use:

« Check the pressure relief vent valve; see Section 9.7 "Pressure Relief Vent Valve"
« Secure connector cables and fit the connector covers to all unused connector ports.
o Check communications with the SPRINT 300/500/700.

5.7 SPRINT System Software

The SPRINT system software should be installed to configure, operate and monitor the SPRINT
300/500/700 for combined AHRS and INS operation. To install the software:

1. Close all applications running on the Navigation Computer.

2. Loginto the Administrator user account and insert the SPRINT software installation media.
3. Navigate to the drive containing the software installation media and double-click Setup.exe.
4

. Follow the on-screen instructions to install and run the SPRINT software.

Note

If upgrading from a previous version of SPRINT, archive and delete both "SPRINT" and "Hub"
folders from "C:\Users\Public\Documents\Sonardyne". Failure to delete these folders will cause
incorrect software operation.

5.8 PC Utility

The PC utility software is used to configure and operate the SPRINT 300/500/700 for standalone
AHRS and also for maintenance functions such as firmware upgrade and onboard log files retrieval.
Toinstall the software:

1. Close all applications running on the PC and insert the software installation media.
2. Navigate to the drive containing the software installation media and double-click Setup.exe.

3. Follow the on-screen instructions to install and run the PC Utility.

Section 5 — Installation 40



UM-8253-SPRINT
Issue A3

User Manual for Type 8253 SPRINT 3rd Generation

Section 6 — Combined INS & AHRS Operation

6.1 Introduction
A SPRINT 300/500/700 can be configured and operated as both as a combined INS and AHRS using
the SPRINT system, this is mode of operation is explained in this section.

Ifthe SPRINT 300/500/700 is only to be configured and operated as an AHRS only; see Section 7
"Standalone AHRS Operation”.

6.2 Changing the Console Port (CP) Baud Rate

Ifthe SPRINT 300/500/700 is to be connected using a serial interface, the console port baud rate must
be setat 115200. SPRINT 300/500/700 units shipped as part of a SPRINT system will be pre-
configured with this baud rate. If the SPRINT 300/500/700 has not been pre-configured for this baud
rate, the PC utility software can be used to configure the console port baud rate.

6.3 Configuring Lodestar Communication Hub (LCH)

The LCH is optionally provided with the SPRINT system and provides an 8-port serial device server
interface to extending the communications of the topside computer.

Figure 6-1 LCH Front and Rear

EI'NBNET | m POI\TS

The LCH can provide a variety of configurable serial settings for each serial input device or output port
required topside, such as:

« Baud rates from 50 to 921,600.
o RS-232,RS-422, RS-485 Half Duplex or RS-485 Full Duplex.
« Data bits, Stop bits, parity, flow control and FIFO.

MBEMW WSTE EPRTPH)

The LCH also contains a 1PPS conditioner that can be used to condition and boost the 1PPS signal
before itis sentto the SPRINT.
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The LCH is supplied pre-configured with the following settings for serial input/output interfaces:
Table 6—1 Serial Input / Output Interfaces

LCH Local Purpose Baud |Data Bits Stop |Parity |FIFO |Flow Interface
Port |[TCP Port Rate Bits Control
Port 1 {5001 SPRINT 300/500/700 | 115200 |8 1 None |Enable [None RS-232
Console Port
Port 2 | 5002 GPS Input 9600 |8 1 None |Enable | None RS-232
Port 3 5003 ZDA Input 9600 |8 1 None |Enable | None RS-232
Port4 |5004 USBL Input 9600 |8 1 None |Enable | None RS-232
Port5 |5005 DepthorS.V.Input (9600 |8 1 None |Enable | None RS-232
Port 6 |5006 Primary Output 9600 |8 1 None |Enable | None RS-232
Port 7 {5007 Secondary Output 9600 |8 1 None |Enable [None RS-232
Port8 |5008 DONOT USE

If it is necessary to modify any setting for system operation, follow the procedure below:

Note

The LCH Port 1 is pre-configured to match the default serial connection configuration of a SPRINT
300/500/700 used with the SPRINT system. If this Port needs to be modified, the default SPRINT
300/500/700 connection configuration will need to be changed. It is advised to contact Sonardyne
Support for further instructions.

Itis necessary to know the IP address of the LCH unit. At the time of manufacture the IP address is set
t0 192.168.179.51. The IP address can be discovered as follows:

1. Open NPort Administrator by navigating from the start menu: Programs > NPort
Administration Suite > NPort Administrator.

2. Click the Search button on the toolbar and wait 5 seconds for the search to complete. The model
and IP address of the LCH comms unit will appear.

Note
The LCH factory default IP address is 192.168.179.51

Once the IP address is known, open Internet Explorer.

Enter the LCH IP address into the address bar e.g. http://192.168.179.51.

A web configuration page will be displayed.

To change any of the port settings, expand the Serial Settings item on the left hand pane.
Select the port to be configured; the current settings will be displayed on the right hand pane.

Change the settings as required and then click Submit to save the settings.

© ® N o g k&~ w

Click Save/Restart and wait approximately 30 seconds for the changes to be applied and the
LCH to restart. The LCH will beep twice when it is ready.

10. When all changes have been made close Internet Explorer.
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6.4 SPRINT system Software Configuration

Insert the security dongle into the Navigation Computer and then open the SPRINT system software

by double-clicking the SPRINT desktop icon:
ﬁft

SPRINT

6.4.1 SPRINT system Security Dongle

SPRINT 300/500/700 are available with different combinations of aiding options. The security dongle
enables the appropriate aiding option in the SPRINT system software. Example S5 and S10 aiding
options are shown in Figure 6—4 and Figure 6-5.

1. The security dongle validity and date/time of expiry information is displayed on the
SPRINT system information pane.

Figure 6-2 Dongle Information Pane

Aiding Inputs
USBL LBL Depth DL Ext Pos ZUPT

000000

IDongle: Valid, Time unlimited, Date/Time of Expiry: n/a. SPRINT UTC Time: 02/19/2018 15:34:58[

2. The SPRINT aiding options (S5 or S10) can be viewed by selecting Help > About > Dongle
Info from the SPRINT system menu bar.

Figure 6-3 Dongle information

Sonardyne Es

SOUND IN DEFTH

SPRINT
Version 1.5.3.480

Dongle Info

Copyright © 2019
Sonardyne International Ltd.
www.sonardyne.com

Full Copyright Motice
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3. Refer to Figure 6—4 and Figure 6—5. SPRINT system aiding options for S5 and S10 systems are
displayed along with dongle validity, type of expiry and date/time of expiry.

Figure 64 SPRINT S5 Settings

Dengle Information *

Figure 6-5 SPRINT S10 Settings

Dengle Information s

Section 6 — Combined INS & AHRS Operation 44



User Manual for Type 8253 SPRINT 3rd Generation UM-8253-SPRINT
Issue A3

6.4.2 SPRINT System Connection
To connect the SPRINT 300/500/700 to the SPRINT system, follow the instructions below:

1. Ifthisis the first time the SPRINT 300/500/700 has been connected to the SPRINT system
software or the connection is not active, the connection window should automatically be
displayed. If the connection window does not appear, open it by clicking Configure > SPRINT >
Connection.

2. Onthe Connection window, click the Ethernet/LCH tab and enter the IP Address and Port:

« Ifthe SPRINT 300/500/700 is connected by means of a serial connection to the LCH, enter IP
Address: 192.168.179.51 and Port 5001.
Figure 6-6 Serial Connection to the SPRINT 300/500/700

T
Connection To SPRINT unit ==

Ethemet / LCH Serial | Seral

IP Address: 132 168.179.51

Port: 5001

‘HSPF{INTunit ‘ Corect H Coce ‘

« Ifthe SPRINT 300/500/700 is connected directly by means of an Ethernet connection to the
LCH, enter IP Address: 192.168.179.50 and Port 4000.

Figure 6-7 Ethernet Connection to the SPRINT 300/500/700

Connection To SPRINT unit (=]

Ethemet / LCH Serial | Serial

IP Address: 192 168.179.50

Port: 4000

‘HSPF{INTun'ﬂ ‘ Coect H Coce ‘
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« Ifthe SPRINT 300/500/700 is connected using a PC serial comms port, set the baud rate as
follows: on the Serial tab, select the Com port and set the Baud Rate to 115200.

Figure 6-8 Direct Serial Connection to SPRINT 300/500/700 for MWSK

Cennection Te SPRINT unit (5]

Ethemet / LCH Serial | Serial

COM Port:  COMI -

Baud Rate: 115200 -

SPRINT unit
‘ Hardware R ‘ Connect H Close ‘

Note

Only use serial comms connection if operating Mid Water Station Keeping (MWSK); not
recommended for survey operations.

3. Click Connect.

4. If connecting for the first time select a configuration option, otherwise skip to Step 5.

Note

If this is the first time the SPRINT 300/500/700 has connected to the SPRINT system software,
the configuration options below will be displayed (no options will be displayed if the SPRINT
300/500/700 has previously connected to the SPRINT system software).

« Load Default Configuration: loads the default SPRINT configuration without aiding inputs
or message outputs configured.

« Load Library Configiration: loads a preconfigured SPRINT configuration from the SPRINT
library (e.g. 8084-251-B Gyro iUSBL configuration).

» Import Configuration: loads a custom configuration.

SPRINT Configuration (===

@ No Configuration Detected

Load Default Configuration (@)
Load Library Configuration ()
Import Configuration (&)

5. Select a configuration option and then click OK.

Updating the Configuration... ==

Sending Corfiguration 157 commands outstanding
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6. Ifthe SPRINT 300/500/700 is not connected, the SPRINT system will prevent access to any
menu options to retrieve or configure SPRINT 300/500/700 settings.

Figure 6-9 No SPRINT 300/500/700 Connection for Configuration

&4 SPRINT

Configure | View Tools Hel

SPRINT
Power Pass Through
IMS

Time Synch
Logging

Outputs »
Options

7. In addition, the system status LEDs at the bottom of the main application window will indicate that
there is no SPRINT 300/500/700 connection, as shown below.

System Status
SPRINT AHRS INS Time Logging

@ o o o o
6.4.3 SPRINT System Configurations

To load the factory configuration or a configuration file from the Library, follow the instructions below:

1. When the SPRINT 300/500/700 connection has been established, click File > Load Default
Configuration (this will load default SPRINT configuration).

&4 SPRINT

File | Configure View Tools Help
ILoad Default Configuration I

Load Custom Configuration..
Load Library Configuration..
Save Custom Configuration
Export configuration and log files
Exit

2. Click Yes to load the default configuration.

Load Default Configuration =R

Are you sure you wish to start a new configuration from system
defaults?

Mote: Previous Custom configuration will be cleared.

o= [ w
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3. The SPRINT 300/500/700 configuration can be saved to the PC by clicking Save Custom
Configuration (this configuration can also be loaded onto the SPRINT 300/500/700 from the PC
by clicking Load Custom Configuration).

ES‘P‘EIHT
File | Configure View Tools Help
Load Default Configuration

ILoad iCustom Configuration.. I

Load Likrary Configuration..

| 5ave Custom Configuration |

Export configuration and log files
Exit

4. Click Load Library Configuration .

ES‘P‘EIHT
File | Configure  View Tools Help
Load Default Configuration

Lead Custom Cenfiguration..,

ILu-ad Library Configuration.. I

Save Custom Cenfiguration
Export configuration and log files
Exit

5. Click Yes to load the configuration file from library.

(| s e e L B LT =

ii Are you sure you wish to lead custom/user configuration?

e
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6. Forexample, to load the default configuration fora SPRINT GyroiUSBL, select the configuration
file 8084-251-B.xml and then click Open.

B4 Select a Configuration file.., X
1 <« Public Documents » Sonardyne » SPRINT » Resources » Configurations » Library v | O Search Library »
Organize » New folder = M @
A
[=] Pictures bl Name Date medified Type Size
Released [ 8084-175-Baml 06/08/201910:33 XML Document 38 KB
SPRINT-MNav [] 20e4-201-Cxml 06/08/2019 10:33 XML Document KB
User Manuals D 8084-231-Cxmnl 06/08/2019 10:33 XML Document 3B KB

‘Word Format

! This PC
_ 3D Objects
[ Desktop
Documents
‘ Downloads
Jﬁ Music
[&] Pictures
B videos
2 Windows (C3)

= ith Nienetichars

(FICLELLERI000013_20190806_14.29 SPRINT v

v| |Conﬁgula{ian files (*aml) V|

| Open | ‘ Cancel |

6.4.4 SPRINT 300/500/700Settings

To configure the SPRINT 300/500/700 settings, proceed as follows:
1. Click Configure > SPRINT or right-click on the System Status AHRS LED.
2. Enter a default Latitude value.

3. After any manual change of the default latitude the Gyrocompass algorithm will be automatically
reset. The Gyrocompass algorithm can be manually reset at any time by clicking Gyro Compass
Reset.
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Figure 6-10 SPRINT 300/500/700 Gyro Compass Settings

SPRINT (=23
SPRINT Connection
PCACHPor: 152 166 173504000
EFRLIELR Cpu Load ‘ Fort Load I Firrnwarel
From SPRINT urit: 3116 Bps Name % Processor Time
To SPRINT unit: 0 Eps SPRINT 282
PCcpu2 00
PCcpu 3 83
Gyro Compass / AHRS PC cpu 128
Latitude:  51.3309 deg Gyro Compass PCecpu 1 05
== PC Load 56
SPRINT unit Power Management
Shutdown SPRINT | 7p minutes without
unit automatically power
Reset SPRINT Shutdown
unit SPRINT unit

SPRINT Mourting
Lever Arms (From Vehicle CRP)  Mounting Angles (From Vehicle Frame)
Forward: (0000 |2 Metres Heading m Dearees

Starboard: (0000 12 Metres Resuting Ptch: 0.000 |2 Degrees

Down: m Metres Resulting Roll m Degrees

] [torr ] o

Note

Failure to update the default Latitude to match the current working area could result in poor
SPRINT 300/500/700 gyrocompass and inertial performance. After any change of default Latitude
the SPRINT 300/500/700 Gyro Compass algorithm is reset. During INS operations the SPRINT
300/500/700 Latitude value will be automatically updated by position aiding messages (USBL).

3. Setthe SPRINT Power Management time period. The SPRINT 300/500/700 will run on its
internal battery for the selected time period after the external power supply has been stopped.

4. Enterthe Lever Arms (From Vehicle CRP) offset values. After changing these values, the
Gyrocompass/AHRS and INS algorithms will be automatically reset to use the new settings.

5. Enter the Mounting Angles (From Vehicle Frame) offset values. After changing these values,
the Gyrocompass/AHRS and INS algorithms will be automatically reset to use the new settings.

6. The SPRINT 300/500/700 can be manually shutdown at any time by pressing the Shutdown
SPRINT button, after which the SPRINT system will also close.

7. The SPRINT 300/500/700 (firmware) can be manually reset at any time by pressing the Reset
SPRINT button.
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8. The SPRINT 300/500/700 can be reset if the connection to theSPRINT 300/500/700 is via

Ethernet port (E1). Click the Connection button to open the SPRINT connection window, as
shown below.

Figure 6-11 SPRINT Connection
M

SPRINT Connection
PC/LCH Port: 192.168.179.50:4000
SRR Cpu Load [ Port Load [ Fimware
From SPRINT unit: 3076 i Name % Processor Time
To SPRINT unit: Bps SPRINT 279
FCcpu 2 17
PCcpu 3 14
Gyro Compass / AHRS PCcpul 15.8

latitude: 513309  deg | GyroCompass PCepul 34
Reset PC Load 21
SPRINT unit Power Management

Shutdown SPRINT  2p minutes without
unit automatically

power

SPRINT unit

Reset SPRINT Shutdown
unit

SPRINT Mourting

Lever Ams (From Vehicle CRP) Mounting Angles (From Vehicle Frame)

Forward: |0.000 lil Metres Heading m Degrees

Starboard: (0000 |2 Meres  Resubing Pich: [0.000 [%| Degrees

Down: m Metres Resulting Roll m Degrees

[Frome——

9. Clickthe SPRINT Hardware Reset button and then wait 3 minutes for the SPRINT 300/500/700
to re-establish communications with the SPRINT system.

Figure 6-12 SPRINT 300/500/700 Hardware Reset

Connection To SPRINT unit E
Ethemet / LCH Serial | Serial

IP Address: 192 168.179.50

Port: 4000

SPRINT unit G

10. Click OK to close and establish connection to the SPRINT 300/500/700.
m

SPRIMT successfully performed SPRINT unit Hardware Reset.
SPRIMT will now try to establish communication with the SPRINT unit.
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6.4.5 SPRINT System Power Pass Through

To enable the Power Pass Through:
1. Click Configure > Power Pass Through
Figure 6-13 SPRINT System Power Pass Through

kA SPRINT
File | Configure | View Tools H

SPRINT

Power Pass Through
INS

Time Synch
Logging

Outputs

Opticns

2. The configured aiding sensor is displayed for each SPRINT 300/500/700 port (C1/T1/T2) with its
previous and current status. Status lights are black if the power pass through is disabled. T2 port
is the internal connection between the SPRINT 300/500/700 and Syrinx DVL.

Figure 6-14 Power Pass Through Settings

SPRINT Power Pass Through Settings ==
SPRINT Ports: Aiding Sensor User Stored Settings Current Settings BahiEhonslisss
Through
: ° ° -
= None . o 0
DVL
; @ @ -
I OK I l Apply l l Cancel l

Note

The SPRINT 300/500/700 will disable all enabled Power Pass Through Ports when powered

cycled.

3. Ifthe SPRINT port has previously had Power Pass Through enabled then the status light is green
in the User Stored Settings column, as shown below.

Figure 6-15 Power Pass Through Settings

SPRINT Power Pass Through Settings (23]
SPRINT Ports Aiding Sensor User Stored Settings Current Settings B blTehFr.oO:";r: P
c1 MNone . o ]
I MNone . o ]
- DVL o o
I oK I l Apply l l Cancel l
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4. Toenable the Power Pass Through, select the Enable Power Pass Through check boxes and
then click Apply, as shown below.
Figure 6-16 Power Pass Through Current Settings

SPRINT Power Pass Through Settings E

Enable Power Pass

SPRINT Ports

Aiding Sensor

User Stored Settings

Current Settings

Through

c1

MNone

T

MNone

T2

DVL

=]

6.4.6 SPRINT 300/500/700Time Synchronisation
To configure the SPRINT 300/500/700 Time Synchronisation:

1. Click Configure > Time Synchronisation, or right-click the Time LED.
2. Onthe Time Synchronisation window, select Type: ZDA Only (default) or ZDA and 1PPS.
Figure 6-17 SPRINT 300/500/700 Time Synchronisation

Time Synchronisation E

Time Synchronisation Mode

Type: |ZDAand 1PPS -
GPZDA Input
@ PC/LCH Port:
192.168.17951:5003 | Configue | | Comms |
(©) SPRINT Port:
cP v|| Corfigure || Comms |

Latency: (0.0000 *| Seconds

1PPS Trigger Input

Trigger In: 0

SPRINT Port: | E1 -
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3. Click Configure and enter the PC Port Serial IP Address 192.168.179.51, Socket 5003 via the
LCH.

Figure 6-18 Adding IP Address

Time Signal input port ﬁ

Connection Type
() PC Seral @ Ethemet / LCH

Connection Details

IP Address:  192.168.173.51

Port: ho03
@ TCP Client &) UDP

| OK | Cancel

4. Click OK to return to the Time Synchronisation window and enter the ZDA Latency value.

Note

The Time Synchronisation can be reset at any time by selecting Reset Time Synch.

5. IfGPZDA and 1PPS is selected, configure the 1PPS Trigger Input settings. The default
SPRINT 300/500/700 input setting for 1PPS is SPRINT Port C1.

6. Click OK to close and save all entered settings.

Time Sync to External Instrument

The SPRINT 300/500/700 can also be configured to output a time sync (ZDA+1PPS) to an external
instrument.
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1. Click Time Sync Output in the Time Synchronisation dialog box.

Time Synchronisation E
Time Synchronisation Mode
Type: [ZDAand 1PPS -

GPZDA Input
@ PC/LCH Port:
192 168.179.51-5003 | Corfigre | | Comms |

() SPRINT Port:

cpP v|| Corfigure || Comms |

Latency: (0.0000 | Seconds

1PPS Trigger Input

SFRINT Fort: Tiggerln: (@)
Trigger Edge: | Rising -
ZDA Amives:  |On TOA v
l Reset Time Sync lﬂmeS}cht.rlpul ]
[ ox J[ romr ][ coren |

2. Selectthe SPRINT Port for ZDA Output and 1 PPS Output and then click Apply.

Time Sync Output (=
ZDA Output
@ SPRINT Port:
cl v] | Configure | [ Comms |
@ PC/LCH Port:
| Corfigure | | Comms |

1 PPS Trigger Output

SPRINT Port: Trigger Output: (D)

Enleae=s)

Note

Both the ZDA and 1 PPS must be configured if a time sync output is required (f only one
parameter is configured then the SPRINT 300/500/700 will not output the time synch).

6.4.7 USBL Aiding

To configure the USBL Aiding:
1. Click Configure > INS > USBL Input or right-click on the USBL Aiding LED.

2. SelectUSBL Aiding Input Type: PSIMSSB (Default) or USBL GGA (Acoustic); see Figure
6—19.Typical USBL aiding inputs are shown below:

« Sonardyne Ranger/Fusion USBL or EIVA NaviPac: Acoustic GGA.
« Sonardyne Marksman/Ranger 2 or Kongsberg HiPAP: PSIMSSB.

Section 6 — Combined INS & AHRS Operation 55



User Manual for Type 8253 SPRINT 3rd Generation UM-8253-SPRINT

Issue A3

3. Onthe PC/LCH Port enter the IP Address for the serial input via the LCH
(192.168.179.51:5004) by clicking Configure; see Figure 6—18).

4. Ifrequired, specify a Beacon ID filter; see Appendix D "INS Message Definitions" for details of
the beacon ID field of the different USBL aiding messages.

Figure 6-19 USBL Aiding

USBL E
USBL Aiding Input
Type: |USBL GGA -

PCALCH Port:  192.168.179.51:5004

Fitter by Beacon 1D

Port connected
USBL Quality

Set USBL Aiding Guality

USBL Beacon Mourting {From Vehicle CRFP)

st 00502 et
Starboard: |0.000 = Metres
Down: |0.000 = Metres

‘ oK | Apply | Cancel ‘

5. USBL Aiding Quality Settings can be configured by clicking Advanced Settings; see Figure 6—
20.

Note

The default setting is for the SPRINT system to use the quality value provided by the USBL

system in the aiding message; see Figure 6-28 of accepted USBL message types see Appendix D
"INS Message Definitions".

Figure 6-20 USBL Aiding Quality Settings

R
USBL Advanced Settings =R g
Horizontal Quality Mode Set Vertical Quality
() Manual @ Use Qualty From Message () Advanced Vertical Quality:  0.00 Metres
Set Manual Quality Set Scale Factor Time
Horizontal Quality: Metres Scale Qualty by:  1.00 Source:  Auto -
Set Quality Adjustment Set Rejection Criteria SEET .00 EECu
Max. SD limit: 1.00 Seconds
[] Enable ] Enable
Min Horizontal Quality: Metres Mazx Horizortal Quality: Metres
NN
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a. Use Quality from Message: The quality value from the USBL message can be scaled
to resolve for systematically incorrect USBL Quality.

USBL Advanced Settings = = =

Harizontal Guality Mode Set Vertical Quality
® Manual ® Advanced Vertical Qualty: 0.00 Metres
Set Manual Quality Set Scale Factor Time

Horizontal Quality: Metres Scale Quality by: 100 Source:  Auto -
Set Quality Adjustmert Set Rejection Criteria Td=on 0.00 Seconds
[ Enable [ Enabie Max. 50 limit: ~ 1.00 Seconds
Min Horizontal Guality: Metres Max Horizontal Quality: Metres

RN

b. Manual: In some cases, it may be required to set a manual horizontal quality value:

« Ifusing Sonardyne Ranger, Fusion USBL or other USBL systems where no quality
value is provided.

« The quality value provided by the USBL system is overly optimistic.

USBEL Advanced Settings E‘Iﬂlg
Horizontal Quality Mode Set Vertical Quality
) Use Quality From Message (©) Advanced Vettical Qualiy:  0.00 Metres
Set Manual Quality Set Scale Factor Tz
Horizontal Quality: 200 Metres Scale Quality by: Source:  Auto -
Set Quality Adjustment Set Rejection Criteria Latency: 0.00 Seconds
@ = [ Ensble Map. SDlimit: ~ 1.00 Seconds
Min Horizontal Quality Metres Max Horizontal Quality: Metres
et |t oot

c. Advanced: This configuration allows horizontal quality to be used from the USBL

message whilst able to set scale factor, minimum and maximum quality values for the
USBL position.

« Min Horizontal Quality: Use this quality to improve shallow water USBL aiding (quality

adjustment), when the USBL system is reporting a false (overly optimistic) position
accuracy, the minimum quality value can be set.

« Max Horizontal Quality: Use this quality value to reject very poor USBL aiding (quality
pre-filter).

USBL Advanced Settings el & ==

Horizontal Quality Mode Set Vertical Quality
) Manual () Use Quality From Message fizncaluiy S .00 Pe=s
Set Manual Quality Set Scale Factor Time

Horizontal Quality: Metres Scale Quality by 1.00 Source:  Auto -
Set Qualty Adjustment Set Rejection Criteria LAz 0.00 it
T ot Mze SDlimi:  1.00 Seconds
Min Horizontal Quality: 100 Metwes Max Horizontal Guality: 300 Metres

ot it st
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d. Vertical USBL Quality: If USBL depth aiding is used, the configured vertical quality will

be used by the INS. The value should be set according to the method of depth
measurement:

« Acoustic

« Sensor Measurement

USBL Advanced Settings =] & ==

Horizontal Quality Mode Set Vertical Quality
(7) Manual @ Use Quality From Message (©) Advanced fRetcaliticy 0.0 SRR
Set Manual Quality Set Scale Factor Time

Horizontal Quality: Metres Scale Quality by: ~ 1.00 Source:  Auto -
Set Quality Adjustmert Set Rejection Criteria Ewme 1.00 Seconds
[ Enable [ Eabe Mz, SD limit: ~ 0.00 Seconds
Min Horizontal Quality: Metres Max Horizontal Quality: Metres

ERENET

On the USBL Beacon Mounting (from Vehicle CRP) enter the Lever Arm offsets from the ROV

CRP to the USBL beacon. After changing the lever arms the INS algorithm will be automatically
reset to use the new settings.

7. USBL Aiding Time Source:

a. Auto: This mode will accept the USBL aiding message as Time Of Arrival, unless a time sync
has been configured, then the Time within the USBL message will be used.

b. Use Time within Message: This mode will use the time stamp within the USBL aiding
message.

c. Use Time of Arrival : This mode will validate the USBL aiding message on time of arrival
only (time the telegramis received).

USBL Advanced Settings = [ i
Horizontal Quality Mode Set Vertical Quality
() Manual @ Use Quality From Message () Advanced Vertical Quality:  0.00 Metres

Set Manual Quality Set Scale Factor Time

Horizontal Quality Metres Scale Quality by: ~ 1.00 Source:
Set Quality Adjustment

Set Rejection Criteria Latency:  Use time within message
e GBI Use time of amival
e, SO limt: A
[] Enable [] Enable

Min Horizontal Quality Metres Max Horizontal Quality: Metres

o [t ] s |

d. Latency: This sets the latency that is applied to the USBL aiding message.
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e. Max SD limit: This sets the Max Time System SD rejection criteria for the USBL message
when the SPRINT system is time synchronised (ZDA or ZDA + 1PPS) with time source
configured as Auto or Use Time within message.

USBL Advanced Settings =] = ==
Horizontal Quality Mode Set Vertical Quality
() Manual @ Use Quality From Message () Advanced pencali=i gy 0.0 Bletes
Set Manual Qualty Set Scale Factor Time:
Horizontal Quality: Metres Scale Quality by:  1.00 Source:  Auto -
Set Quality Adjustment Set Rejection Criteria S 1.00 S=cou=
[] Enable [] Enable Mz, SO limit 0.00 Seconds
Min Horizontal Quality: Metres Max Horizontal Quality: Metres
ER N

8. Click OK to close and save all entered settings.

Note

If Sonardyne Marksman or Ranger 2 software is being used for USBL aiding, configuration
instructions are provided in Section 6.4.24 "Marksman & Ranger 2 USBL Aiding".

6.4.8 Depth Aiding

To configure the Depth aiding:
1. Click Configure > INS > Depth Input or right-click on the Depth Aiding LED.

2. Nointernal pressure sensor; on the Depth Type drop-down list, select DigiQuartz (kPa, PSl or
Metres); NMEA DPT, External Depth or Son Depth; see Figure 6-21.

3. Selecta Depth Input by selecting either PC/LCH Port or SPRINT Port.

4. Ifthe sensor is connected via a serial connection, select the PC/LCH Port and enter the IP
Address for the serial input via the LCH (192.168.179.51:5005) by clicking Configure (as shown
in Figure 6—18).
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5. Ifthe sensor is connected directly to the SPRINT 300/500/700, select SPRINT Port and the
relevant connection point (C1, T1, T2).

Figure 6-21 Depth Aiding

Depth >
Depth Type
Type: | DigiQuartz (PSI) “
Depth Input
SPRINT-Mav Intemal Pressure Sensor Comms
() PC/LCH Port:
None Configure Comms
(® SPRINT Port:
|C1 v| | Configure | | Comms |
Surface
ofeet s | AutoSa
Depth Sensor Mounting
(® From Vehicle CRP ) From IMU
Forward: |0.000 El Metres
Starboard: Metres
Down: (0.000 Iil Metres
o | ] [ |

6. Click Configure and enter the SPRINT 300/500/700 port configuration settings; see Figure 6—

22.
Figure 6-22 SPRINT 300/500/700 Port Configuration

SPRINT C1 Configuration ==

Protocal: [H5232 V]

Baud Rate: [BBDEI v]

Parity: [None V]

Data Bits: [3 v]

Stop Bits: [1 v]

| ee—

7. Click OK to save all entered settings and return to the Depth window; see Figure 6-21.

8. Enter the Surface Offset value in metres if required. If the ROV is on deck and the ambient
surface pressure is to be removed from raw pressure depth value, click Auto Set.

9. Enterthe Depth Sensor Mounting (from Vehicle CRP) Lever Arm offset from ROV CRP to
Sensor (after changing the lever arms the INS algorithm will be automatically reset to use the new
settings).

10. Click OK to close and save all entered settings.
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To view Pressure Depth Aiding residuals and depth, right-click on the Depth aiding LED and
select View Pressure Depth Aiding; see Figure 6-23 and Figure 6—24

Figure 6-23 Enable Aiding Plot

LBL Depth DvL sV Ext Pos ZUPT

Configure

Disable

| View Pressure Depth Aiding I

ngle: Valid, Time unlimit: Time: 15/06/201512:15:52

Figure 6-24 Pressure Depth Aiding Plot

¥ Pressure Depth Aiding | = R

150140

B i s S  PH

B e TR S e [

160,040

0.040

-0.040
165:68:10

6.4.9 DVL Aiding
To configure the DVL Aiding:

1.

a bk oNn

Click Configure > INS > DVL Input or right-click on the DVL Aiding LED.

Selectthe SPRINT Port from the drop-down list and then click Apply; see Figure 6-25.
Select the type of DVL to be connected: Syrinx, TRDI DVL or Other.

If the DVL is to be triggered by SPRINT, select the Triggered by SPRINT unit check box

Select the Hex-ASCII DVL Data Output checkbox if the DVL will be outputting ASCII data; if left
unchecked the SPRINT 300/500/700 will expect binary data (default).

Note

The Use Syrinx Beam Level check box is to enable beam level aiding for SPRINT-Nav
hardware, not for use on separate Syrinx and SPRINT unit mounting.

6. Enterthe Scale Factor and Latency values from the DVL calibration.
7. Enterthe Lever Arms offsets from the ROV CRP to DVL and the the Mounting Angles from

the ROV frame to the DVL (after changing the mounting angles or lever arms the INS algorithm
will be automatically reset to use the new settings).
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Note

The DVL mounting angles, scale factor and latency can be calculated using the calibration
procedure explained in Section 6.11 "DVL Calibration Procedure". If the DVL input is being
configured on deck prior to the calibration, it is recommended that the default mounting angles,
scale factor and latency values are used.

Figure 6-25 DVL Aiding

on =
SPRINT DVL Connection
SPRINT Pot: | Coniue | | comme
SPRINT-Nav Intemal DVL
Select DVLtype: @ SYRINXDVL (O TRDIDVL () Other DVL
Triggered by SPRINT unit [ Mllow 3 beam solution to be used
Hex-ASClI DVL Data Output [ Use Syriree Beam Level

DVL Corfiguration

Calibration

Scale Factor: % Latency: Seconds

DWL Calibration Settings
DVL Mourting

Lever Ams (From Vehicle CRP) Mounting Angles (From Vehicle Frame)

Forward: |0.000 EI Metres Heading: Degrees

Starboard: 0.000 |+ Metres Resufting Pich: |0.000 |£] Degrees

Down: Metres Resulting Roll: Degrees

RN

8. Ifthe DVL connected to the SPRINT 300/500/700 is a Sonardyne Syrinx DVL or Teledyne RDI,
the SPRINT system can automatically program it for use with SPRINT. To configure the DVL
click the Auto Configure button; the DVL configuration dialog box will open; see Figure 6-26

Figure 6-26 DVL Auto Configuration

Configure DVL ... EI@
DVL Mode Data Format Select Data Stream
@ Triggered @ Bin commended) @ PD4 (Recommended)
B > > B
() Free Running Hex-ASC (") Beam Level
Status: Cancel

Note

Make sure the Syrinx/TRDI DVL is connected to the SPRINT 300/500/700 and powered before
trying to configure it.

DVL Mode: If the DVL cabling will allow the SPRINT 300/500/700 to send a trigger to the
selected DVL , select Triggered, otherwise select Free Running.

Data Format: The data format output of the DVL will be set to Binary by default. If Hex-ASCll is
required, select Hex-ASCII.

Select Data Stream: This function sets the data stream message output of the Syrinx DVL
(beam level only to be used for Sonardyne SPRINT-Nav hardware).

9. Click Configure to configure the DVL,; the software will display the progress of the configuration
process.
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10.

11.
12.
13.

14. The DVL Alignment to vehicle frame quality options are described below.

UM-8253-SPRINT
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If the DVL is already configured, the Deploy button will command the DVL to start making
measurements.

When the DVL has been configured, return to the DVL dialog box.
Click OK or Apply to save the settings.

Click DVL Calibration Settings to set DVL Alignment and import DVL Calibration file from
Janus. For more information see Section 6.11 "DVL Calibration Procedure”.

Figure 6-27 DVL Calibration Settings

DV =]
SPRINT DVL Connection
SPRINT Port:  (T1

- l Corfigure ] [ Comms

] SPRINT-Mav Intemal DVL

Select DVLtype: @ SYRINXDVL (&) TRDIDVL (@) Other DVL

Triggered by SPRINT unit [] Mllow 3 beam solution to be used
Hex-ASCI DVL Data Output Use Syrirec Beam Level

Calibration

Scale Factor: % Latency: Seconds

DVL Calibration Settings
DVL Mounting

DVL Configuration

Lever Ams (From Vehicle CRP)
Forward: (0.000 |2 Metres

Starboard: Metres
Down: Metres

Mounting Angles (From Vehicle Frame)
Heading: m Degrees

Resulting Pitch: Degrees

Resutting Roll: Degrees

Lo [ |

Cancel ]

Calibrated: The calibrated alignment option is set as default and must be selected if applying a

DVL Calibration by either importing a DVL Calibration file or manual entry.

Pre-Calibrated: This option should only be selected if the SPRINT 300/500/700 is co-located
with a DVL and has been pre-calibrated using GPS (RTK) prior to installation on the ROV.

Un-Calibrated: If it is not possible to perform a DVL calibration then this option may be selected
to relax the DVL alignment error, reducing INS rejection (the DVL must be aligned within 3° of the

vehicle frame).

DVL Calibration Settings =] @ |
DVL Alignment DVL Calibration
@ Calibrated
() Pre-Calibrated Import DVL Calibration file
) UnCalibrated
o [ ] [Loms |

15. The DVL Aiding window displays the raw DVL velocities, vertical ranges and residuals that can
be selected on the View menu or by right-clicking on the DVLAIding LED and selecting View
DVL Aiding (aiding data plots can be viewed for all aiding sources except SV).
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Figure 6-28 DVL Aiding Plot

. DVL Aiding =N B =

B 35 BM3 —— B4
RDI PD4 i

3-Beam soluti enabled

Tilt informatio t used
strument-Co nate Velocities

9.00e-003 mis .

10:51:45 10:51:50 10:51:55 10:52:00

2.00e-003 mis

0.00e+000 m/s

0.00e+000 m/s

30.00 m

30.00 m

30.00 m

30.00 m

-0.010
10:57:50 10:52:00

5.97e 004 m/s

ooin
Used

-0.01o

10:51:40 10:51:46 10:51:50 10:51:56 10:52:00

6.4.10 Sound Velocity

To configure the Sound Velocity:
1. Click Configure > INS > DVL Input.
2. Click Sound Velocity or right-click on the SV Aiding LED and then click Configure.
3. Selectthe Sound Velocity Type from the options shown below; see Figure 6—-29.

« DVL Derived: valid for most ocean conditions; with this method the sound velocity is
automatically calculated using the salinity value and measurements from other aiding sensors
such as DVL (Temperature) and Pressure/Depth (Pressure).

« Various options for receiving sound velocity measurement messages from a sensor or other
sources, such as a Valeport Mini-SVS.

« Manual Sound Velocity.

4. If Sound Velocity messages will be received from a sensor or other source, specify and configure
either:

« The SPRINT 300/500/700 port which will receive the Sound Velocity message (on the
vehicle).

o The LCH or PC port which will receive the Sound Velocity message (topside).
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5. If Manual Sound Velocity is selected, a value can be entered in the Manual Sound Velocity
box.

6. Click OK to close and save all entered settings.
Figure 6-29 Sound Velocity Configuration

SoundVelocity E

Sound Velocity Type
e
Salinity: |35.00 | PPT
Sound Velocity Input
@ PC/LCH Port:
192.168.179515005 | Configue | | Comms |
() Lodestar Port:
v|| Configure || Comms |
Port connected
Manual Sound Velocity
1485 Metres per second
[ ok J[ e ][ comes |

6.4.11 LBL

To configure LBL aiding:
1. Click Configure > INS > LBL Input or right-click on the LBL Aiding LED.

2. SPRINT Transceiver Connection: Select the SPRINT Port that the LBL transceiver is
physically connected to (usually T2); see Figure 6—30 and then configure the baud rate as
required by clicking Configure; see Figure 6-22.

3. Fusion LBL Interface: Specify the PC port that will be used to provide LBL transceiver
communications to the Fusion LBL software.
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4. Click OK to close and save all entered settings.
Figure 6-30 LBL Aiding Configuration

ﬁl

SPRINT Transceiver Connection
SPRINT Port:

[r2 v] [ Conigwe | | Comms |
Fusion LBL Interface
Transceiver PC/LCH Port:

coM4 | Configure | | Comms |
INS PC/LCH Port:

coms | Corfigue | | Comms |

LBL Aiding Range
Mirimum: 25 000 [2] Metres

Madmum: 2D00.000 EI Metres

Fusion LBL Transceiver Lever Ams (From Vehicle CRF)

Forward: 0.0000 Metres
Starboard: 0.0000 Metres
Down: 0.0000 Metres
Lok J[ ey || conen |

5. Referto Section 6.7 "Fusion LBL Aiding"to configure Fusion LBL for use with SPRINT.

Note
Depending on the SPRINT version purchased, LBL aiding may not be available.

6.4.12 External Position Aiding

To configure External Position Aiding:

1. Click Configure > INS > External Position Input or right-click on the Ext Pos Aiding LED and
select Enable; see Section D.14 "Proprietary XPOS Report'for External position (XPOS)
message format.
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2. To configure External Position as an aiding source, select the External Position Aiding Input.
Figure 6-31 External Position Aiding Configuration

External Position E

Bxtemal Position Aiding Input

PC/LCH Poit: ~ COMIT

I Comms I l Remove
Port connected
Manual Posttion and INS Reset
Latitude™: Decimal Degrees
Longitude™: Decimal Degrees
[] Reset INS

*In WG584
Set Position Quality
Set Manual Position Quality
Horizontal Guality: 030 Metss
Vertical Quality: r Metres

Bxtemal Position Mourting (From Vehicle CRP)

Forward:  |0.000 2| Metres

Starboard: Metres

Down: 0.000 El Metres
NN

3. Click Configure and select PC Serial or Ethernet/LCH. If using an Ethernet/LCH port, enter
the IP Address for the serial input and socket (192.168.179.51:5004) by clicking Configure, as

shown in Figure 6—18.

4. Tosend a manual External Position, select Manual Position, enter the Latitude and Longitude
and then click Apply or OK. Manual Position aiding will be used by the INS without restarting the
INS unless the ‘Reset INS check box is selected.

Manual Posttion and IN5S Reset

Latitude™: W Decimal Degrees
= Longitude™: 083563  Decimal Degrees
@ Reset INS

*In WGS84
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5. External Position Quality settings can be configured on the Set Position Quality pane. Manual
Horizontal and Vertical Position Qualities are set as default. Clear the Set Manual Position
Quality check box to use the default values. See Section D.14 "Proprietary XPOS Report'for
External position (XPOS) message format.

Set Posttion Quality
Set Manual Posttion Quality
Horizontal Cuality: 030 Metres
Vertical Guality: Mﬂ— Metres

6. Click OK to close and save all entered settings.

6.4.13 GPS Aiding

To configure GPS aiding:
1. Click Configure > INS > GPS Input or right-click on the GPS aiding LED.
2. Click Configure to set up the aiding input Ethernet/comms port.
a. Ethernet/LCH port:

i. Select Ethernet/LCH and enter the IP address for the serial input via the LCH
(192.168.179.51:5002).

ii. Click OK.
b. Serial port:
i. Select PC Serial and select the comm port and baud rate.
ii. Click OK.

GPS *

GP5S Aiding Input
PC/LCH Port: |192.168.179.51:5002 Configure

Comms Remove

GPS Quality

Minimum Cuality:
man Cut

GPS Antenna Mounting from Vehicle CRP)
Foreard: |0.000 El Metres

Starboard: Metres

!

oK Spply Cancel
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3. The quality of GPS Aiding can be rejected/accepted by selecting Minimum Quality and
Maximum Quality.

Note

If enabling GPS on deck to compensate AHRS, ensure GPS aiding is disabled and USBL aiding is
enabled prior to vehicle deployment.

6.4.14 INS
To configure the INS:
1. Click Configure > INS.
Figure 6-32 INS Configuration

IMNS >
Position Aiding Inputs Depth Aiding Inputs
USBL  [[] Extemal Position Pressure Depth
LBL ] GpPs ] USBL Depth
Velocty Aiding Inputs [] Extemal Position Depth
[] ovL

LBL Aiding requires INS to be initialised

s ok [ | oo

2. Selectthe INS Aiding Inputs; USBL, Pressure Depth and DVL are selected by default.

Note
The INS can be reset at any time by clicking Reset INS.

3. Click OK to close and save all entered settings.
6.4.15 Options

To configure software options proceed as follows:
1. Click Configure > Options.
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2. Clickthe INS Position Chart Settings tab to configure preferences for the software INS chart

display.
Figure 6-33 INS Position Chart Settings
Options ol & e
INS Position Chart Settings | Extemal Postion Chart Settings | User Limts | Misc. Options |
INS Fosition
Centre on INS Position Use Shape ROV_INS -
Forward Shape Offset: 0 History Length: 500

Starboard Shape Offset: 0

Horiz. Nav Quality Measure: 1 SIGMA -

i) (ot (et

3. Click the External Position Chart Settings tab to configure preferences for the software
external chart display. If using Windows® 7, double click on either the USBL, INS or Transponder
chart shapes to centre on the main chart.

Note
Show LBL range history can only be enabled if using Windows® 7.

Figure 6-34 External Position Chart Settings

Options =R EoR==|
INS Position Chart Settings | Extemal Position Chart Settings | User Limits | Misc. Options
USBL Posttion
Centre on Edemal Position Use Shape Beacon -
Forward Shape Offset: 0 History Length: 500

Starboard Shape Offset: 0

External Position
Centre on Edemal Position Use Shape Beacon -
Forward Shape Offset: 0 History Length: 500

Starboard Shape Offset: 0

LBL Transponder Position and Ranges
Show LBL beacons and ranges
Show LBL range history History Length (110 60 mins range): 40 Mins

it o] oo
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4. Clickthe User Limits tab to configure navigation horizontal and depth quality limits (if the limits
are enabled the software will alert the user if the limits are exceeded; see Section 6.10.7
"Navigation Quality Limits"for more details).

Figure 6-35 User Limits

Options == EeR==|

| INS Posttion Chart Settings | Extemal Postion Char Settings | User Limits. | Misc. Options |

Enable

INS Quality Limits
Horizontal Nav Guality Limit Depth Nav Quality Limit
Quality Measure: |1 SIGMA Quality Measure: |1 SIGMA
Limit (m):  10.00 Limit fm):  5.00

Heading MNav Quality Limit

Quality Measure: |1 SIGMA

Limit (deg): 1.00

] ot e

5. Clickthe Misc. Options tab to configure the position text type and history length of the time
series plots (it is recommended to select the Automatically Start with Windows option).

Figure 6-36 Misc. Options

Options = e ==
[ INS Postion Chart Seitings | Exemal Posiion Chiart Seftings | User Limts | Misc. Options |
Text Display Options
@ Show Posttion in Lattude and Longitude

) Show Position in Eastings and Northings

Startup Options
Automatically start with Windows

Time Series Limits

Higtory Length (1to 30 mins range): 20 Mins

Configuration Backup

Backup the corfiguration every Hours

6. Click OK to close and save all entered settings.

Note

The Show LBL beacons and range history option within the External Position Chart Settings
tab can only be enabled when using Windows® 7.
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6.4.16 Logging

To configure the Logging process:
1. Click Configure > Logging.
Figure 6-37 Logging Configuration

Logging o] = ==

Log File Suffix: Sprint

Log File Location: |C:'-.Users'-.Public'-.Doc:umerds'-.Sonardme'-.Hub'-Logﬁles |

Cument Log File (00003 _20180223_17.10_Sprint bin |

Start New File Every: m Minutes
Max Log Folder Size™: 10 GBytes
] (o ] [omen |

* Oldest log files deleted when max. log folder size reached.

2. Default settings for logging are already defined but may be changed as required.

3. Click Restart Logging to close the current log file and open a new one.

6.4.17 Remote Output Points

To configure the Remote Output Points:
1. Click Configure > Outputs > Remote Points.

Figure 6-38 Remote Output Points Configuration

Remote Points E

Remote Poirt A Remote Poirt B

Lever Arms (From Vehicle CRFP)

Forward: Metres

Starboard: | 0.000 El Metres

Dawn: Metres

Lever Arms (From Vehicle CRF)

Fanward: Metres

Starboard: |0.000 EI Metres

Down: Metres

Lo [ o ]| coes |

2. The system can support navigation and attitude outputs with respect to two remote points on the

vehicle.

Note

By default all outputs will be with respect to the CRP of the vehicle.

3. Enter any lever arms for the remote points from the CRP to the remote point specified.
4. Click OK to close and save all entered settings.
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6.4.18 SPRINT 300/500/7000utput

To configure outputs from the SPRINT 300/500/700 ports:

1. Click Configure > Outputs > SPRINT > Port Outputs. SPRINT ports that are not currently in
use (connected to the topside system or to an ROV sensor) will be available to configure as an
output.

Figure 6-39 SPRINT system Output Configuration

[ santpoostpts =]

[Bhemet [cP | C1 [0 [T2 |

I M5G Rate Qutput Frame: Source

el ettt oo

2. Click the tab for the required port to configure.

3. Select the message type, output rate and if a remote output point is to be used (the default output
will be with respect to the vehicle CRP). For some outputs (such as a raw sensor feed) an output
rate cannot be specified as this is defined by the sensor itself.

4. Click Apply to configure the output.
5. Iffurther outputs are required, click Add and repeat the configuration steps outlined above.

6. After configuration, click OK to close and save all entered settings.

6.4.19 PC Port Outputs

The system supports two local output ports (primary and secondary). To configure outputs from the
local PC or LCH ports:
1. Click Configure > Outputs > PCA CH Port Outputs.
Figure 640 PC Output Configuration
M

Output T | Qutput2 mpua|oupu4
PC/LCH Port:  192.168.179.51:5006 Status : Port connection established

| msa Rate Output Frame Source
Sonardyne SONZ ~[10 CRP ~ | aHRs

[ =
Waming: Outputs from PC/LCH ports may be latent {<=0.5secs). ’ ok ] [ = l [ c ]

For zemo latency use output(s) direct from Lodestar portis).
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2. Click the tab for the required port to configure.

3. Configure the PC/LCH Port; enter the IP Address for the serial input via the LCH by clicking
Configure (as shown in Figure 6—18).

4. Output ports can be configured for multiplexed messages as shown below.

Primary cutput port E

Connection Type
(7 PC Serial @ Fthemet / LCH

Connection Details

IP Address:  192.168.173.51

Part: S00E
@ TCP Cliert ) UDP

Format: ‘E H! - '
Multiplexed
QK Cancel

5. Select the message type, output rate and if a remote output point is to be used (the default output
will be with respect to the vehicle CRP). For some outputs (such as a raw sensor feed) an output
rate cannot be specified as this is defined by the sensor itself.

6. Click Apply to configure the output.
7. Iffurther outputs are required, click Add and repeat the configuration steps outlined above.
8. Click OK to close and save all entered settings.

Note

The Data Rate and Output Frame cannot be changed when selecting DVL, SVS and any Depth
messages.

6.4.20 View Lever Arms

To view a 3D representation of the configured sensor offsets:
1. Click View > Lever Arms.

2. Side and top views of all offsets are displayed as shown below.
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3. Check that all offsets are correct and no errors are present.

Note
Scale is dependent on the level of zoom applied.

Figure 641 View Lever Arms

K2 View Lever Arms ol = ==

Side View:

Top View:

6.4.21 View Comms Map

To view the SPRINT topside comms configuration, proceed as follows:
1. Click View > Comms Map.
Figure 642 View Comms Map

8 Comms Mep =

Name

Port Details Input Output

Port Type
nt
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6.4.22 Main SPRINT System Software Window

To configure outputs from the local PC or LCH ports:

1. Click the Zoom All button to auto zoom the chart on the main software window to keep all chart
shapes visible at all times.

@,

2. Click the Zoom In button to zoom in the chart display.

Q

3. Clickthe Zoom Out button to zoom out the chart display.

K

4. Click the Erase History button to erase any position history trails on the chart display.

2]
©

6. Allaiding inputs can be enabled/disabled for INS use or configured by right-clicking on the
appropriate aiding input LED and selecting the required option.

5. Clickthe INS reset button to reset the INS.

USBL LBL Dep
Configure

Disable

View USBL Aiding

6.4.23 Fusion LBL Aiding

Tointerface Fusion LBL to SPRINT system for aiding, follow the steps below (for further information
on operation of Fusion, see UM-8025 “User Manual for Fusion LBL").

This procedure assumes the following connections have already been configured:
« A SPRINT 300/500/700 is running and connected to the SPRINT system software.

« LBL Transceiver is physically connected to SPRINT 300/500/700 T1 or T2 port and is
powered.

« The Fusion LBL interface ports have been configured in SPRINT (see Section 6.4.2
"SPRINT System Connection"
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o Transceiver PC Port

o INS PC Port

1. Open Fusion LBL and add an LBL Transceiver from the acoustic instruments group on the job

tree.

Create New Instrument E

El-*%. Transceiver

N Transceiver 5G
£ UsBL

2. RovNav 5 (Adv)
L% RovNav 5

Instrument Name | LBL Tevr

IOKI[C&noeI]’Heh]

2. After adding an LBL transceiver, specify the PC COM port configured in SPRINT.

3. Onthe LBL Transceiver properties window, click Advanced to open the advanced transceiver
options window.

Transceiver Tcvr 1 Properties E

Summary / Comms | Battery / Release | Depth / Temp. / Sound Speed | Roll / Fitch |

Name Ichr'I Type ITmnscei\rerHE (HPT/RN
Frequency IMF' Finmware |3.05.un.m )
DD‘IES?"
uib Advanced ... |

s [ e
Erers I‘Mdeband‘u"Z

Communications
Port [Pag COM204 =] config. | Show Comms |
Cor]P;c:ion I‘u"la Musc LI Test

(0]:4 I Cancel | Apply | Help
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4. Onthe Comms reset drop-down list, select None and then click Close.

Advanced Ranging Options =
sddimss |22m B e |1.4 mir # 17:26:10 23 Feb 2018 ~ Multi-user Subscription -
Multi-user enabled [ Get Subscription Status |
Fianging power hd Transmitwait | 190 = s Corman Reply Ranging
Interragation Signal TAT [ms) power
Telemetry power ILOW jv Blocking delay 100 _:| ms IUnknown IUnknown IUnknown IUnknown

Receive gain IHiQh 126 dE) j' “wiake Lp tone IWake Up1 j' Iunknown IUnknown IUnknown IUnknown
Common Iﬁ
Interogation MF CIS1E00 Activity time I18 hours j' IUnknown IUnknown IUnknown IUnknown

Individual Reply - [M2201 jv Detect threshold IAUED IUnknown IUnknown IUnknown IUnknown
Turn Around Time |2DD i ,l
[milliseconds) ' Extra comms ID_D

delay (5] —Acoustic Link Statu.

HPF Channel IDfF vl C Im 0 i Tl 5
omms reset s rosz-corelation elemetry Sync l—
ID 1]

tabuz

M awimurn range Wﬂ NOtT: Eomn;s_b;ud raéle iTItrEnstEeivei " |[4UN sU] " SL l
muzt be set independently by the user ignal to Noise I nterference Level l—
WI Ise in tracking [ Aol LB dEB?\,].' i (0-40 i
e P Consn 0.3 |
Get Link Status |

Show Comms | Show Moise Plat | Close |

Use diagnostics W
Get | Set | .

Note

In later versions of Fusion, the baud rate of the transceiver may be automatically changed
when it is added. In this case the baud rate of the transceiver must be manually changed in the
SPRINT system to match Fusion and the new baud rate of the Transceiver.

5. Onthe Transceiver LBL Tcvr Properties Summary/Commes tab, click Test to check connection
and communications to the Transceiver.

6. Once connection is established the Fusion software will confirm that the instrument is working.

Transceiver Tcvr 1 Properties E

Summary / Comms | Battery / Release | Depth / Temp. / Sound Speed | Roll / Fitch |

Name Ichr'I Type ITmnscei\rerGG (HPT/RN
Frequency IMF' Finmware |3.05.Du.m 1]
DD‘IES?"
vo Advanced ... |

. =
Scheme I\'\ﬁdeband‘u'?

Communications
Port [Pag COM204 =] config. | Show Comms |
Cor]P;c:ion [Via heoc | Test

QK I Cancel | Apply | Help

7. Click OK to close the Transceiver LBL Tcvr Properties page.

Section 6 — Combined INS & AHRS Operation 78



UM-8253-SPRINT
Issue A3

User Manual for Type 8253 SPRINT 3rd Generation

8. Adda SPRINT 300/500/700 from the non-acoustic INS instruments group on the job tree:

Create Mew Instrument E

- Communications
[ GNSS Instrument
@ Heading Instrument
]‘_t Wertical Reference Unit
&L Motion Reference Unit
EI? Inertial Instrument

[ ‘ Lodestar

(%) Time Sync Instrument
% External System

JL Depth Instrument
---pp‘c CTD / Sound speed

Instrument Name I SPRINT

oK I Cancel | Help |

9. After adding the SPRINT 300/500/700, specify the PC COM port that has been configured in the
SPRINT system.

Non-Acoustic Instrument "SPRINT" Properties E

Summary / Comms | Postion Data | Heading Data | VRU Data | Depth Data |

SPRINT Type [Lodestar ‘

Tracking
’7 ¥ Use in tracking

Name

Transceiver I‘m Tewr 1-Tdr 1 j Config. Tewr |
Port B2y coM216 ] _Config ot |

Show Comms | Timing |

OK I Cancel | Apply | Help |

10. The PC port may be a physical COM port of a virtual serial port pair if Fusion is running on the
same PC as the SPRINT system.

11. Select the transceiver connected to the SPRINT 300/500/700 from the Transceiver drop-down
list.
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12. Tocheckthe SPRINT 300/500/700's output to Fusion, select either the Heading, VRU, Depth or
Position tabs (the data displayed will be sourced from the SPRINT 500/700).

o
Non-Acoustic Instrurnent "SPRINT" Properties ===

" Summary / Comms | Position Data Heading Data |‘u"F{U Data | Depth Data I

Grid Heading {Comected)
Raw heading |0.00°

I—
Comoction (Subtracted) [IE

Magnetic variation IW

Convergence IDD‘P—

Sentence Im
Bearingtype |True

Calculated Heading

Magnetic  |-1.00°

True [0.00° Age / Last IUnknown

Gnd Iﬂ.DD’ Float Display | Show Comms |
OK I Cancel | Apply | Help |

13. Click OK to close and save entered settings.

14. After adding the INS (SPRINT 500/700) and Transceiver, they should be listed on the Fusion
LBL Job Tree.

-3 Job: "LBL Sparse 1,jcf"
M nits

it

o™ Global Settings
-&¥ Geodesy

- Logging

I:—]é Instruments
EI Mon Acoustic
- . SPRINT
-- Transceivers
# Beacons
Deu Comms
Ey@ Yehicles

.39 ROV: "ROV"
Eg...ﬂ Arrays

ir Envircnmental
B-¥F Guidance

--[E] Reports

15. The instruments must now be added to an ROV. Select the ROV from the job tree and then open
the Instruments tab on the ROV properties dialog box.
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16. Add the INS and the appropriate Transducer by clicking the Add button and selecting from the list
of available instruments.

Select the Instrument or Senzor you wish to attach to the offset and press O to add it.
Mame Type Dezcription
=@ LBL Tewr Transceiver BG
Tranzducer
JLS Depth Sensor Strain gauge
ﬂ. Temp. Senzor Temperature gensor
< | I | 3
[ ey ] [ Caonfigure ] l QK. I [ Cancel ] [ Help ]

17. After adding each instrument, click Configure on the Offset pane and enter the instrument
offsets.

ﬁ

'General Instruments & Offsets | Positioning | Chart |

Instrument | Sensor | Mame | Starbo.... | Forward I Up Instrument
E,TCVT 1 Tdr 1 Offsetl 0000m O0O000m O0.000m
‘SPF{INT Offget2 2080m -2135m 08%m Ad

Configure

Remowe

d

Configure

e [l

Remowve
] i | »

OK | Cancel |  rpnly

Hep |
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18. Enter the offsets for both instruments with respect to the vehicle CRP.

Note

The convention for the instruments may differ from the SPRINT system. These values only
require entry at this point as they will automatically be sent to the SPRINT system.

Properties for Offset "Offset2” E

General |
MName Vehicle ROV
Description
Instrument - Sensaor Configure
Show Label

Cifsets from the Vehicle’s Common Reference Point

Starboand Forwand Up
0.000m 0.000m 0.000m
(oK J[ Camcel J[ ooy |[ e ]

19. Click OK to close and save all entered settings.
20. Onthe Properties for ROV window, click the Positioning tab:

Properties for ROV "ROV" E
| General | Instruments & Offsets| Pestioning | Chart |
Acoustic Update Sound Speed
Interval 10s @ Use global S
1485.00 m/=
Actual N/A () Use local
Syne to Time Cf Day |Manual || Advanced
Measurement Source
Display Positions Depth
© Kalman @ Least Squares [Measured  ~||[100.000m |
RMS Scale factor Eading i
0.000m 1 [Meaa.lred v] |D.DD' |
Position
) Select
l Dynamics l l References NS -
Lok J[ Camcel || ey [[ tHep |

21. To use the depth output from the SPRINT system, select Measured as the Depth measurement
source.

22. Touse the heading output from the SPRINT system, select Measured as the Heading
measurement source.

23. Touse the INS position output from the SPRINT system, select INS as the Position
measurement source. Alternatively, for LBL acoustic solution, select Acoustic as the Position
measurement source.
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24. To specify the reference beacons for this ROV, click Select References.

W
| General | Instruments & Offsets| Postioning | Chart |
Acoustic Update Sound Speed
Interval 10s @ Use global B
148500 mfs
Actual M/ ) Use local
[ Sync to Time Of Day |Manual || Advanced
Measurement Source
Display Positions Depth
() Kalman @ Least Squares [Meamd v] |'IDD.DDDn1 |
RMS Scale factor Heading i
0.000m 1 [Measured =] [0.00° |
Position
. Select
Beiss References INS =
[ ok J[ Concal || ooy | [ Heb |

Note

Not all reference beacons specified need to be used for INS LBL aiding but must be specified

if the SPRINT system is to record the observations for other purposes, such as post processing
in Janus.

25. After adding the references, click OK to close the Select References window.

Se‘ll:c'l References

=<

Irstrument Transducer  Offset

=Y Bl Tow Tl

Offset]

Freq Band References
MF

A Mate: References which are in a different frequency band from
1D il the senzor will be shown grayed and cannot be selected for
tracking.
Available References Selected References
MHame Freq. Band Type Calibrated MHame Freq. Band Type
#5 1702 MF Compatt &
allss | | dg 1703 MF Compatt &
(S5
<< Al
[ gk ] [ Cancel ] [ Help

26. Click OK to close the Properties for ROV window. By default, all reference beacons added as
references will be used for INS aiding.
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27. Todisable a beacon for INS aiding but to still record LBL data in the SPRINT system (for use
offline) open the properties page for the Compatt and deselect Use in INS.

Properties for Compatt 6 "1703" E
Battery / Release / Temp. / Sound Speed | Roll / Pitch
Position / Environmertal | Summary ¢ Comms
Mame 1703 é 6
Aray Seabed
Position Sound Speed Source
g 650778.550m Major 0.000m @ Global
S — 148500 m.
n; DEEB3E3.3E0m Mingr  0.000m ) Local
. 160.000 0.00° ——
D: m Theta Manual | Advanced |
[¥] s Calibrated th 0.000m
r
Use in Tracking Scale Factor
B ke NS [mpor Posten. |
ok [ Camcd || sy |[ Heb |

28. The ROV can now be tracked using INS with LBL aiding; click the green Go button to start the

tracking wizard.

29. Select the correct ROV for tracking and then click Tracking On.

30. Click Next.

Select Vehicles
Select the vehicles you wish to start/stop Tracking.
The following pages will corfigure the vehicles appropriately.

Tracking Wizard E

Sonardyne

SOMM IN NEPTH

Mame Track Ac. GNSS RO Update Depth
F- ROV ] Yes  Yes ] 10 Meas

Hdg  XYDyn DepthDyn Auto

Meas

Tracking On

Tracking Off | Note: Scale Factor will NOT be applied during tracking

0K

<Back || Net> | [ Fiish

[ cancel ][ Heb |

7z

31. If prompted, the transceiver may need to be set by clicking either the Quick Set or Full Set

button.
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32. Click Next.

ﬁl

Initialise Transceivers &nurdyne
Before starting Tracking, the transceivers used for telemetry -

and acoustic ranging must be corfigured. SonMnoEN nERTH

Mame Status ~ Type Vehicle Telem. Freg.  Ranging Freg. Mode
@ | Bl Tewr Set Transceive... ROV MF MF Simuttaneous

(= o =]

Set

<M[M>]|[%][W][Heb]
7

2

33. If prompted, the beacons may need to be set using either the Quick Set or Full Set button:
34. Click Next.

ﬁl

Initialise Beacons &nurdyne
Before starting tracking beacons which will be used -
mustbeconﬁgured. SOINMD IN DEPTH

Mame Addr  Status Freq.  Inter. Reply ~ TAT {ms) Towr Type
[ 1702 1702 Set MF MFC... M1702 Compatt &

[ M 1703 1703 Set MF MFC... M1703 Compatt &

Select Al ||| Quick Set ]l Ful Set I Ay | | Configurs

<Back | Net> JJ[ Fnsh | [ Cancel | [ e

7z
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35. Click Finish to start tracking and configure any specific Fusion log files.

Tracking Wizard E

o Sonardyne
If you wish to change the logfile the Tracking Data will be
recorded in, you can do so on this page. SOUND IN NEPTH
Log File LBL Sparse 1mdh]| Corfi ]

Folder C:\Program Data"\DocumentsSonardyneFusionLBL"\Projects\L BL Sparse’Log Files"

Cumert File Size  0.119 Mb

<Back Next > i|m=h||[t:mca][Heb]

A

6.4.24 Marksman & Ranger 2 USBL Aiding

This procedure assumes the USBL system has already been configured as follows:
« Calibrated and compensated for vessel movement with a high grade MRU/AHRS.
o UTC time synchronised.
« Isusing GPS (WGS84) to provide absolute positions.
« Using correct sound velocity.

« Is configured to track the ROV USBL beacon as a mobile beacon.

Tointerface Marksman or Ranger 2 USBL to the SPRINT system for aiding:
1. Add anew SSB telegram output.
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2. Select 9600 as the baud rate and select an appropriate port to output the message to the
SPRINT system.

.rdAdd Mew Telegram @
-

e SSE  LBP1

R COM1 -

Data-Parity-Stop  [EERIA RS

3. Specify the following telegram options.
» Frame of Reference: select World
« Orientation: select Lat/Long

« Source: select Raw

Ird Output Telegram Editor

= [ -5-]=]

Ship 1

2605
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4. Ifusing Marksman/Ranger 2 V4.06.01 or later. set the following telegram options:
« Frame of Reference: select World
« Orientation: select Lat/Long

« Source: select Sprint

.a Output Telegram Editor = @

DEnahIEe

Ship 1

2605

6.4.25 Time Series Plots

Navigation and quality data displayed on the user interface can be graphically displayed on a chart as
Time Series Plots. Examples of plotted charts are shown below.

This time series plot shows INS Velocities North/East/Down.

2.nnn
1.500

1.000

-0.500
-1.000
-1.500

11:38:00 11:40:00 11:42:00 11:44:00 11:46:00
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This time series plot shows INS Depth, External position and INS horizontal position qualities.

0400 -
0200 (-

11:38:00 11:40:00 11:4z:00 11:44:00 11:46:00

Displaying Plots
The following steps describe how to display data as single and multiple plots.

1. Todisplay navigation measurements (apart from Lat and Long), quality and INS statistics, right-
click a value on the navigation text panel and select Show on New Chart Area.

INS .

Lat 51" 19.7730° N
Long
Depth 100.04 m

- Shavw an Mew Chart Area
Down (1] b —

Horiz.5.Major (1ag) 0.27 m
De 10 0.04 m
Heading (1o) 0.15

2. Todisplay additional plots on the same chart, right-click a value on the navigation text panel and
select Show on Chart Area.

INS

0s
1 51° 19.7730° N
Long 000" 50.1399° W
Depth 100.04 m
Forward 2
Down

|-||-”i1_5_[.|-'|.'|_i|'|| 1a) 0.2T m

Depth (10)
Show on Mew Chart Area

Heading (1a)

Show on Chart Area
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3. Toremove data from a chart, right-click the value on the navigation text panel and select Remove
Time Series Plot.

0.27
004

S l.o)lp)le

i

Remove Time Series plot

Note

There is a limitation of three sensor inputs per plot and a maximum of four Time Series Plots
displayed simultaneously, plus the LBL Aiding Plot.

6.4.26 Exporting Configuration and Log Files

To export system configuration and log files:
1. Click File > Export Configuration.

kad Export Configuration and Log Files EI [=]
Log File Selection
@ Last 1 Hours
(@ From (UTC) 18/05/2015 11:11:11 @~  To(UTC) 18/05/201511:11:11  [EH~

Destination and Export Settings
Destination Directory™ C]

*SPRINT exports files in subfolder "SprintExport™ under destination directory.

=

2. Specify either the Last number of hours to export or a date/time range.
3. Specify a destination directory for the exported file.
4. Click Export to create the export file.

6.5 Configuration Check List

Use the summary list below to assist in the system configuration, prior to operation:

No |Action Manual Section Checked
(Sign and Date)
1 Configure the LCH Section 6.3
2 Check Dongle is Valid Section 6.4
3 Configure the SPRINT 300/500/700 Connection Section 6.4.2
4 Configure SPRINT 300/500/700 Section 6.4.3
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No |[Action Manual Section Checked
(Sign and Date)
5 Configure Time Synchronisation Section 6.4.6
6 Configure USBL Aiding Section 6.4.7
7 Configure Depth Aiding Section 6.4.8
8 Configure DVL Aiding Section 6.4.9
9 Configure Sound Velocity Section 6.4.10

10 [Configure LBL Aiding

Section 6.4.11

11 | Configure External Position Aiding

Section 6.4.12

12 | Configure GPS Aiding

Section 6.4.13

13 | Configure INS Aiding

Section 6.4.14

14 | Configure Options

Section 6.4.15

15 | Configure Logging

Section 6.4.16

16 | Configure Outputs

Section 6.4.17
Section 6.4.18
Section 6.4.19

Note

See Appendix G "SPRINT 300/500/700 Installation and Setup Check List" for a full step-by-step
installation and setup check list that can be printed and used as a hard copy reference.

6.6 INS

6.6.1 Initialisation
Toinitialise the INS:

1. The AHRS algorithm should be settled. This will take 10 minutes from the SPRINT 300/500/700
start-up in the default SPRINT system configuration. The ROV can be moving. On the main
software window the AHRS status LED will be green when the AHRS s settled; see Section

6.10.2 "System and Aiding Status”.

2. The SPRINT 300/500/700 should be time synchronised. On the main software window the Time
Synch status LED will be green when the SPRINT 300/500/700 is Time Synchronised; see

Section 6.10.2 "System and Aiding Status".

3. A starting position for the INS algorithm. In normal operation this will be provided by the first

accepted USBL position for the vehicle during descent.
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Figure 1-42 shows a typical descent and INS initialisation sequence.

Figure 643 Descent and INS Initialisation Sequence

AHRS settles while vehicle is on deck
(or very early during descent).
AHRS settled; AHRS status LED turns green.

INS is not initialised; INS status LED is red.

First accepted USBL position initialises INS.
INS is initialised; INS status LED is green.
DVL has no bottom lock; DVL status LED is orange
é\!L gets bottom lock; DVL status LED is green I

6.7 Fusion LBL Aiding

6.7.1 Transition from USBL to LBL aided INS

To transition from USBL aided INS to LBL :

1. Make sure the SPRINT system has good USBL and DVL aiding (e.g. bottom lock). The ROV
should continue with some dynamics during the following steps.

2. Check Fusion is tracking and that ranges are being received on the Fusion measurements panel.
3. Selectthe DVL and LBL check boxes.

INS x
Position Aiding Inputs Depth Aiding Inputs
[QuseL  [] Exdemal Position Pressure Depth
LBL [ Gaps [] USBL Depth
Velocity Aiding Inputs [] Extemal Position Depth
DVL

Reset INS | oK || Aoply || Cancsl |

4. LBL aiding can also be selected by right-clicking on the LBL Aiding LED.

Aiding Inputs
USBL LBL Depth DvL SV
o e Configure o o
| Enable |
Don View LBL Aiding Time of Expiry: n/a. Lodest
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5. LBL aiding can then be monitored in operation as described in Section 6.10.5 "INS with Fusion
LBL Aiding".

6.8 Zero Velocity (ZUPT) Aiding

6.8.1 Features and Operational Guidelines

Zero velocity aiding feeds ‘zero’ velocities in to the INS (with an amount of error) to help the INS
estimate sensor bias errors when a vehicle is not moving. It can be used to:

o Stop INS position drift if DVL, USBL or LBL aiding is lost

« Provide better static fix results if aiding data is poor (e.g. USBL)

Rules for Zero Velocity (ZUPT) Aiding:
o Must ONLY be used when the ROV is truly static
o Must NEVER be used when the ROV is moving

« Switching between USBL and LBL aiding must NOT be carried out when the INS is ZUPT
aided as it will not be allowed to move between the two positioning sources.

Note

If Zero Velocity (ZUPT) aiding is used when the vehicle is moving the INS integrity and
performance could be affected.

6.8.2 Enabling Zero Velocity (ZUPT) aiding

Zero Velocity Aiding can be enabled by clicking the ZUPT button on the main SPRINT window, see
Figure 6—44. It can disabled by pressing the ZUPT button again. When active the INS status on the
navigation chart will display Navigating (ZERO VELOCITY).

Figure 644 Enabling ‘ZUPT’ Aiding

6.8.3 Static Fixes with Zero Velocity (ZUPT) Aiding

Follow the steps below if Zero Velocity Aiding (ZUPT) is to be used while taking a static fix.
1. The SPRINT system should be ‘healthy’ with green LEDs before taking a static ZUPT fix.

Manoeuvre the vehicle in to position for the static fix.

Once the vehicle is static enable ZUPT mode.

Record the static fix using 3rd party software.

Turn off ZUPT mode.

The vehicle can now move away from the static fix position.

2B
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Note

ZUPT aiding may not be available depending on the SPRINT system version purchased.

6.9 Pre-Dive Check List

Use the list below to assist in making sure the SPRINT system is ready before a dive.

No

Action

Checked
(Sign and Date)

Check the SPRINT 300/500/700 is powered.

Check all aiding sensors (Depth, DVL, Sound Velocity, and LBL Transceiver) are
powered.

Check the default Latitude in the SPRINT system.

Check the SPRINT 300/500/700, AHRS, Logging and Time Synch status LED’s
are green (OK).

Check the Depth status LED is blue (not used). A red (critical) status could
indicate there is no data being received.

If a DVL is being used, check the DVL status LED is blue (not used). A red
(critical) status could indicate there is no data being received.

If an SV feed is being used, check the SV status LED is blue (not used). A red
(critical) status could indicate there is no data being received.

If connected to an LBL transceiver, open the Fusion software and check the
Transceiver connection by performing a ‘Get’ or ‘Test’ on the transceiver
instrument page.

Check or set the (surface) pressure offset on the depth aiding page of the
SPRINT system.

6.10 Monitoring the System

6.10.1 Main Application Window

The main SPRINT system application window, with USBL, DVL and Depth aiding active, with key
features highlighted is shown below in Figure 6—45.
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Figure 645 SPRINT system Main Application Window

INS Vehicle
Position
USBL Position INS Error
/ \ Ellipse

el

ey INS Navigation &

Quality

Status Descriptions

(INS to USBL Difference
1 System & Aiding
T .88
Tine

T T : Aiding Sensor
E Status
System Status Auding Inputs
SPRINT AHRS s Tine Logorg usaL s Desth o s &2 Fos 2Pt

lww Commands Sent Dongle: Valid, Time unlimited, Date/Time of Expiry: n/a. SPRINT UTC Time:: 12/08/2017 11:19:32

6.10.2 System and Aiding Status

All the major system components and aiding inputs can be monitored using the system and aiding
status LEDs ‘traffic light status' at the bottom of the main application window:

Figure 646 System and Aiding Status LEDs

System Status Aiding Inputs
Lodestar AHRS INS Logging USBL LBL Depth DVL ZUPT

The following system components are always monitored:
« SPRINT 300/500/700 (Hardware)
« AHRS (Attitude Heading Reference System)
« INS (Inertial Navigation System)
« Time (Synchronisation)
« (Local PC) Logging
Aiding inputs are monitored if they are specified for INS aiding in the INS Settings configuration. The

colour of the monitoring ‘traffic light’ LEDs is explained in Table 6—2 "System and Aiding Status Traffic
Light LED Colours".

Table 62 System and Aiding Status Traffic Light LED Colours

Status LED Traffic Light Example States
Colour
Critical Red Communications Failure to Component

Hardware Issue
Component not Initialised or running correctly
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Table 6-2 System and Aiding Status Traffic Light LED Colours (continued)

Status LED Traffic Light Example States
Colour
Timeout for Critical Instrument (typically 30 second limit)
Warning Orange / Amber Aiding Sensor Data Rejected
AHRS Algorithm Settling
OK Green Data Received within Time Limit
Data Accepted and Used
Not Used or Blue Aiding data is received but as the INS is not initialised it is not yet
Disabled being used.

A text description for each component status is provided in the status list and can also be seen by
placing a mouse over the appropriate LED, as shown in Figure 6—47 (with the example of the INS
being unable to initialise as it is not receiving position). If there is an issue, the status text will provide
guidance to resolve it.

Figure 6-47 Component Status Popup

INS Q Ins
Critical: Inltuahsmg , No Position Available
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6.10.3 Navigation Text Panel

Real time navigation data is displayed on the navigation text panel. All positions can either be
displayed in WGS 84 decimal degrees or UTM Eastings and Northings. Various quality metrics are
also displayed on the panel for both the INS and the SPRINT 300/500/700 time synchronisation
status.

Figure 648 Navigation Text Panel

51°19.8384' N
000° 50.1413" W
130.10

0.53
0.06

0.13

51° 19.8385" N
000" 5 14" W
30.00

1.40
30.00

30.00

INS to USBL Difference
| 0.19 |
‘M:
0.5

Note

The displayed USBL beacon position and external depth are with respect to the vehicle CRP to
allow for direct comparison with the INS position, which is also with respect to the vehicle CRP.
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6.10.4 INS Statistics

To view detailed INS performance statistics, click View > INS Statistics:
Figure 649 INS Statistics

i INS Statistics o] @ (3]

-

Position

Latitude 217 19.8385° h North 0.007
Longitude 000° 50.1414" W East 0.014
Depth 130.11 m Down 0.030

1DRMS 1.16 m Depth | RMS 0.050

0.82 m Semi Min. 82 m Down 0.013

0.000 0.020 ° Heading 249.911 ° Heading 249.911
0.000 0.020 “Ihr Pitch 0374 © Pitch 0374 °
0.000 0.020 “Thr Roll 0.155 ° Rell 0.170 °

Heading 1.000 © Heading 0.001

R/P 0.055 ° Pitch 0.015 °
Roll 0.005 °

Alpha ("Roll") 0.000 = 0.500 : 0.000 = 0.005

Beta ("Pitch") 0.001 = 0.500

Gamma ("Heading") 0.000 = 0.500

Note
If the INS Statistics display is closed while in use as Time Series Plots, the plots will be deleted.
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6.10.5 INS with Fusion LBL Aiding

When LBL is selected and used as an aiding source in the SPRINT system, there are some features
that should be noted. See the LBL aiding example in Figure 6—50. When LBL aiding is active the
USBL position is still displayed for comparison but is not used for aiding. Additionally the INS error
ellipse may take a distinctive shape that is representative of the geometry of the vehicle with respect to

the reference beacons used for aiding.
Figure 6-50 SPRINT System with Fusion LBL Aiding

Distinctive INS
Error Ellipse
LBL Transponder
Position LBL Ranges

Accepted LBL
‘ Ranges
|~

[INSm USBL Difference
ime Syncl

Navigating

LBL Aiding Status For
Each Range Received

Adting lnputs
useL 8L Dest o

@ © o o 06 o o o o o o o

Donale: Valid Time unfimited. Date/Time of Exirv: n/a. SPRINT UTC Time : 12/11/2017 09:29:56

v £ Pos ZueT

Info: Commands Sent

If any LBL ranges are rejected, the LBL aiding LED will change to amber/orange and the beacon
address and reason for rejection will be displayed. Examples showing reasons of LBL rejection are

shown in Figure 6-51.
Figure 6-51 LBL Aiding Rejection

lok |
[Warming |
[Warning | Beacon 1703 Rejected (Outside INS Prediction)
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Click View > LBL Aiding to see additional LBL aiding information as shown below.

Figure 6-52 LBL Aiding Window

¥ LBL Aiding

0450 ooy

SL 0.00dB

12:06:00 12:06:30 12:07:00

SL 0.00dB
Used

0180

12:06:00

12:06:30 12:07:00

12:07:30

12:07:30

f=feE=s

12:08:00

12:08:00

The LBL aiding window will display aiding information for all LBL beacons which are currently being

tracked while the SPRINT system is LBL aided.

The upper graph displays travel time for all tracked beacons while the lower graph displays the LBL
aiding range residuals. The residuals displayed are the differences between the INS estimated and
the actual received LBL ranges and are therefore an extremely useful indication of LBL aiding health.
The residuals should typically be low (<10 cm) and centred around zero.

To edit the LBL aiding chart contents:
1. Press the minus sign = on the keyboard to hide the beacon text.
2. Right-click on the charts to enable options to:
« Maximise or hide one of the charts
« Show or hide data from individual beacons

« Copy and save the charts

3. Dragging the mouse over a section of the chart will zoom into the area selected.
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Itis recommended that during critical INS positioning with LBL aiding, the LBL aiding window is kept
open to monitor the aiding, as shown below.

Figure 6-53 Monitoring LBL Aiding

@[S [0]0|[2]

¥ LBL Aiding o |3 |[=
N5 to USBL Difference

[-Imesmn—J

If the residuals are not centred around zero, this would indicate that there is a systematic error with
LBL aiding, such as:

« Sound velocity

« Beacon to INS relative depth

If LBL aiding observations are rejected, it will be indicated by a red cross on the residuals display, as
shown below.

Figure 6-54 LBL Aiding Rejection in Residuals Graph

-4.000

-6.000

14:53:00 14:53:10

6.10.6 Communications Monitor

On any of the dialog boxes in the SPRINT system that allow the configuration of input or output
communication, a comms monitoring function is provided. When the Comms button is clicked, a new
window is displayed showing the received or sent data on the configured port; see Figure 6—-55. The
actual message contents are provided in the Message column.
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Figure 6-55 Communications Monitor

&3 Depth Lodestar Comms... = e
[ AsCll |[Hex ) [ ToFie | C:\Users\Public\Documents\Sonardyne \Hub [ ... | Highlight:
Timestamp Message -

10:22: 35,91 0001150. 0500

10:22:36.836 $PRDID,-0.34,0.15,250.02+52
10:22:36.916 *0001150.1100

,0.15,250.02%52

.15,250.02%52

.15,250.02+%52

,0.15,250.02+52 El

Fl

2R 30 30 20 31 21 35 30 2E 31 31 30 20 *0001150.1100

Status: Connected

The data received on the port is displayed green and the data sent on the port displayed blue as
shown in Figure 6-55. The communications can be saved to a file by selecting a location and clicking
the To File button. The communications can be filtered by entering Filter text. Any communication
containing the filter text is displayed red as shown below.

Figure 6-56 Communications Monitor Filter

[AsCil ][ Hex ][ Tofie ] C:\Users\Pubiic\Documents\Sonardyne\Hub [ | Highlight:  0.15 .
Timestamp Message -
10:23:15.833 $PRDID,-0.34,0.15,250.02*%52
10: :15.920 *0001150.0500

.240 $PRDID,-0.34,0.15,250.02%52

-950 *0001150

.340 ¢PRDID,-0.34,0.15,250.02%52

957 +*0001150.0700

H .837 &PRDID,-0.34,0.13,250.02*%52

10:23:12.958 #0001150.1200
10:23:19.837 &PRDID,-0.34,0.13,250.02*%52 @
10:23:19.914 #*0001150.0500
10:23:20.834 &PRDID,-0.34,0.13,250.02%52 =

The communications stream can be paused by clicking the Pause button.
6.10.7 Navigation Quality Limits

Navigation quality limits can be enabled and configured in the SPRINT system; see Section 6.4.15
"Options”. If enabled, the horizontal navigational quality limit will be displayed on the chart as a red
circle (INS horizontal quality is displayed as a yellow circle or ellipse).

If either the vertical or horizontal quality limits are exceeded, the SPRINT system will alert you, see
Figure 6-57:

« The ‘Compass Ring’ on the navigation chart will flash red.
« The INS status on the navigation chart will read Quality Exceeds Limit.

« The relevant quality value on the navigation text panel will flash red.

Section 6 — Combined INS & AHRS Operation 102



UM-8253-SPRINT
Issue A3

User Manual for Type 8253 SPRINT 3rd Generation

Figure 6-57 Navigation Quality Limits Exceeded
INS

Lat 5 N
Long 000° 50.1414" W

©)8)|0)2).2)

Ll:lr‘lg u
Depth 125.00 m

Quality 140 m
1s

ed 60/61 in last min
125.00 m
s

0/0 in last min

6.11 DVL Calibration Procedure

An accurate calibration will typically require ~15—20 minutes of manoeuvring at the seabed. A quick
calibration can be done in just a few minutes.

Prior to the start of the calibration, make sure the following conditions apply:
« The subsea vehicle must be within DVL range of the seabed with good bottom lock.
« The subsea vehicle is being tracked with USBL and the SPRINT system is receiving USBL
aiding.
« The Pressure Depth input is active and the SPRINT system is receiving Pressure Depth
aiding.
« The correct sound velocity is being used by the SPRINT system.
Follow the instructions below to undertake a DVL calibration.

1. Itisrecommended to start a new log file with a suffix that will be clearly identifiable as DVL
calibration data.

2. Open the Logging dialog box and enter the required log file suffix (e.g. DVLCalibration).
Figure 6-58 DVL Calibration Logging Configuration

Logging ol B ]

Log File Suffoc: DVLCalibration 1|

Log File Location: CUsers'\Publich\Documents Sonardyne\Hub\Logfiles

Currert Log File: D00213_20150630_12.29_LS bin
Start New File Every: 15 2| Minutes Restart Logging
Me Log Folder Size™: 10 GBytes

o ] o ][

* Qldest log files deleted when maw. log folder size reached.

Section 6 — Combined INS & AHRS Operation 103



User Manual for Type 8253 SPRINT 3rd Generation

UM-8253-SPRINT
Issue A3

Click OK to close and save all entered settings.

4. The subsea vehicle can now undertake some specific manoeuvres. A suggested and efficient

10.

11.

12.

approach would be to travel along an approximate linear path and the vessel to follow the ROV
and maintain a constant heading (to minimise USBL systematic error) whilst performing:

« Accelerations along various axes including up/down.
« Heading changes +/- 90°, i.e. sideways movement maintained for a few minutes.

« Random high dynamic manoeuvres

A total position change of ~500 metres is sufficient. For deep water, make the trajectory/duration
longer for optimum performance.
Figure 6-59 DVL Calibration ROV Manoeuvres
% :
* * % *®
**_p de._ —‘-* €+
. L]

To minimise USBL systematic error, the surface vessel must follow the ROV, maintaining a fixed
heading (directly above the ROV) during the calibration.

When the calibration manoeuvres have been completed the subsea vehicle can continue with
other operations.

Open the Logging dialog box and enter a log file suffix to indicate the log files no longer contain
any DVL calibration data, the default log file suffix is LS.

. Create a working folder on the hard drive for the DVL calibration log files; e.g. My

Documents\DVLCal and create a subfolder in the working folder called LogFiles.

Note
SPRINT system binary log files have a .BIN extension.

Copy the relevant log files from the SPRINT system logging location into the LogFiles folder.

Note

It is important to only copy the log files covering the time period of the DVL calibration
manoeuvres as time taken to process the log files will increase with the amount of data used.

Run the DVL Calibration tool by double-clicking the icon on the desktop (it may be necessary to
wait up to 10 seconds for the application to run)

The DVL calibration application will open on the AINS tab.
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13. Clickthe Choose job/root directory button and select the parent working folder, e.g. My
Documents\DVLCal and then click OK.

|4 Sonardyne - Janus DVL cal. (ver. 1.4.0.11) - m| X

AINS | Aiding sensor  Log files/Import data = DVL Calibration  AHRS = Export

Job directory: | Choose job/root directory --> | | Choose job/root directory

Mavigate
Time Selection

All available data.

Time span: from plot

Start from position (nearest to): |[lat (rad), lo Change configuration
First good DVL observation.

First good USBL (Remote) observation.

Plotting
Navigation: MN/A ~ |Reference:| MNone ~
Plot:| Trajectory KF-states Observation Used
Plotting tools:| Sync. plots ” Close plots
Apply AINS states

Time conversion

Input tirme: <input time>
UTC time: <UTC time>
System time [min]: <Internal time>
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14. Click the Log files/Import data tab.

z Sonardyne - Janus DVL cal. (ver. 1.4.0.11) — O x
AINS | Aiding :en:chVL Calibration AHRS Export
Import data
Import data from Lodestar log files. Log files are assumed to
be in the sub-directory logfiles. [ Import all
Imported data:
Import/apply configuration file(s). Apply configuration file(s)
Lodestar QC
Plot the Built-In Self Test (BIST) status for the Real-Time system. Plot BIST
Compensate data
Compensate data for calibrated values.

15. Click Import data to import the data from the log files (this may take several minutes).
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16. When the import is completed a list of imported data is displayed.

4\ Sonardyne - Janus DVL cal. (ver. 1.4.0.11) - O X

AINS Aiding sensor Log files/Import data  DVL Calibration AHRS Export

Import data

Import data from Lodestar log files. Log files are assumed to
be in the sub-directory logfiles. [ Impaort all

Imported data:
IMU  DVL GPS Pressuredepth Sound velocity sensor  Time system
Fixed depth ZUPT AHRS BIST RTAINS Settings

Import/apply configuration file(s). Apply configuration file(s) ‘
Lodestar QC

Plot the Built-In Self Test (BIST) status for the Real-Time system.
Compensate data

Compensate data for calibrated values. Edit Compensation

Section 6 — Combined INS & AHRS Operation 107



UM-8253-SPRINT
Issue A3

User Manual for Type 8253 SPRINT 3rd Generation

17. Click the DVL Calibration tab.

4\ Sonardyne - Janus DVL cal. (ver. 1.4.0.11) - O X
AINS  Aiding sensor  Log files/Import datal DVL Calibration § AHRS  Export
DVL Calibration

Enter an initial guess or leave it to use either Command & Control settings or
default values.

Once done, press use calibration in order to use the DVL calibration for navigation.
The DVL calibration is also affected by the time selection on the AINS tab. Use it to
perform a calibration using only a subset of the data.

Mote that the mounting angles are in Vehicle frame.

Parameter Initial Estimated Std.Dev  Unit
Roll 0.000 0.000 0.000
Pitch 0.000 0.000 0.000
Heading 0.000 0.000 0.000
Scale-factor 0.000 0.000 0.000 %
Latency 0.000 0.000 s
ﬂ Calibrate DVL

] Predefined sensor selection
[ Bypass coarse estimation
[] Diagnose calibration
Plot DVL residuals

Use calibration Save calibration report

New DVL frame convention
A Only for use when upgrading firmware!
From firmware ver. 3.02.00.000 the DVL mounting angle

convention changed. You can convert to the new DVL
frame definition without having to redo the DVL

calibration.

18. The initial (default) values will be displayed (they do not need to be modified).

19. Click Calibrate DVL (a progress indicator shows the processing status).

*

]
|

Forward processing
i
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20. When completed, two figures will be displayed. Figure 1: DVL Calibration displays the DVL
velocity residuals for all axes before and after calibration.

4| Figure 1: DVL calibration - [m} X
File

EFE R EEIEE

DVL residuals before calibration

=4
(=3
@

=]

Velocity residual [m/s]
S
&

1335 1340 1345 1350 1355 1360 1365 1370

DVL residuals after calibration

=4
(=3
@

&
&

Velocity residual [m/s]
(=]

1335 1340 1345 1350 1355 1360 1365 1370
System Time [min]

21. Figure 2: DVL Calibration displays the DVL velocity residuals for each axes before and after
calibration.

4| Figure Z: DVL calibration - O X
File

dde RRU9E 0@

DVL residuals comp.

=
o=
@

Velocity
residual [m/s]
o

05 . . . . . L .
1335 1340 1345 1350 1355 1360 1365 1370

=4
(=3
o

Velocity
residual [m/s]
o

005 . . . . . L .
1335 1340 1345 1350 1358 1360 1365 1370

=4
(=3
(&

o

Velocity
residual [m/s]

005 I I I I I . I
1335 1340 1345 1350 1355 1360 1365 1370
System Time [min]
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22. Onthe DVL Calibration tab the estimated calibration values are displayed.

(4 Sonardyne - Janus DVL cal. {ver. 1.40.11) - O X

AINS  Aiding sensor  Log files/Import data  DVL Calibration  AHRS  Export

DVL Calibration

Enter an initial guess or leave it to use either Command & Control settings or
default values.

Once done, press use calibration in order to use the DVL calibration for navigation.
The DVL calibration is also affected by the time selection on the AINS tab. Use it to
perform a calibration using only a subset of the data.

Mote that the mounting angles are in Vehicle frame.

Parameter Initial Estimated Std.Dev  Unit

0.715
0127
0.176 0.00

0.000 o0.0m %
-0.009_ s

0.091
0.014

Roll 0.000
Pitch 0.000
0.000
0.000
0.000

Heading

Scale-factor

Latency

Calibrate DVL

Predefined sensor selection
[ Bypass coarse estimation

[] Diagnose calibration

Plot DVL residuals

| Use calibration | | Save calibration report

New DVL frame convention
A Only for use when upgrading firmware!

From firmware ver. 3.02.00.000 the DVL mounting angle
convention changed. You can convert to the new DVL
frame definition without having to redo the DVL
calibration.

Conversion tool

Itis recommended that a (PDF) copy of the DVL calibration report is saved by clicking Save
calibration report and specifying an appropriate location.

23.

24. Open the report to retrieve the results (they are also available directly from the DVL Calibration
tab).
DVL params a(rol)[’] | b(pitch)[?] |g (heading) 1 s‘fr'r%:“[f}n;" Latency [s]
Before 0 0 0 0 0
Calculated 0.715 0.127 0.176 0 -0.009
Calculated Accuracy 0.091 0.014 0.041 0.011
25. Inthe SPRINT system, navigate to the DVL dialog box; Configure > INS > DVL Input.
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26. Enter the calculated values and click Apply or OK to save the changes.

DvL X

SPRINT DVL Connection
SPRINT Pt | Cobowe || Comns |
SPRINT-Nav Intemal DVL
Select DVLtype: (@ SYRINX DVL () TRDIDVL () Other DVL

[] Triggered by SPRINT unit [] Mllow 3 beam solution to be used
Hex-ASCIl DVL Data Output [ Use Syrire Beam Level
DVL Configuration
DVL: Auto Configure Sound Velocity:
Calibration
Scale Factor:  |0.000 EI i Latency:  |0.000 EI Seconds
DVL Calibration Settings
DVL Mourting
@ From Vehicle CRP () From IMU
Lever Am Mounting Angle

Forward: Metres Heading: Degrees

Starboard: Metres Resulting Pitch: Degrees

Down: |0.000 % Metres Resulting Roll: |0.000 % Degrees
om0

[ox | [t | [t |
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27. DVL Calibration results can be imported into the SPRINT system; click Save Calibration
Report to produce the import file within the Janus DVL Calibration data folder.

z Sonardyne - Janus DVL cal. (ver. 1.4.0.11) - O *

AINS  Aiding sensor  Log files/Import data  DVL Calibration  AHRS  Export

DVL Calibration

Enter an initial guess or leave it to use either Command & Control settings or
default values.

Once done, press use calibration in order to use the DVL calibration for navigation.
The DVL calibration is also affected by the time selection on the AINS tab. Use it to
perform a calibration using only a subset of the data.

Note that the mounting angles are in Vehicle frame.

Parameter Initial Estimated Std.Dev  Unit
Roll 0.000 0.715 0.091
Pitch 0.000 0.127 0.014
Heading 0.000 0.176 0.041
Scale-factor 0.000 0.000 0.011 %
Latency 0.000 -0.009 s
Calibrate DVL

Predefined sensor selection
[] Bypass coarse estimation

| Diagnose calibration

Plot DVL residuals

| Use calibration | | Save calibration report

New DVL frame convention

A Only for use when upgrading firmware!

From firmware ver. 3.02,00.000 the DVL mounting angle

convention changed. You can convert to the new DVL
frame definition without having to redo the DVL onversion too

calibration.
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28. To apply the DVL Calibration settings, open DVL Aiding in the SPRINT system and click DVL
Calibration Settings.

DvL X

SPRINT DVL Connection
SPRINT Por: | Cobgwe || Comns |
SPRINT-Nav Intemal DVL
Select DVLtype: (@ SYRINX DVL (O TRDIDVL (O Other DVL

[] Triggered by SPRINT unit [] Mllow 3 beam solution to be used
Hex-ASCI DVL Data Output [] Use Syrinx Beam Level

DVL Configuration

Calibration

Scale Factor:  |0.000 EI i Latency:  |0.000 EI Seconds

DVL Calibration Settings

DVL Mourting
(®) From Vehicle CRP O From IMU
Lever Am Mounting Angle
Forward: (0.000 |2 Metres Heading: |0.000 {2| Degrees

Starboard: 0.000 |3 Metres Resutting Pitch:  |0.000 {2| Degrees
Down: (0000 |2 Metres Resutting Roll:  |0.000 12| Degrees

R

29. Select Calibrated on the DVL ALignment pane and then click Import DVL Calibration File.

DVL Calibration Settings - >

DVL Alignment DVL Calibration
SPRINT-Mav

(@) Calibrated

O PreCalibrated Import DVL Calibration file
re-Cali

() Un<Calibrated

0K Apply Cancel

30. Selectthe DVL Calibration file (.ccl) and then click OK to apply the DVL mounting angles, scale
factor and latency.

[ » DVL Calibration »

- MNew folder
MName . Date modified Type
. ahrs 30/06/2015 11:29 File folder
. extracted 30/06/2015 11:29 File folder
1 NavRT 30/06/201511:29 File folder
B ref 30/06/201511:29 File folder
. sensor 30/06/2015 11:29 File folder
L temp 30/06/2015 11:29 File folder
I|2| DVL_Calibration.ccl 30/06/2015 11:40 CCLFile I
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Note
The DVL Calibration import is supported by Janus software V1.1 and above.

6.12 DVL Frame Convention

The default mounting for the DVL frame convention has changed (instrument FWD mark aligned with
vehicle FWD mark), as shown below.

Mounting SPRINT System 1.4 Convention SPRINT System 1.5.1+ Convention
Heading 135.00 0.00
Pitch 0.00 0.00
Roll -179.90 0.00

The DVL frame convention tool allows DVL mounting angles in SPRINT system V1.4 to be converted
to SPRINT system VV1.5.1 (or later) convention without the requirement to perform an additional
DVL calibration.

l Use calibrati ] [ Save calibration report

New DVL frame convention

A Only for use when upgrading firmware!

From firmware ver. 3,02,00,000 the DVL mounting angle
convention changed. You can convert to the new DVL
frame definition without having to redo the DVL
calibration.

DVL frame conversion E =§= | S|

The DVL frame conversion should only be applied to:

@ the real-time system if you are upgrading firmware to v3.02.00.000 or later
@ Janus if you are using v3.02.00.000 firmware or later and have not yet converted the DVL mounting angles

old V20200000 or later
Roll [deg] 1799 -0.00|
Pitch [deg] | ooz || 0.012
Heading [deg] 13500 | -0.000|
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Section 7 — Standalone AHRS Operation

7.1 Introduction

The SPRINT 300/500/700 can be configured and operated as a standalone AHRS as explained
below.

7.2 Configuring using PC Utility

7.2.1 Connection

Connect the PC to the SPRINT 300/500/700 via a serial port on the PC or alternatively an Ethernet
connection. Default connection details are provided below.

The software will default to COM 1 on the PC.

The SPRINT 300/500/700 default Ethernet properties are:
o IP Address: 192.168.179.50
« Subnet Mask: 255.255.255.0
« Command port/socket: 4000

The software will default to these values if the Ethernet option is chosen. Make sure the PC Ethernet
port is configured correctly to allow communication with the SPRINT 300/500/700’s default settings.

If the SPRINT 300/500/700 is being used as a standalone surface AHRS then connect GPS to the
SPRINT 300/500/700 using a spare |0 port and arrange to supply the NMEA 0183 $GPGGA and
$GPVTG sentences to the SPRINT 300/500/700.

Connect the SPRINT 300/500/700’s 10 ports to the external instrumentation as required.

Start the SPRINT 300/500/700 configuration software (if it is not already running) by double-clicking
the program’s icon on the PC’s desktop.

Once a physical connection has been made it is necessary for the PC Ultility to communicate with
SPRINT 300/500/700; see Figure 7—1.
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Configure the connection to the SPRINT 300/500/700 by clicking Connect.

Figure 7-1 Configuration Software Main Window (not connected)

* |odestar

About, .

Lodestar Conzole Connection
PC Port: | COR1 Dizconnect

Houzing Tupe Wersion

|AHHS | Firmware: l:l Download Firmware
Audible Alam Shutdown/Reset CPU UART FPGA |:|

Shutdawn Interconnect FPGA: Flsst Ta Factor
D pnamic Display GC Reset enial Number:

Launch

Full Reset Licence

Lodestar Configuration peeettern Ll l:l
Retrieve fram Send to User Level l:l
Lodestar Lodestar . -

@ v
. Ry Refresh  &ppl

The application will default to a serial connection on PC port COM 1 as shown in below.
Figure 7-2 SPRINT 300/500/700 Serial Connection Settings

£ Connection to Lodestar

Carnm Port:
Baud F ate:
Data Bits:
Stop Bits:

Auta Detect...
Status:

[ Multiplexed [ 0K l [ Cancel l
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To configure an Ethernet or NSH connection, click IP and the default SPRINT 300/500/700 Ethernet
connection parameters are displayed, as shown below.

Figure 7-3 SPRINT 300/500/700 Ethernet Connection Settings

£ Connection to Lodestar

IP Address: |192.1 68.172.50

Socket [d: 4000

[] Canmect Ta NSH
M5H Canfig
MSH Part: 48 On

Baud Rate: Canfigure
[rata Bits: Configure
Parity: Configure

Stop Bits: Configurs

Auta Detect...
Statusz:

[ Multiplesed [ 0K, l [ Cancel l

Note

Before proceeding, make sure the SPRINT 300/500/700 has been running for at least one minute
before trying to connect via the configuration software. This allows time for the SPRINT 300/500/700 to
start up and receive commands.

Once the connection parameters match the physical connection between the SPRINT 300/500/700
and the PC, click OK.

A window will appear indicating communication status with the SPRINT 300/500/700.

Once connected, the software will populate with the SPRINT 300/500/700 configuration and the
status indicator circle on the bottom left hand side of the application will turn green, indicating a good
communication link with the SPRINT 300/500/700; see Figure 7—4.
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Figure 74 Configuration Software Main Window (connected)

£ Lodestar

About...

INS Settings S - o
System | Terminal | Corsole | €1 |[E1 | T1 | T2 | Gwo-Compass | Offsets| 5D Card | Time || GPS | File Transfer |

Lodestar Consale Connection

FC F’ort:|CDM1 | L Cornect J [ Disconnect ] Connected to Lodestar Cansale Port
Housing Type Wersion
|SUBSEA | Firrnwsare: ’W‘ Download Firmware
Audible Alarm Shutdawn/Fesst CPU UART FPGA
S Interconnect FPGA Reset To Factory
Oynomic Disply [ GCReset | SellNurber
ﬂ] Licence
Lodestar Configuration Application Level
Fetiigve from Send to User Level

Lodestar Lodestar

| [ wiie |

Licence Key:

& GPS-INS Sigma Level v
Refresh  Apply

Note

If the status indicator remains red and the SPRINT 300/500/700 configuration is not updated, the
software was unable to connect to the SPRINT 300/500/700. Check the SPRINT 300/500/700 is
powered, all cables are connected to the correct ports and the settings entered on the ‘configure
connection’ window are correct and then retry connecting. If this is not successful refer to Section 12
"Troubleshooting”.

7.2.2 Shutdown and Reset

The SPRINT 300/500/700 can be commanded to shut down or reset from the configuration software
using the buttons on the Shutdown/Reset pane:

« Shutdown will shut down and turn off the SPRINT 300/500/700.
« GC Reset will restart the SPRINT 300/500/700 AHRS algorithms.
« Full Reset will re-boot the SPRINT 300/500/700, completely resetting it.

7.2.3 Gyrocompass Configuration

Select the Gyro-Compass tab in the Configuration Software.

Itis essential to set the default Latitude if the SPRINT 300/500/700 is operated without a GPS input. It
is also important to set this parameter even when the SPRINT 300/500/700 is used with a GPS input,
because the SPRINT 300/500/700 can revert to using the default Latitude if the GPS input fails for any
reason.

Note

If the SPRINT 300/500/700 receives telegrams from a GPS receiver or any position aiding such as
USBL, these will automatically update the default Latitude. However, if the GPS input fails, then the
SPRINT 300/500/700 will revert back to using the default Latitude. Make sure the default Latitude
setting is kept up to date in case the GPS input fails or is not available.
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The default Latitude can be set by entering the operating Latitude on the Manual Latitude Setting
pane; see Figure 7-5. After setting the Latitude, click Apply on the main application window.

Figure 7-5 Manual Latitude Setting Panel

b anual Latibude Setting
Decimal Degrees: |-21 00ao %|

Longitude: | 0.0 |

Where possible it is strongly recommended to connect a GPS receiver supplying the necessary
NMEA 0183 GPGGA and GPVTG sentences to the SPRINT 300/500/700.

1. Click on the tab that corresponds to the GPS input (T1).
2. Configure the baud rate and protocol.
3. Ensurethe Enable Output and Enable Power are selected and then click Apply.

% Lodestar
About...

| Terminal |

| System | Corsole [ ©1 |E1 | T1 [T2 | Gyro-Compass | Offsets | SO Card | Time | GPS | File Transfer | INS Setlings |
Faort Settings
Baud Rate: |BBDD v| Parity |N0ne v| [ Echo Commands  [] Allow Commands
Protocok  |RS232 v| Daatis [8 v [ Enable Output
Stop bits [] Enable Multiplex

Enable Power

Remaote | Remate op
MSG Fate Remate Point | FwD STBD | UP A B C  « Heave Heave

Type Filter SR

[ Add ][ Remove ]

= Qubput messages reset

Refresh  Appl

4. Click the GPS tab and configure the GPS port to be the port the GPS is connected (T1).

5. Enter the offsets from the vessel CRP to the GPS antenna and then click Apply to send the
changes to the SPRINT 300/500/700.
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6. Select Display NMEA GPS Telegrams to show any GGA telegrams that are being correctly
received and decoded.

% Lodestar

About, ..

| Terminal e
Systern | Console| ©1 | E1 |71 | T2 | Gyro-Compass | Offsets | SO Card || Time | GPS | File: Transfer " INS Settings |
GPS Settings
GPS Part IN5-GPS Accepted Quality Offzets from Platform CRP
Lodestar Port Minirum Fonward [m)
Ethernet Part I awirnum Starboard [m]

Up )

Mote: Pleaze go to comesponding GPS port tab to change port settings

Display NMEA GPS Telegrams

Message

:000091 7C9278,{$G PGGA, 163402,5158.99938,M,0001 9.00002,4/,2,07.1.4,0.0,M,0.0.1,2.2,0362°41 }*4C
:0000918B0 44D {$GPGGA,163403,5158.99398,M,00019.00002 ) 2,07,1.4,0.0,M,0.0,M,2.2 0362740} 4C
:0000319616E2,{$GPGGEA,163404,5158.99998,M,0001 9.00002\/,2.07.1.4.0.0,M.0.0.M,2. 2. 036247 4T

= Logging settings

v
Refresh  Apply

7. Ifrequired, the Heave output from the SPRINT 300/500/700 can be configured on the Heave
Filter for the anticipated surface wave period experienced by the vehicle.

Heawe Filter
() Shaort [« 83)
Wave Period: (&) Medium [ - 153
) Long[» 155

7.2.4 Mounting Angle & Lever Arm Configuration

Click the Offsets tab on the configuration software.

If mounting angles for the SPRINT 300/500/700 need to be configured, this can be done by entering
the appropriate values in the A, B and C Mounting Angle boxes, as shown in Figure 7—6. Similarly if
there are any offsets that need to be applied for the SPRINT 300/500/700 with respect to the vehicle
CRP these can be applied in the Forward, Starboard and Up entry boxes. See Appendix C
"SPRINT 300/500/700 Mounting Angle Examples" for definitions and an example of the SPRINT
300/500/700 mounting angles and offsets.

CAUTION

A It is strongly recommended the SPRINT 300/500/700 mounting angles are not modified while the
SPRINT 300/500/700 is in operation as an AHRS device. When any changes are applied the user will
be prompted to reset the SPRINT 300/500/700 AHRS algorithm and it will be several minutes before
the SPRINT 300/500/700 output is settled.
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Figure 7-6 Mounting Angles and Offsets Panel

Lodestar Mounting Angles and Offsets
hounting dngles Offsets from Platform CRP

A [degrees] (00000 2 Forward [m] |0.0000 - Guidance on Maounting
Anglez, Offzets and

B [degrees) |0.0000 % Starboard (m] |0.0000 {ﬁ Femate Points:

C [degrees) |0.0000 % Up[m] |0.0000 {ﬁ Efekmes

Reset All to Zero Reset

All mounting angles can be reset to zero using the button available.

SPRINT 300/500/700 measurements may be required for vehicle sensors that are not located near to
the vehicle CRP, such as remote heave.

For the SPRINT 300/500/700 to be able to supply these systems with measurements, offset distances
must be measured and applied in the SPRINT 300/500/700 configuration.

The SPRINT 300/500/700 supports up to two remote outputs (extendable on request) and these are
listed in the Remote Point list; see Figure 7—7. The remote points are numbered 3 and 4 (remote

points 0 to 2 are reserved for system use).

The offsets can be entered in the X, Y and Z columns and then saved in the SPRINT 300/500/700 by
clicking Apply on the main application window.

Additionally, angular adjustments can be entered in the A, B and C columns and saved by clicking
Apply on the main application window.

Figure 7-7 Remote Point List

Remate Paints

Remate
e Fu/D 5TBD Up A B C
3 0.0000 0.0000 20000 0.0000 0.0000 0.0000
4 00000 0.0000 0.0000 0.0000 0.0000 0.0000

MOTE: Remote Pointz 0 - 2 are reserved for spstem use

Click Guidance on the Offsets tab to view a summary guidance page explaining the SPRINT
300/500/700 angles and offsets.

7.2.5 Port Configuration

The settings for each SPRINT 300/500/700 port are available by selecting the appropriate tab in the
main application window.
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Serial Ports
The settings for the port can be viewed or modified on the Port Settings Pane; see Figure 7-8.
Figure 7-8 Port Settings Panel

Part Settingz

Baud Rate: ‘EIEEIEI M Parity Echo Commands
Frotocol: ‘HSEEE M Data bitg . Enable Output
S 5 _ [] Enable Multiplex

[*] Enable Power

The Baud Rate, Protocol, Parity, Data and Stop Bits can be configured by selecting the
appropriate value from the drop-down lists and then clicking Apply.

Note

Several settings on the console port are fixed to make sure the user can always communicate with
the SPRINT 300/500/700. Protocol is selected by the protocol select pin on the console cable and
cannot be set in the configuration software. Also, the power to the console port cannot be turned off.

Further settings can be modified by selecting the check boxes on the Port Settings Pane:

« Echo Commands will output any commands received by the SPRINT 300/500/700 on this
port.

« Enable Output will turn the message output ON/OFF on this port.
« Enable Multiplex will enable/disable multiplex communications on this port.

« Enable Power will enable/disable power to this port.

Note

The Enable Power setting does not activate external power for the selected port; it allows a user to
turn off a communication port completely to lower power consumption. If the power for a port is
turned off it can no longer send or receive data.

The output messages for the appropriate port can be viewed or modified in the output message table;
see Figure 7-9.
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Figure 7-9 Output Message Table

¥ Lodestar

About..,

Port Settings

Baud Rate: | 9500 | Faiity [ Echo Commands [ Allow Commands
Frotocol:  |RS232 | Databits Enable Dutput
Stap bits [] Enable Multiples

Enable Pawer

Remate Remote ap

M5G Rate Remote Point Fu/D STBD up A B C | Heave Heave 5
it ouice
Type Filter

w10 O-CRP ~ | 0.00000 0.00000 0.00000 000000 | 0.00000 000000  FULL AHRS v
HDT |10 0-CRP | 0.00000 0.00000 0.00000 000000 | 0.00000 0.00000  FULL  » AHRS v

@ v
Refresh  Appl

'= Qutput message settings

Note

The SPRINT 300/500/700 output messages are described in UM-8084-109 Lodestar AHRS
Messages.

Click Add/Remove to add or remove an output.
Select the required output message type from the drop-down list in the MSG column.
Select an output rate (up to 100 Hz) by entering the required value in the Rate column.

If this message is to be output with respect to a remote point on the vehicle, select the appropriate
remote point (already setup on the Offset tab) from the list in the Remote Point column. After
selecting the Remote Point, the appropriate offsets and angles are displayed in the table.

5. Ifthis message is to be output with respect to the vehicle CRP, leave None selected in the
Remote Point column.

6. After all settings have been updated, click Apply on the main application window to save the
configuration to the SPRINT 300/500/700.

o Dnp =

Ethernet

The default IP settings of the SPRINT 300/500/700t are listed below:
» IP Address: 192.168.179.50
« Subnet Mask: 255.255.255.0
« Command port/socket: 4000

Note

The command port 4000 is always available to make sure the user can always communicate with
the SPRINT 300/500/700 via an Ethernet connection. This port is not shown or listed in the
configuration application as it should never be removed or modified.
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The IP port settings can be viewed and modified on the Port Configuration pane; see Figure 7-10.
Figure 7-10 IP Port Configuration Panel

% lLodestar
About..
| System | Console | C1 |EW‘ Tt | T2 | Gyo-Compass | Offsets | S0 Card | Time | GPS | File Transfer | INS Seftings | Teminal|

Port Configuration
|P Addiess: ﬁ32.188 17950 ‘ Maszk: |255.255.255.U ‘ [ Set I Mote: E1 wag called Ethemet[C2] on Old Unit

Port Protocol Allow Commatds Multiplex: Haldoff

TCP O 50

Output Messages

Remole | Remote  qn
Fort MSGE Rate Remote Paint FwD STED uUp A B C Heave Heave

Tupe Filker SR

Add Remave

= Metwork Port settings

@ v
Refresh  Appk

The IP address and subnet mask can be modified by changing the value and then clicking Set.

CAUTION

A If connected to the SPRINT 300/500/700 via the Ethernet port and you wish to change the IP
address or subnet mask, it is strongly recommended that after changing the values the configuration
application is closed. Reconnect using the new IP address by adding it in the Ethernet Connection
Settings and then click "Connect". It also recommended that the SPRINT 300/500/700 is restarted.

1. Click Add/Remove to add or remove an Ethernet port (also referred to as a socket).

2. The Ethernet port settings available are:
« Protocol: can be TCP/IP (secure but slow) or UDP (broadcast fire and forget).
o Allow Commands: enables the SPRINT 300/500/700 to be commanded on this port.
« Multiplex: enables/disables multiplex communications on this Ethernet port.

« Holdoff: the timeout in milliseconds for data to be output on a network port in the event there
isn’'t enough data to be output within that time.

3. After all settings have been updated on the tab, click Apply on the main application window to
save the configuration to the SPRINT 300/500/700.
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The Ethernet output messages can be viewed or modified in the output message table; see Figure 7-

Figure 7-11 Ethernet Output Message Table
% Lodestar
About..
| Systern | Consale | C1 [JET 011 || T2 | Gyro-Compass | Offssts | SO Card | Time | GPS || File Transfer | INS Settings | Teminal|
Part Configuration
IP Address: ﬁ82.188 179.50 ‘ Mask: |255.255.255.D ‘ [ Set ] Mate: E1 was called Ethernet(C2] on Old Urit
Port Protocol Allow Commands Multiplex Holdoff
= ]
Output Messages
Femate | Remcte  qp
Port M55 Fiate Remate Paint FwD STBD uUp A B C Heave Heave ¢ o
Type Filter
Add Femove
‘= Metwork Port settings Re@esh AVI
Note

SPRINT 300/500/700 output messages are described in UM-8084-109 Lodestar AHRS Messages.

1. Click Add/Remove to add or remove a message output.

2. Select the Ethernet port from which this message will be output from the drop-down list in the
Port column.

3. Select the required output message type from the drop-down list in the MSG column. Select an
output rate (up to 100 Hz) by entering the required value in the Rate column.

4. Ifthis message is to be output with respect to a remote point on the vehicle, select the appropriate
remote point (already setup on the Offset tab) from the list in the Remote Point column. After
selecting the Remote Point the appropriate offsets and angles are displayed in the table.

5. Ifthis message is to be output with respect to the vehicle CRP, leave None selected in the
Remote Point column.

6. After all settings have been updated on the tab, click Apply on the main application window to
save the configuration to the SPRINT 300/500/700.
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7.2.6 Configure Time Settings

The time and date configured in the SPRINT 300/500/700 is displayed in the Clock Settings panel
on the Time tab; see Figure 7-12.

Figure 7-12 Clock Settings panel

% |odestar

About..

| IN5 Settings |
| System | Terminal | Console | C1 |E1 | T1 | T2 | Gyro-Compass || Offsets | SD Card |T| i GPS || File Transfer |
Clock Settings
Time and Date: |05 Jul 2012 14:3502 3 (s |
Esternal Time Synchronisation
Z0a, Part PPS Paort
Lodestar Port: |C1 v| Trigger Edge: |Fiising Vl
Ethermet Port Z04 Sequence: |Afler PFS vl

Ethemet Port. [4000 Tl (P o |

Time Statiztics
UTC time: | |

Z0A, Time: |
[ Test 4204 receipt

Status Flag: | |

[ Test $PSONTMS receint

Mote: Please go to comesponding 204 port tab to change port settings

= Time Svstem sekting

v
Refresh  Apply

1. The time and date can be modified using the up/down arrows on the Time and Date box and
then clicking Set.

2. IfGPS inputis available and a GPS receiver is not already supplying the necessary NMEA 0183
GPZDA sentences to the SPRINT 300/500/700, make sure the input is connected now.

3. The GPZDA input can be configured on the ZDA Port pane; see Figure 7—13.

4. Selectthe SPRINT 300/500/700 port the GPS is connected to from the drop-down list. The
settings for the selected port are displayed and can be changed if required.

5. Click Apply on the main application window to save this configuration on the SPRINT
300/500/700.

6. The GPZDA input Test ZDA receipt (if available) can be selected; see Figure 7-13.

Figure 7-13 ZDA Port Panel

Z0 Part

Baud Rate: | 3600 |
Fratacal |F|S232 v |
Parity: | MHaohe b |
Data bits: | 8 v |
Stop bitg: | 1 hd |
Lodestar Port: | C1 |

ZDA Time: | 27/05/2010 16:30:1 |
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7. Ifthe PPS inputis available and is not already connected to SPRINT 300/500/700, connect it
now. The SPRINT 300/500/700 can accept an input trigger on the following ports:

Table 7-1 PPS Input Ports

SPRINT Type SPRINT V2 Port SPRINT V3 Port
Subsea C1 C1

E1 (Ethemnet) E1 (Ethemnet)

T1 -

T2 -
Note

The test cables supplied with the SPRINT 300/500/700 have BNC connectors that can be used to
input the PPS pulse to the SPRINT 300/500/700.

8. The PPS input pulse can be configured on the PPS Port panel; see Figure 7—14.

Figure 7-14 PPS Port panel

PPS Part

Trigger Edge: | Rizitig w |
F08 Sequence: |.-'l'-.fter PPS P |
Trigger Part: | 1 A" |

Trigger Edge: specifies whether the timing pulse should be measured on the rising (high) or
falling (low) of the input signal.

ZDA Sequence: specifies when the ZDA message arrives with respect to the PPS timing
pulse.

« After PPS: should be selected if the ZDA arrives shortly after the PPS pulse.
« Before PPS: should be selected if the ZDA arrives shortly before the PPS pulse.

« Time of Arrival: should be selected is the ZDA arrives at the same time as the PPS pulse.

9. Onthe Trigger Port drop-down list, select the SPRINT port that is receiving the 1PPS signal.

10. Click Apply on the main application window to save this configuration on the SPRINT
300/500/700.

7.2.7 Checking Output

There are several methods that can be used to check the output from the SPRINT 300/500/700,
explained below.

A dynamic display can be viewed that allows you to view the real time output from the SPRINT
300/500/700. This can be launched by clicking Dynamic Display on the System tab. The display
shows heading, roll, pitch, heave, surge and sway measurements with respect to the CRP of the
vehicle; see Figure 7—15.
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Figure 7-15 Dynamic Display

¥ Dynamic Display

Surge=0.01m

Pitch=-0.29°

Close

Sway=0.06m Heave=0.00m Roll=1.69°

Note

If the output is incorrect, check the following settings are correct:
- Mounting angles and offsets
- Default Latitude or automatic GPS compensation

The method for checking the automatic GPS compensation is detailed below.
While the Dynamic Display window is open, click the Terminal tab on the main application window.

The Terminal tab displays the output from the SPRINT 300/500/700, which in this case is the
Sonardyne proprietary SON1 telegram. The last character of each received message is a status flag
that indicates the type of GPS compensation received by the SPRINT 300/500/700; see Figure 7-16.

Figure 7-16 Terminal check of GPS compensation

Timestamp Meszage o)

2010-05-27 16:13:39.... :-000376-000063-002422 002006-000211 190??[@

2010-05-27 16:13:39.... :-000377-000069-002406 002005-000212 1907744

2010-05-27 16:13:39.... :-000378-000069-002385 002005-000212 1907744

2010-05-27 16:13:39.... :-000379-000069-002372 002005-000212 1907744

2010-05-27 16:13:39.... :-000380-000063-002355 002005-000211 1307744

2010-05-27 16:13:39.... :-000381-000063-002338 002005-000212 1907744

2010-05-27 16:13:40.... :-000382-000069-002321 002005-000211 1907744

2010-05-27 16:13:40.... :-000383-000063-002304 002003-0002171 1907744

2010-05-27 16:13:40.... :-000384-000063-002287 001995-000210 1907734

2010-05-27 16:13:40.... :-000385-000063-002270 001986-000206 1307744

2010-05-27 16:13:40.... -000386-000063-002253 001982-00020% 1907744

2010-05-27 16:13:40.... -000387-000063-002236 001930-000204 1307744

2010-05-27 16:13:40.... :-000388-000069-002219 001979-000204 1907744

2010-05-27 16:13:40.... :-000389-000069-002202 001979-000204 1907744

2010-05-27 16:13:40.... :-000390-000069-002185 001979-000204 1907744

2010-05-27 16:13:40.... :-000391-000069-002168 001979-000204 1907744

2010-05-27 16:13:41.... :-000391-000063-002150 001 980-000204 13077 &‘ =
v

The status flag should be A indicating the SPRINT 300/500/700 is receiving full GPS compensation
and is also fully settled. Descriptions of all possible states are listed below.

An upper case character indicates the SPRINT 300/500/700 is settled whereas a lower case
character indicates the unit is still settling.

« aor A meansthe SPRINT 300/500/700 is receiving and decoding valid GPGGA and GPVTG
telegrams successfully.

« gor Gmeansthe SPRINT 300/500/700 is receiving and decoding only valid GPGGA
telegrams.
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« vorV meansthe SPRINT 300/500/700 is receiving and decoding only valid GPVTG
telegrams.

« uorU meansthe SPRINT 300/500/700 is not receiving or decoding any valid GPGGA and
GPVTG telegrams.

If a GPS is connected to the SPRINT 300/500/700 and the GPS input flag is not A, make sure the
GPS receiver is sending the correct telegrams by connecting a terminal application, such as
HyperTerminal, to the GPS receiver’s output as shown in Figure 7—17.

Figure 7-17 Example GPS output in HyperTerminal

‘& COM22 9600 - HyperTerminal uw]

Ele Edt Wiew Cal Iransfer Help
DF &8 08B &

$6PVTG6,173.630,7,173.630,M,0.112,N,0.207,K=49

$6PZDA. 081931.00.22,01,2009, 00, 00~6F

$GPGGA. 081932.00,5119,85,N,00129.2078458,1,5,8,1.33,115.983 M, ,,0.0,1=6
$6PYTG,173.630.7,173.630,H,0.112,N,0.207  K=49
$6PZDA.081932.00,22,01,2009,00,00=6D

$GPGGA, 081933.00,5119.85,N,00129.2078458,H,5,8,1.33,115.983 M, ,,0.0,1=7
$6PVTG,173.630,7,173.630,M,0.112,N,0.207 ,K=49

$GPZDA, 081933.00,22,01,2009, 00,0060

$GPGGA, 081934 .00,5119.85,N,00129.2078458,H,5,8,1.33,115.983 M,,,0.0,1~0
$GPVTG,173 630,T, 173 63@ M 0. 112 N B 207, K=49

$G6PZDA. 081934 .00, 22,

igge?ﬂ,ﬂ&lBSS .00, 5119 85 N 00129 2878&58 H 5 8 1.33,115.983,4,,.0.0,1=1
$GPZDA, 081935. BB 22 01 2889 BB 00~6H

$GPGGA.081936.00.5119.85,N, 06129.2078458,1,5,8,1.33,115.983 H,,,0.0,1=2
$GPVTG,173,630,1,173.630,M.0,112,N,0.207, K=49

$GPZDA, 081936.00,22,01,2009,00,00~69

$GPGGA, 081937.00.5119,85, N, 00139, 2878658,“.5.8,1.33 115.983 . M,,,0.0,1=3
$6PVYTG,173.630,7,173.630,M,0.112,N,0.207 K

$G6PZDA. 081937.00.22,01,2009, 00,0068

$GPGGA, 081938 . 96 5119.85,N,00129. 2078&58.".5.8.1.33 115.983 ,H,,,0.0,1=C
$6PVTG6,173.630,7,173.630,M,0.112,N,0.207 K=&

$GPZDH,BBI938 00 22,01,2009,00,00~67

Connected 0:02:27 ANSIW 9600 G-N-1 | SCROLL | CAPS | NUM | Capture | Print echo
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Section 8 — Retrieval and Storage

8.1 Introduction

Before retrieving the equipment, ensure Section 2 — Safety is read and fully understood.

8.2 Retrieval

On retrieval from the installation location, the following procedures must be carried out before the
SPRINT 300/500/700 is stored.

1. Cleanthe SPRINT 300/500/700; see Section 9.4 "Cleaning".
2. Inspectthe SPRINT 300/500/700; see Section 9.5 "Inspection”.

3. Place connector covers on all connector ports.

8.3 Storage

On completion of all checks in the previous section the SPRINT 300/500/700 can be placed in storage
as described below.See Table 8-1 for the recommended storage conditions.

1. Store the SPRINT 300/500/700 in its transit case.

2. Equipment must be kept in a dry, non-condensing atmosphere (20% to 80% humidity), free from
corrosive agents and isolated from sources of vibration.

3. The transit case should be stored on solid, level, clean and damp proof floors. It must not be
stored directly on damp/dirty floors or areas prone to flooding. It is recommended to store the
case on suitable shelving raised off the floor.

4. Itis recommended to visually insect the equipment at least annually.
5. When equipment is taken from low temperature storage for immediate use its temperature should
be raised to normal operating temperature before use.

Table 8-1 Storage Conditions

Item Specification

Storage Temperature -20°C t0 60°C (see Note below)
Relative Humidity 20 to 80% (non-condensing)
Note

To prolong the life of the lithium-ion backup battery, it is recommended to store the instrument in
the temperature range of 0° to 30°C.
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Section 9 — Maintenance

9.1 Introduction

Before any maintenance is performed, ensure Section 2 — Safety is read and fully understood.

9.2 Retrieval from the Water

See Section 8 "Retrieval and Storage”.

9.3 Dismantling
Dismantling of the SPRINT 300/500/700 must only be carried out by Sonardyne qualified personnel.

9.4 Cleaning

Note

Do not use any abrasive brushes or sharp tools to remove marine growth when cleaning the
SPRINT 300/500/700 as this may damage the instrument.

1. Thoroughly wash the instrument in warm clean fresh water to remove accumulations of salt, sand
or silt and marine growth, paying particular attention to the electrical connectors.

2. Remove any attached cabling or dummy plugs/protective caps and clean the external socket.
3. Drythe instrument and any attached cabling with a clean lint free cloth.

4. Replace any attached dummy plugs/protective caps.

9.5 Inspection

Regularly inspect the instrument for the following:
1. Inspect the pressure relief vent valve; see Section 9.7 "Pressure Relief Vent Valve".

2. Inspect the housing for signs of damage. At full working depth, the instrument housing is at risk of
failure if damage is not repaired.

3. Inspect the connectors and cables for signs of abrasion, damage or corrosion.

4. Check the security of the connectors. Any movement will require attention and the connector to
be secured.

9.6 Lubrication

9.6.1 Connectors

The Seacon connectors are dry mating and do not require lubrication on the connector pins/sockets.
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9.7 Pressure Relief Vent Valve

9.7.1 Checking the Pressure Relief Vent Valve

Check the pressure relief vent valve is flush with the endcap. If the pressure relief vent valve is not
flush it could indicate a pressure build-up during previous operations due to a fault developing in the
backup battery pack.

Item |Description

1 Pressure Relief Vent Valve

9.7.2 Operating the Pressure Relief Vent Valve

To operate the pressure relief vent valve:

Note

Refer to Warnings in Section 2 — Safety “high internal pressure, risk of toxic gases and corrosive
liquids”.

1. Screw an M4 bolt into the pressure relief vent valve.

2. Slowly pull the M4 bolt to withdraw the vent valve and wait for any internal pressure to be
released.

3. With the pressure relief vent valve pulled out inspect the O-rings for any signs of damage.
4. If necessary, lubricate the O-rings using petroleum jelly.

5. The valve should retract back into place; remove the M4 bolt and check the valve is flush with the
endcap face.

9.8 Corrosion

The SPRINT 300/500/700 housing is manufactured from titanium and is highly resistant to corrosion.
Under normal use the housing should not show any signs of corrosion and no maintenance is
necessary.
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9.9 Calibration

The SPRINT 300/500/700 uses rugged and durable high quality inertial sensors of unrivalled and
thoroughly field proven reliability: The sensors are used in systems qualified for the most demanding
and safety critical applications and are standard fit for use in the main navigation systems of the
maijority of today’s commercial and business aircraft. The inertial sensors are maintenance free.

SPRINT 300/500/700 based products do not require re-calibration subsequent to initial factory
calibration unless:

« the unit has been subject to excessive shock beyond quoted specification.

« performance re-verification is requested by the customer.

Performance re-verification is often possible in the field without return to factory; contact Sonardyne
Support for more information.
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Section 10 — Firmware Update for SPRINT 300/500/700

10.1 Introduction

The SPRINT 300/500/700 firmware can be updated in the field by using the PC Utility software tool
(included with the SPRINT 300/500/700). Sonardyne support will notify customers when new
firmware updates become available.

The SPRINT 300/500/700 will accept firmware updates on the CP port only.
To update the firmware using PC Ultility software via a serial connection, follow the procedures below.

10.2 Updating the Firmware

10.2.1 Prerequisites

To update the firmware, the following prerequisites must be met:
« The new firmware file (IMU.hex)
« A serial connection to the SPRINT 300/500/700 on the CP port.
« A PC Utility software installation.

10.2.2 Update Procedure

1. Connectthe SPRINT 300/500/700 CP port to the PC either directly via RS232 or through a
Navigation Sensor Hub (NSH).

Note
Wait two minutes after applying power to allow the SPRINT 300/500/700 to start up.

2. Click Start > Programs > Sonardyne > Lodestar > Lodestar to open the PC Ultility.
3. Click Connect to connect to the SPRINT 300/500/700.

£ Lodestar

About,.,

IN5 Settings e
System | Temninal | Corsole | 1 | E1 | T1 | T2 | Gyro-Compass | Offsets | D Card | Time | GPS | File Transfer |

Lodestar Console Connection

PC Part: | COM1 Connecl t Disconnect t Connected to Lodestar Console Port

[suBsEA | Firmuare:

Audible Alaim Shutdawn/Feset CPU UART FRGA

Eosl Interconnect {FPBA
Dwnamic Display GC Resst Serial Number:

ﬂ] Full Reset Licance

Pic SN
Lodestar Canfiguration Pesebm ek

Sendto User Lewel

Licence Key:

% GPS-INS Sigma Level | @ v
Refresh  Apply

4. Once connected click Retrieve from Lodestar (SPRINT 300/500/700) to store the
configuration of the SPRINT 300/500/700 as a text file (this is recommended for a backup).
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5. Click Download Firmware.

% Lodestar

Ahout...

INS Settngs|
System | Temninal | Consale | €1 |E1 | T1 | T2 | Gyro-Compass | Offsets | S0 Card | Time | GPS | File Transfer |
Lodestar Console Connection

P Part: | COM1 Connected to Lodestar Console Port

Housing Type “ersion
[suBsEe | Fimwae: [z0500.788 | [ Dovnioad Fimware_|
Audible Alarm Shutdown/Feset CPU LART FPGA
[ Enable Shutdown Interconnect FRGA: |2 Rosel T Foctoy
Dynnic Diplay G | SoNumer (2075002 el
;}Launch Full Reset S=rce
Pic SN 9935
Laitste Cantigneime Application Levet  [SUBSEA_INS
Fetrieve from Sendto User Level:
Lodestar Lodestar
Licence Kew | ‘ [ Write ]

= User Status

v
Refresh  Apply

6. Click Yes to confirm.

Please confirm...

P

Lodestar will be forced to be in Bootloader Command Prompt,
Are you sure you want ko download Firmware ko the Lodeskar?

7. Browse to the folder and select the new IMU.HEX file to download (supplied by Sonardyne).

Firmware Download Settings

L]

File to download: |

3E00 v

Select Baud Rate:

Status

File Size: 0
Bytes Transfered: 0

Start

Dore

8. A warning will be displayed asking if you are sure that selected file is a SPRINT 300/500/700)
firmware file.

9. Click Yes to continue.

Is saints_s3. hex Lodestar Firmware file?

&

Are wou sure that selected file is a Lodestar Firmware file?
If %es, then the file shall be stored on the S0 card of the Lodestar as ‘TMIUHER',
If Mo, then the file shall be stored on the SO card of the Lodeskar as 'saints_s3 hex'

I mo

L e
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10. Select a Baud Rate for the download (Sonardyne recommends 115200 baud for all firmware
downloads).

Firmware Download Settings

File to download: | Yhanetisharedvworkgroupshengineenng'software_deviA eIeases\Lodestar| D

Select Baud Rate:

Status

File Size: 1}
Bytes Transfered: 0

[ st | [ Dpoe |

11. Click Start to commence the download (at this point the progress bar will show download status;
download time at 115200 is less than five minutes).

Note

It is recommended not to interact with the PC while the download is in progress.

Firmware Download Settings

File to download: |\\snet\shaled\\N'olkgroups\engineering\software_dev\F!eIeases\Lodestar| B
Select Bawd Rate: 115200 W
Status

Downloading MU HEX. ..

LT ]
File Size: 3913522
Bytes Transfered: 927744

12. Once the download is complete click Done.

Firmware Download Settings

File to download: |\\snet\shaled\Wolkgroups\engineering\software_dev\F!eIeases\Lodestar| D
Select Baud Rate: 115200 w
Skatus

MU HE transferad successtully

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII‘
File Size: 3913522
Bytes Transfered: 3913922

[ Start ] l Dore ]
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13. Atthis point the utility will re-boot the SPRINT 300/500/700.

Firmware Download Settings

File ta download: TEi"-.ElinariE:E:

Select Bawd Rate: 115200

Status
Please wait for the Lodestar to load firmware........ 109 seconds

[IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII‘
File Size: 39135922
Buytes Transfered: 3913922

Skart Dane

14. Once complete, the PC Ultility software will re-program the SPRINT 300/500/700 with the same
configuration it had before the update.
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Section 11 — Retrieving On-board Log Files

11.1 Introduction
On-board log files can be retrieved from the SPRINT 300/500/700 using the PC Utility software.

11.2 SPRINT 300/500/700 Connection and Retrieval

1. Connect to Ethernet port 4000 or 4001 (if the unit has been configured for SPRINT INS
operation); see Figure 11-1.

Figure 11-1 SPRINT 300/500/700 Ethernet Connection

IP Address: | 192.168.179.50 IP Addiess: |192.168.179.50
Socketld: ((4000) | Socketld: ([4001) |
[[] Connect To NSH ] Connect To NSH
NSH Config NSH Config
NSH Port 48v On NSH Port 48y On
Baud Rate Configure Baud Rate Configure
Data Bit Configure Data Bits Configure
Parity Configure Parity: Configure
Stop Bits Configure Stop Bits Configure
Status: Status:
[ Muliplesed [ OK ] [ Cancel ] [ Multiplesed oK ] [ EReE

2. Once the connection has been established, select the E1 tab and ensure multiplex is cleared; see
Figure 11-2 and Figure 11-3.

3. Apply the changes and wait for progress bar to complete before selecting a new tab.
Figure 11-2 SPRINT 300/500/700 Ethernet Port 4000 Configuration

| Syztem || Terminal || Conzole || C1 | E1 | T1 || T2 || Gyro-Compass || Offsetz || S0 Card || Time || GPS || File Tranzfer || IMS Settings
Part Configuration

IP Addresz; | 192.168.173.50 W agk: |255.255.255.D | [ Set ] Mote: E1 waz called Ethemet(CZ2] on Old Unit

Pyt Protocal Allowy Commands Multiplex Holdoft
TCF O a0
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Figure 11-3 SPRINT 300/500/700 Ethernet Port 4001 Configuration

| System || T erminal || Conzole || C1 | E1 |T1 || T2 || Gyro-Compass || Offzets || 5D Card || Time || GFS || File Tranzfer || IN5 Settings
Port Configuration
IP Address: Mask: (2562562550 ||  Set | Note: E1was called Ethemet(CZ) on Oid Uni
Fo Protocal Allowy Commands Multiplex = Holdoff

4007 ToP (o) 50

B

Note

The SPRINT 300/500/700 port used for file transfer must have multiplex mode disabled and
must not be configured for AHRS/INS operations (input/output messages enabled).

4. Onthe File Transfer tab and select the data destination folder; see Figure 11—4.

5. Onthe Lodestar SD Card Explorer pane, click + to expand the folders and open the
LoggedData folder.

Figure 11-4 SD Files Destination Folder

% Lodestar

About...

| IN5 Setiings

| System | Temninal| Console | €1 | ET | T1 | T2 | Gyro-Compass | Offsets | SD Card | Time | GPS | File Transter ]
File Transfer
Local PC Settings

Flace received files in following folder:
[() AT
|
Lodestar SO Card Explarer
& . Mame Size | Date Modif...
IMU.HEX 4082 12/03/2M 3.
cliflash.hex 183KE 314017203

s -
S0 Fi @ v
" IE Refresh  Appl
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6. The folders and files use the following naming convention:
« Folders: D[serial number]_[yyyymmdd

« Files: D[serial number]_[file counter]_[yyyymmdd]_[hhmmss][#].BIN
(#is only present on first file created after boot-up)

r ~
3 Lodestar E@g
About...
INS Settings
| System | Teminal [ Console [c1 [E1 [ T1 [T2 | Gyro-Compass | Offsets | SD Card [ Time | GPS | File Transfer
File Transfer
Local PC Settings
Place received files in following folder:
(o) [ UploadtoPC
Delete
Lodestar SO Card Explorer
=-@ l-oggDe;E;Ew —— “ || Name Size Date Modfied -
8 D312491.004 2012.03.29 _||| D213491-004_004048 20180320 0231022 BIN  9379.. 20/03/2018...
() DI13481-004_2018-0330 = ||| D312491-004_004045_20180320_030056.BIN 9049, 20/03/2018...
] D31M41-004_2018-03.31 D313491-004_004050_20180320_033053BIN 1268 20/03/2018..
@ D313491m4:201m1 D313451-004_004051_20180320_040050.BIN 1247, 20/03/2018...
(3] D313491-004_2018-04-03 [:313451-004_004052_20180320_043043.BIN 1045...  20/03/2018...
(&) D313491-004_2018-04-04 D313491-004_004053_20180320_050045BIN 8646 20/03/2018.. |
(£ D313491-004_2018-04-05 D313491-004_004054_20180320_053042BIN 6472 20/03/2018.. 3
(] D313491-004_2018-04-06 D313491-004_004055_20180320_060040BIN  6156.. 20/03/2018..
() D313491-004_2018-04-10 D313491-004_004056_20180320_063037BIN 6009 20/03/2018
(2] D313491-004_2018-04-12 - || D313491-004_004057_20180320_070034.BIN  0.00.. 20/03/2018... e
4 sDFile v
Refresh  Apply

6. Selectthe log file(s) for retrieval and click Upload to PC.

% Lodestar

About..,,

| INS Settings

‘ Sustern ” Terminal || Conzole || ]

| E1

|

File Transfer
Local PC Settings

Place received filez in following folder

C:\Documents and Settingshitb\D esktopiLodestar 50 Data

Lodestar SO Card Explarer

=& - Narne Size | Date Modified |
=) LoggedData D2859071-002_D00323_20130403_0S1010BIM  4431KE  03/04/2013 08:10:05
[ D285301-002_2013-0313 D285301-002_000324_20130403 0S2009BIN  4486KE  03/04/2013 08:20:04
[ D285301-002_2013-03-14 4498KB  03/04/2013 08:30:04
[ D2B6301-002_2013-03-21 4468KE  03/04/2013 03:40:03

4431KE  03/04/2013 0860:03 =
82 Dogoann Q001528 4aEKS 1342013 150003
(3 D285901.002_2013-03-26 A415KE 03/04/2013 09:20:01

- D28590-002_2013-03-27 4414KB  03/04/20130330:01 —
(1] D285901-002_2013-03-28 4431KB  03/04/2013 09:40:01
(1] D285901-002_2013-04-02 4434KE 0340442013 09:50:00
(] D265901-002_2013-04-03 002 _| | } X 4450KE  03/04/2013 10:00:00
) D2A5901-002_201 30411 D265301-002_000335_20130403_100959BIN  4464KE  03/04/2013 10:0%:29
G D285301 002201304412 D2685301-002_000336_20130403_101958BIN  4474KE  03/04/201310:19:29
- D265901-002_000337_20130403_102957BIN  4431KE  03/04/2013 10:23:28
(10 D285401-002_2013-04-13 D2859071-002_0D0235_20130403_103956.BIN  4483KE  03/04/2013 10:33:28
(3 D285901-002_2013-04-14 D285901-002_000339_20130403 104955BIN 4410KE  03/04/2013 10:43:27

(] D285501-002_2013-0415 D265901-002_000340_20130403_105954BIN  4410KE  03/04/2013 105927+

(] D285501-002_2013-04-16 < O | s

30 File
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7. A progress bar displays the data upload.

Receiving files .. Receiving files ..

Filaz In Progress 28 Filas In Progress 878

(LTI I (T T T T LT
C:ADs and Settrgsab\My Documents\Ledesta S0 Datat\DOBRA01 02_0003 C:ADy ared Settiegs \ab\My Decumenis\Ledesta S0 Darat\DEER01-002_ 0003
[WRRNRNRRNRRRRED ] O T T

8. Afterfile transfer completes, click the System tab and then click Disconnect prior to removing
the test cable connected to the SPRINT 300/500/700.
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Section 12 — Troubleshooting

12.1 Introduction

This section provides guidance for troubleshooting and fault identification.

Before calling Sonardyne Support, preliminary checks should first be made on the SPRINT
300/500/700 so a full description relating to the problem can be provided.

If technical support from Sonardyne is required, provide information about the SPRINT 300/500/700
configuration in use at the time when the problem occurred. Do this by supplying a copy of the relevant
configuration file saved automatically by the SPRINT INS log files, which can be exported from the
SPRINT system software.

12.2 SPRINT 300/500/700 Hardware Test Procedure

Figure 12—1 shows the recommended test procedure to follow if it is suspected that SPRINT
300/500/700 has developed a fault.

Use this test procedure after installation to check the system operates correctly, or if a fault is
suspected during normal operation.

Note

There are no user-serviceable parts inside the SPRINT 300/500/700. The SPRINT 300/500/700 must
only be accessed internally and dismantled by qualified Sonardyne personnel.
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Figure 12-1 SPRINT 300/500/700 Hardware Test Procedure

Ve \
Lodestar fault
identification
e . T T
_~ DCpower . No " pCpower
oK? rectified?

Yes v Yes
Allow settling time
and repeat test
procedure
.
T . Check cabling and
- Data ' No
" ved? S connectors
recelveds throughout
| Yes
/___/" T~
- S
- .y No Connect a PC, run
/ Is data
< ood? ™ software and set
8 ’ commes parameters

L

- N
/ R _~ ~
Lodestar OK " Comms . NO | Restartlodestarand
oK? repeat test procedure
Yes
T
e ~.
e Value \"'\_ No Contact Sonardyne
Support
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12.3 SPRINT 300/500/700 Connection

When connecting the SPRINT 300/500/700, carry out the following:

1. ALWAYS configure and check the SPRINT 300/500/700 connection prior to mounting on subsea
vehicle.

2. Make sure the SPRINT 300/500/700 is fully charged (2—3 hours) prior to vehicle connection tests
to eliminate any communication failures due to intermittent connections and power loss.

3. Once the SPRINT 300/500/700 is mounted on the vehicle, connect a laptop using test cables to
verify the SPRINT 300/500/700 operation and sensor communications.

4. Ethernet— check vehicle supports 100 megabit.

5. Serial — check 232 485 cable select for console port connection issues.

12.4 Attitude Heading Reference System (AHRS)

When using the AHRS, make sure:
1. The default Latitude is set.

2. Thereis a constant bias noted. If so, check SPRINT 300/500/700 mounting angles, lever arms
and remote output points if configured.

12.5 Inertial Navigation System (INS)

When using the INS, make sure:

1. Generally, INS will always reject for a valid reason. Rejection indicates issues for investigation on
the aiding sensor.

2. The most common reason for rejection of time stamped data (GPS / USBL) is an incorrectly
configured time synchronisation.

3. Ifbad aiding data is accepted as good then INS may report Bias, Accelerometer or Heading
warnings.

4. Following other troubleshooting steps first (INS is last port of call for issues/errors).

12.6 Time Synchronisation

When using the Time Synchronisation process, make sure:
1. IfZDA only is used, latency MUST be set.

2. Theideal method is ZDA and 1PPS, verify the PPS indicator LED on the Time Synchronisation
window is active once per second.

3. Make sure any time stamped aiding (GPS/USBL) is also UTC time synched; check in comms
viewer.

4. Ifthe SPRINT 300/500/700 is synchronised to difference time base than GPS/USBL the
behaviour to notice is:

« SPRINT 300/500/700 accepts position data while static
« SPRINT 300/500/700 rejects position data as soon as it moves
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Note

Rejection reason might be ‘outside INS estimate’ rather than indicating a time synch issue, an
INS cannot tell the difference.

12.7 Aiding Inputs (All)

When using Aiding Inputs, make sure to:
1. Check input using:
« Comms Monitor
« SPRINT 300/500/700 Port Traffic

2. Check lever arms and mounting angles.

12.8 USBL Aiding

When using USBL Aiding:

Make sure the USBL system is UTC time synched.

Check UTC time stamp in telegram is correct.

Make sure the Radians Lat/Long are selected for PSIMSSB message.

Check that measured rather than filtered is selected (raw position is required).
Make sure beacon ID is correct.

Check USBL setup:

« Lever arms and angular corrections (calibration)

2B S o A

« Sound velocity

12.9 Depth Aiding
When using Depth Aiding make sure:

1. The correct units are selected.

2. Tocheck surface correction.

12.10 Doppler Velocity Log (DVL) Aiding
When using a Doppler Velocity Log Aiding system, make sure:
1. The DVL is configured correctly.
2. The sound velocity is correct.
3. The latency and scale factor are configured correctly.

12.11 LBL Aiding
When using LBL Aiding:
1. Is Fusion sound velocity correct?
2. Is ROV to Beacon(s) relative depths correct?:
. Tide

o Absolute->Corrected
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Has INS had time to move between USBL and LBL?
How does this beacon fit into array?

Can the acoustic LBL position be used for comparison?

o g kA~ w

Are the minimum/maximum range settings correct?

12.12 External Position Aiding

When using External Position Aiding:

Make sure the External Positioning system is UTC time synched.
Check UTC time stamp in telegram is correct.

Make sure the Lat/Long are in WGS84 degrees.

L bdh =

Check External Position setup:
o Lever Arms

« Quality

12.13 Recovery Procedures

The following procedures can be followed to recover the SPRINT 300/500/700 to a known state in the
event of a problem.

12.13.1 SPRINT 300/500/700 Hardware Reset

The SPRINT 300/500/700 can be commanded to perform a hardware reset if it becomes
unresponsive.

To perform a hardware reset you must be connected to the SPRINT 300/500/700 serially via the CP
port using a terminal package such as HyperTerminal.

Make sure the connection to the SPRINT 300/500/700 is 9600 baud and RS232 protocol. If these
conditions are met, the SPRINT 300/500/700 can be restarted by typing UNLK, and then return in the
terminal window (note the use of uppercase letters). You may need to type UNLK and press return
several times.

Ifthe SPRINT 300/500/700 is connected via Ethernet to the SPRINT system, a hardware reset can
also be performed using the Reset SPRINT button on the SPRINT dialog box.

12.13.2 Restore SPRINT 300/500/700 Factory Settings

The SPRINT 300/500/700 can be commanded to restore its factory default settings.

If factory settings are restored, all previous user defined settings in theSPRINT 300/500/700 will be
lost. It is recommended a careful note is taken of any required settings before restoring factory
settings.

The PC Utility software can be used to restore theSPRINT 300/500/700 to its default state. This
procedure will succeed even if the current baud rate of theSPRINT 300/500/700 isn’t known.

1. Connectthe SPRINT 300/500/700 CP port to the PC either directly via RS232 or through a
Navigation Sensor Hub (NSH).

Note
Wait two minutes after applying power to allow the SPRINT 300/500/700 to start up.
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2. Click Start > Programs > Sonardyne > Lodestar > Lodestar to open the PC Ulility.
3. Click Connect and select the COM port that the SPRINT 300/500/700 is connected to.
4. Click Reset to Factory Default.

£ lodestar,

About. .

INS Settings
Spstem | Terminal | Console | C1 [ E1 | T1 | 72 | Gyro-Compass | Offsets | S0 Card | Time | GPS | File Transfer |

Lodestar Console Connection

PC Port: |[COM1 Connect Disconnect Connected to Lodsstar Consale Port

Housing Type Yersion
[sUBSEA | Fimare [20500788 | [ Dowmload Fimuere |
Audible Alarm Shutdown/FReset CPU LIART FPGA

M Shutdonn Interconnect FPGA: |2 R
) Default
Dynamic Display GC Fesat Serial Number: 270729-002
L h A
&] Full Resst Licence

Pic 5M: 9935

\edtenien o EiEn Appication Level.  [SUBSEA_INS

Fetrigve fram Send to User Level ustomer
Lodestar Lodestar
Licence Key: [ Wwirite ]

% GPS-INS Sigma Level

® v
Refresh  Appl

5. Click Yes to confirm.

Please confirm..

i . Lodestar will be Forced to Factory default.
Are you sure you wank ko reset Lodestar to Factory default

Lres J[ to |

6. The PC Utility will reboot the SPRINT 300/500/700 and reset it to factory default state. It will then
wait for the SPRINT 300/500/700 to re-boot.

Please Wait...

Please wait for the Lodestar to load firmware........ 108 seconds
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7. After the boot process has completed the PC Ultility software will attempt to connect to the
SPRINT 300/500/700 using factory default settings. If successful the SPRINT 300/500/700
information will be displayed.

¥ Lodestar

About. ..

IN5 Settings
System | Teminal | Console [C1 |E1 |71 | T2 | Gyo-Compass | Offsets | SD Card | Time | GPS | File Transter

Lodestar Consale Connection
PC Port; | COM1 Connect Disconnect Connected to Lodestar Console Port
Hausing Type Wersian
[suBsEA | Firmuare 205.00.783 Dowrioad Fimware
Auetble Alam Shuidown/Resel | CPUUART FPGA
B Iecanmect P FES R
Default
ey [ G Fresst Sistial Number 270723002
Launch
[ Loweh ] Ful Fesat ez
PFic 5N 9935
ey Application Level,  |SUBSEA_INS

Fietrieve from Send to User Level:
Lodestar Lodestar
Licence Key \ [ wie |

A5 User status

v
Refresh  appl
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Section 13 — Spares

13.1 Introduction
When ordering spare parts, please provide:
a. The part number

b. The description

Enquiries about, or orders for spare parts should be directed to your local Sonardyne office or agent
(see back page for Sonardyne office addresses).

13.2 SPRINT 300/500/700 Spares List

Description Stock Code
SPRINT 300/500/700 Battery 270-0610
SPRINT 300/500/700 Transit Case 790-1139
Standard Seacon CP+E1 5m Cable Tall 317-3250
Standard Seacon C1/T1/T2 5m Cable Tail 317-3265
Standard Seacon CP+E1/D12m Test Cable 820-6942
Standard Seacon C1/T1/T2 2m Test Cable 820-6951
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Section 14 — Technical Specifications

14.1 Type 8253-4511 SPRINT 300 4000 m 4 x Seacon

‘Seacon
MINL-16-FCR/L
e

Feature Type 8253-000-4511
Depth Rating 4,000 metres
Physical Size (Dia x Length) 205x260 mm
Weight in Air/Water* 18.5/11.5kg
Mechanical Contruction | Titanium
Connectors 4 x Seacon
Performance Heading Accuracy 0.2° (Lodestar AHRS), 0.05° (SPRINT INS) Secant Latitude
Rolland Pitch Accuracy |0.01°
Settle Time <10 minutes in dynamic conditions (AHRS), Instantaneous (INS)
INS Aiding Supported USBL, Depth, DVL, Zero Velocity, Manual Position, LBL (position), GNSS
USBL/LBL Aided 3 x precision improvement over USBL/LBL (Position)
USBL/LBL and DVL 3to 7 x precision improvement over USBL/LBL (Position)
Aided
DVL Aided Accuracy 0.2% position error for distance travelled (3rd party DVL) 0.16% position error for distance
travelled (Sonardyne Syrinx DVL)
DVL Aiding Loss/Drift 1.2mover 1 min, 5 m over 2 mins (CEP50)
Station Keeping <1 mover 1 hour (3rd party DVL)
<1 m over 24 hours (Sonardyne Syrinx DVL)
Environmental Temperature -20to +55°C (operating), -20 to +60°C (storage)
Shock Rating 22 g, 11 mshalf sine
Power Power Requirement 20-50V dc, 15 W nominal, 35 W max
Power Pass Through 3 xfor external aiding sensors (up to 3A per sensor)
Back Up Battery Li-ion/5 minutes
Typel/Life
Data/Comms Data Storage 8 GB internal memory

Digital Ports/Protocol

Up to 4 digital Ports/RS232 or RS485

Other Ports 1xEthernet, 4 Triggers
Output Rate Upto 100 Hz
Output Telegrams Industry standard AHRS/INS telegrams including acceleration and rotation rates**

* Estimated Weights

** Specific outputs may be limited below quoted performance for reasons of export classification and control and should not be used as IMU data.
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14.2 Type 8253-9909 SPRINT 300 4000 m 4 x Seanet®

99,027
Measurement Point

Feature Type 8253-000-9909
Depth Rating 4,000 metres
Physical Size (Dia x Length) 205 x260 mm
Weight in Air/Water* 18.5/11.5kg
Mechanical Contruction | Titanium
Connectors 4 x Seanet®
Performance Heading Accuracy 0.2° (Lodestar AHRS), 0.05° (SPRINT INS) Secant Latitude
Rolland Pitch Accuracy |0.01°
Settle Time <10 minutes in dynamic conditions (AHRS), Instantaneous (INS)
INS Aiding Supported USBL, Depth, DVL, Zero Velocity, Manual Position, LBL (position), GNSS
USBL/LBL Aided 3 x precision improvement over USBL/LBL (Position)
USBL/LBL and DVL 3to 7 x precision improvement over USBL/LBL (Position)
Aided
DVL Aided Accuracy 0.2% position error for distance travelled (3rd party DVL) 0.16% position error for distance
travelled (Sonardyne Syrinx DVL)
DVL Aiding Loss/Drift 1.2mover 1 min, 5 m over 2 mins (CEP50)
Station Keeping <1 mover 1 hour (3rd party DVL)
<1 mover 24 hours (Sonardyne Syrinx DVL)
Environmental | Temperature -20 to +55°C (operating), -20 to +60°C (storage)
Shock Rating 22 g, 11 mshalf sine
Power Power Requirement 20-50V dc, 15 W nominal, 35 W max
Power Pass Through 3 x for external aiding sensors (up to 3A per sensor)
Back Up Battery Li-ion/5 minutes
TypelLife
Data/Comms Data Storage 8 GB internal memory
Digital Ports/Protocol Up to 4 digital Ports/RS232 or RS485
Other Ports 1 x Ethernet, 4 Triggers
Output Rate Upto 100 Hz
Output Telegrams Industry standard AHRS/INS telegrams including acceleration and rotation rates**

* Estimated Weights

** Specific outputs may be limited below quoted performance for reasons of export classification and control and should not be used as IMU data.
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14.3 Type 8253-6571 SPRINT 300 6000 m 1 x Seacon

‘Seacon
MINL-16-FCRIL
Titanium

with Dust cap

Titanium

Housing and end
caps Titanium

241

Feature Type 8253-000-6571
Depth Rating 6,000 metres
Physical Size (Dia x Length) 205x280 mm
Weight in Air/Water* 22/14 kg
Mechanical Contruction | Titanium
Connectors 1xSeacon
Performance Heading Accuracy 0.2° (Lodestar AHRS), 0.05° (SPRINT INS) Secant Latitude
Rolland Pitch Accuracy |0.01°
Settle Time <10 minutes in dynamic conditions (AHRS), Instantaneous (INS)
INS Aiding Supported | USBL, Depth, DVL, Zero Velocity, Manual Position, LBL (position), GNSS
USBL/LBL Aided 3 x precision improvement over USBL/LBL (Position)
USBL/LBL and DVL 3 to 7 x precision improvement over USBL/LBL (Position)
Aided
DVL Aided Accuracy 0.2% position error for distance travelled (3rd party DVL) 0.16% position error for distance
travelled (Sonardyne Syrinx DVL)
DVL Aiding Loss/Drift 1.2mover 1 min, 5 m over 2 mins (CEP50)
Station Keeping <1 mover 1 hour (3rd party DVL)
<1 mover 24 hours (Sonardyne Syrinx DVL)
Environmental | Temperature -20 to +55°C (operating), -20 to +60°C (storage)
Shock Rating 22 g, 11 mshalf sine
Power Power Requirement 20-50Vdc, 15 W nominal, 35 W max
Power Pass Through 3 xfor external aiding sensors (up to 3A per sensor)
Back Up Battery Li-ion/5 minutes
TypelLife
Data/Comms Data Storage 8 GB internal memory
Digital Ports/Protocol Up to 4 digital Ports/RS232 or RS485
Other Ports 1 x Ethernet, 4 Triggers
Output Rate Upto 100 Hz
Output Telegrams Industry standard AHRS/INS telegrams including acceleration and rotation rates**

* Estimated Weights

** Specific outputs may be limited below quoted performance for reasons of export classification and control and should not be used as IMU data.
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14.4 Type 8253-4510 SPRINT 500 4000 m 4 x Seacon

Housing and end
Seacon Sosci caps Titanium
MINL-16-FCRIL MING-7-FCR
Titanium Titanium
with Dust cap . = with Pressura cap

Feature Type 8253-000-4510
Depth Rating 4,000 metres
Physical Size (Dia x Length) 205 x260 mm
Weight in Air/Water* 18.5/11.5kg
Mechanical Contruction Titanium
Connectors 4 x Seacon
Performance Heading Accuracy 0.1° (Lodestar AHRS), <0.04° (SPRINT INS) Secant Latitude
Rolland Pitch Accuracy 0.01°
Settle Time <5 minutes in dynamic conditions (AHRS), Instantaneous (INS)
INS Aiding Supported USBL, Depth, DVL, Zero Velocity, Manual Position, LBL (position), GNSS
USBL/LBL Aided 3 x precision improvement over USBL/LBL (Position)
USBL/LBL and DVL Aided |4 to 10 x precision improvement over USBL/LBL (Position)
DVL Aided Accuracy 0.1% position error for distance travelled (3rd party DVL)
0.08% position error for distance travelled (Sonardyne Syrinx DVL)
DVL Aiding Loss/Drift 0.8 mover 1 min, 3.2 m over 2 mins (CEP50)
Station Keeping <1 mover 1 hour (3rd party DVL)

<1 m over 24 hours (Sonardyne Syrinx DVL)

LBL & DVL Aided Accuracy |3 cm confined area, 20 cm wide area (dynamic)

‘Synthetic’ LBL Aided <20 cm @ 200 m distance to single transponder
Accuracy

Environmental Temperature -20 to +55°C (operating), -20 to +60°C (storage)
Shock Rating 22 g, 11 mshalf sine

Power Power Requirement 20-50Vdc, 15 W nominal, 35 W max
Power Pass Through 3 xfor external aiding sensors (up to 3A per sensor)

Back Up Battery Type/Life | Li-ion/5 minutes

Data/Comms Data Storage 8 GB internal memory
Digital Ports/Protocol Up to 4 digital Ports/RS232 or RS485
Other Ports 1 x Ethernet, 4 Triggers
Output Rate Upto 100 Hz
Output Telegrams Industry standard AHRS/INS telegrams including acceleration and rotation rates**

* Estimated Weights
** Specific outputs may be limited below quoted performance for reasons of export classification and control and should not be used as IMU data.
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Appendix A — SPRINT 300/500/700 Angle Definitions
A.1 Euler angles (Tate Bryan Rotations)

The “Tate Bryan” rotations given hereafter are commonly and henceforward referred to as the Euler
angles even though they are formally just a specific sequence of a larger set of possible Euler angle
rotation sequences. The Euler angle rotation sequence from NED (Earth Frame; x-North, y-East, z-
Down) to body frame is:

1. Rotation by the heading angle ¢ (phi) about Zned.
2. Rotation by the pitch angle 6 (theta) about the resulting Y axis.
3. Rotation by the roll angle y (psi) about the resulting X axis.

Similarly, the rotation sequence from a reference frame (ROV) to a sensor frame (IMU, USBL, DVL)
is:

1. Rotation by the gamma angle about Zref.
2. Rotation by the beta angle about the resulting Y axis.

3. Rotation by the alpha angle about the resulting X axis.

A.2 Heading (Azimuth, Yaw)

Heading is the angle between Xned and the projection of Xb into the horizontal plane (XYned)
measured about Zned. Heading is in the interval [0° ... 359.999°], Yaw is in the interval [-179.999° ...
+180.000°].

A.3 Pitch

Pitch is the angle between Xb and the horizontal plane (XY ned). Pitch is positive when Xb is pointed
above the horizontal plane. Pitch angle lies in the interval [-90° ... +90°].

A.4 Roll

Roll is the angle between Yb and the horizontal plane measured in the ZYb plane. Roll is positive
when Yb is pointed below the horizontal plane. Roll angle lies in the interval [ -180° ... +180°].

A.5 Gravity (Datawell) Angles

Gravity angles are typically returned by a gyro and traditional VRUs measuring the angle of the gravity
vector using 2 independent orthogonally mounted tilt sensors e.g. Datawell, TSS or Watson VRUs.
These are generally defined as follows:

A.6 Pitch

Angle between the vessel forward axis and the horizontal, positive when bow is pointed above
horizontal.

A.7 Roll

Angle between the vessel starboard axis and the horizontal, positive when starboard is pointed below
horizontal.
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A.8 Heading

Angle from the North axis to the vertical projection of the vessel forward axis onto the horizontal,
measured about the down axis.
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Appendix B — Reference Frames and Angular Conventions

B.1 SPRINT 300/500/700 Frame

The SPRINT 300/500/700 frame is a fixed right-hand coordinate frame XY Z. Typically the SPRINT
300/500/700 is mounted so that the X axis is approximately coincident with vehicle forward; the Y axis
is coincident with vehicle starboard; and the Z axis is coincident with vehicle down.

The SPRINT 300/500/700 has the X and Y directions displayed on the top of the unit as an orientation
aid during installation. Additionally, all measurements involving the SPRINT 300/500/700 should be
made with respect to the unit’s centre of axis; see UM-8084-101 Lodestar Hardware Manual.

The SPRINT 300/500/700 angular outputs are defined in Gravity (or Datawell) angles; see Appendix
A "SPRINT 300/500/700 Angle Definitions "for more information.

Figure B—1 SPRINT 300/500/700 Reference Frame

Item |Description

1 Y Axis Positive (+) Starboard
2 Orientation Marks (Forward)
3 X Axis Positive (+) Forward
4 Z Axis Positive (+) Down

B.2 Vehicle Reference Frame

For most applications, measurements are required with respect to the vehicle’s reference frame. The
definition of the vehicle reference frame is shown below.

Unless otherwise stated for a particular output telegram, the SPRINT 300/500/700 will output
measurements with respect to this frame.

Before installing the SPRINT 300/500/700 it is important to understand the concept of the vehicle
reference frame. Often the chosen centre of a vehicle’s reference frame is its centre of motion or mass
and is usually defined and documented prior to the installation of equipment such as the SPRINT
300/500/700. The centre of the vehicle’s reference frame is often referred to as the CRP or central
reference point.

In a typical installation, the SPRINT 300/500/700 may not be perfectly aligned to the installation
vehicle reference frame.
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Figure B-2 Vehicle Reference Frame

Item |Description

Positive Pitch (Bow up)
Starboard (Y)

Positive Heading Change
Down (2)

Positive Roll (Starboard Down)
Forward (X)

Ol D WIN| -

B.3 Mounting Angles

In some cases, for the SPRINT 300/500/700 to output measurements that are correct for the vehicle
reference frame, mounting angles in the three axes must be carefully measured and configured.

The rotation sequence from a reference frame (vehicle) to the actual SPRINT 300/500/700 frame is:
1. Rotation by the C (Heading) angle about the Z axis of the reference frame.
2. Rotation by the B (Pitch) angle about the resulting Y axis.
3. Rotation by the A (Roll) angle about the resulting X axis.

Note

Only the misalignment for angle C (heading) can be measured independently. The misalignments
for angles B (pitch) and A (roll) are the resultant misalignments after the preceding misalignments
have been applied.

Mounting angles are specified as Euler angles; the convention for measuring each mounting angle is
shown below.
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Note

To simplify the definition and convention of each mounting angle, each angle is depicted
independently but in practice they are non-commutative and must be measured in the order defined
previously.

Figure B-3 SPRINT 300/500/700 Heading Mounting Angle Example

*®

Item |Description

1 Heading Output (Mounting Angle +40°)
2 Positive (+) Mounting Angle Applied

3 Heading Output (Mounting Angle 0°)

Figure B—4 SPRINT 300/500/700 Pitch Mounting Angle Example
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Item |Description

1 Pitch Output (Mounting Angle 0°)

2 Positive (+) Mounting Angle Applied
3 Pitch Output (Mounting Angle +30°)

Figure B-5 SPRINT 300/500/700 Roll Mounting Angle Example *

i o ,’

Item |Description

1 Roll Output (Mounting Angle 0°)

2 Positive (+) Mounting Angle Applied
3 Roll Output (Mounting Angle +30°)

*Vehicle view is bow-on.

Note

If mounting angles for either heading, pitch or roll exceed 2°, contact Sonardyne support for
assistance.
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Appendix C — SPRINT 300/500/700 Mounting Angle Examples

C.1 Introduction

This section provides some examples of alternate SPRINT 300/500/700 mountings and the
associated “coarse” mounting angles that should be used in the system configuration.

C.2 Configuration A
If the SPRINT 300/500/700 is mounted in the following configuration:

TOP VIEW VIEW FROM
REAR OF VEHICLE

Then use the following mounting angles on the SPRINT 300/500/700 configuration:
» Heading: 0
« Resulting Pitch: 90
« ResultingRoll: 0

C.3 Configuration B

Ifthe SPRINT 300/500/700 is mounted in the following configuration:

TOP VIEW VIEW FROM
REAR OF VEHICLE

Then use the following mounting angles on the SPRINT 300/500/700 configuration:
« Heading: 180

» Resulting Pitch: -90
» Resulting Roll: 0
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C.4 Configuration C
If the SPRINT 300/500/700 is mounted in the following configuration:

TOP VIEW VIEW FROM
FRONT OF VEHICLE

Then use the following mounting angles on the SPRINT 300/500/700 configuration:
« Heading: 0
« Resulting Pitch: -90
« Resulting Roll: 0

C.5 Configuration D
If the SPRINT 300/500/700 is mounted in the following configuration:

TOP VIEW VIEW FROM
FRONT OF VEHICLE
r
Forward

Then use the following mounting angles on the SPRINT 300/500/700 configuration:
» Heading: 180
« Resulting Pitch: 90
« ResultingRoll: 0
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Appendix D — INS Message Definitions

D.1 Introduction

This section lists messages that are specific to the SPRINT (INS) system input and output. Other
messages are available for output, such as Lodestar (SPRINT) AHRS output messages; see UM-
8084-109 Lodestar AHRS Messages.

Table D-1 SPRINT Input & Output Messages

Message INS Input INS Output
GGA v v

GPGGA INGGA
NPGGA

PSIMSSB

Sonardyne External Position
DVL PD4

DVL PD5

DigiQuartz Pressure Depth
Valeport Midas SVX2 Depth
PSONDEP Depth

NMEA DPT Depth
Sonardyne External Depth
ZDA

Valeport Sound Velocity
PSONSS Sound Velocity
INS Navigation

x

x

AN NI N N N NE N N N B N RN
x

x

x

INS Navigation Quality

Time System
Sonardyne PSONNAV x
Sonardyne LNAV x

x
NERRRE

D.2 Simrad SSB — SSBL Position Report ($PSIMSSB)
Reference: Kongsberg APOS Release 4.2.2 Manual (29.April. 2005)

Description

The PSIMSSB sentence contains the position of a SSBL beacon which is sent after each USBL
measurement. The operator may define various parameters.

Format

$PSIMSSB,hhmmss.ss,ccc,a,ccc,a,a,a, X.X, X.X, X.X,X.X,a,X.X,X.X*hh <cr><|f>
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Table D-2 PSIMSSB Formatting

Field Description

$ Start character

PSIM Proprietary Simrad code

SSB Sentence Formatter

hhmmss.ss |Empty or UTC time of reception

cce Beacon code, Examples: BO1, B33, B47

a Status, A for OK, V for not OK

ccc Error_code, Empty or 3 character error code

a C for Cartesian, P for polar, U for UTM coordinates, R for radians
a Orientation, H vessel heading up; N for north; E for East:

a Software filter, M=Measured, F=Filtered, P=Predicted

X.X x coordinate

X.X y coordinate

X.X Depth in metres

X.X Expected accuracy of the position

a Additional info, N=None,C= Compass, |=Inclinometer, T=Time from Beacon to Transceiver
X.X First add value, empty or Tp compass or Tp x inclination

X.X Second add value, empty or Tp y inclination.

*hh Terminator and checksum (or empty?)

<cr><If> return plus linefeed

Supported Input Format

Sonardyne Marksman/Ranger 2 and Kongsberg HiPAP:

Appendix D — INS Message Definitions

‘ Beacon ID H WGS 84 Lat/Long ‘

-N_-_I_‘_J;—
$PSIMSSE,091430.22,B18)A (R,N,M1.28,1.8 ,13‘1.88N,,*7E
MUST be UTC || MUST be: USBL Quality
R = Radians,

N = North Orientation,
M = Measured

163



UM-8253-SPRINT
Issue A3

User Manual for Type 8253 SPRINT 3rd Generation

D.3 Proprietary $PSONDEP Report

Description

The purpose of this proprietary string is to support depth input into Sonardyne software and
instruments from a non-specific source. This string is already used in several subsea positioning
applications with both Ranger and Fusion software.

Format
$PSONDEP,x.xx,y.y,c*hh<cr><If>

Table D-3 PSONDEP Formatting

Field Description

$ Start_character
PSONDEP Address

X. XX Depth

y.y Observation Error

¢ Units (M=metres)

*hh Terminator and Checksum
<cr><If> Termination (0xOD 0x0A)

Supported Input Format

$PSONDEP,1A

Measurement Data
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D.4 Proprietary $PSONSS Report

Description

The purpose of this proprietary string is to support sound speed input into Sonardyne software and
instruments from a non-specific source. This string is already used in several subsea positioning
applications with both Ranger and Fusion software.

Format
$PSONSS, x.x,y.y,c*hh<cr><If>

Table D—4 PSONSS Formatting

Field Description

$ Start_character

PSONSS Address

X.X Depth

y.y Sound Speed in Units per second
c Units

*hh Terminator and Checksum
<cr><If> Termination (0xOD 0x0A)

Supported Input Format

$PSONSS.2011.001500.00.M*65
==

Sound Velocity
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D.5 Digiquartz Pressure Sensor Report

Description
Pressure depth output from Paroscientific Digiquartz intelligent pressure depth sensor.

Format
*0001nnn__<cr><If>

Table D-5 Digiquartz Formatting

Field Description

* Start character

00 Destination ID (00 is ID of serial host)

01 Source ID (01is ID of sender device)

nnn__ Measurement Data (units=Metres H20 / KPA / PSI)
<cr><If> return plus linefeed

Supported Input Format

*000195.247173>

Measurement Data

Appendix D — INS Message Definitions 166



UM-8253-SPRINT
Issue A3

User Manual for Type 8253 SPRINT 3rd Generation

D.6 $ DPT Report

Description

This is NMEA string outputs water depth.

Format
$_ DPT,x.x,y.y,z.z*hh<cr><I|f>

Table D-6 DPT Formatting

Field Description

$ Start_character

__DPT Address

X.X Water depth relative to the transducer, in metres
y.y Offset from transducer, in metres. (NOT USED)
z.z Maximum range scale in use

*hh Terminator and Checksum

<cr><If> Termination (0xOD 0x0A)

Supported Input Format
$SDDPT,20.3,0.0,0.0*64
- =

Measurement Data
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D.7 Valeport Sensor Telegram

Description

This simple string outputs the data from the Valeport Mini SVS sensor. Sound Velocity only m/sec
supported.

Format

<space>xxxx.xxx<cr><If>

Table D-7 Valeport Sensor Telegram Formatting

Field Description

<space> A space character

XXXX. XXX Sound Speed in metres per second
<cr><If> Termination (0x0D 0x0A)

Supported Input Format

‘ 1 or 2 leading spaces ‘
ﬂ?

Sound Velocity
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D.8 $__ GGA Report

Description
This NMEA string outputs longitude and latitude ata UTC time.

Format

$--GGA, hhmmss.ss, lllLIL,a,yyyyy.yy,a,x,xx,X.X,X.xxx,M,x.x,M,x.x,xxxx*hh<cr><|f>

Table D-8 GGA Formatting

Field Description

$ Start character

- Sender Code (IN ? or GP)

GGA Sentence Formatter

hhmmss.ss uTC

l.i,a Latitude, N/S 2 fixed digits degrees, 2 fixed digits minutes, variable digits of decimal
minutes.

yyyyy.yy,a Longitude, E/W 3 fixed digits degrees, 2 fixed digits minutes, variable digits of decimal
minutes.

X GPS quality Indicator 0-8

XX Number of satellites

X.X Horizontal dilution of precision

X.XXX,M Antenna altitude above/below mean sea level (geoid), Metres (units of antenna altitude)

X.X,M Geoidal Separation, Metres

X.X Age of Differential data, not relevant.

XXXX Differential Reference Station ID

*hh Terminator and checksum

<cr><If> Terminator, return plus linefeed

Supported Input Formats
Sonardyne Ranger:

$GPGGA(145750.00 4459.97858,N,00600.06971,E.2,07 1 .4,0.000,M,0.0,M,2,250

MUST be UTC MUST be WGS 84 Lat/Long Beacon ID

EIVA NaviPac:

$NPGGA(145750.00,4459.97858,N,00600.06971,E, ,07,.OOO,M,0.0,M,2.2,0362*5O
| 2

MUST be UTC || MUST be WGS 84 Lat/Long USBL Quality
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D.9 $ _ZDA Report

Description

This NMEA string outputs UTC,day,month,year and local time zone.
Format

$--ZD A, hhmmss.sss, XX, XX, XXXX,XX,XX*hh <cr><If>

Table D-9 ZDA Formatting

Field Description

$ Start character

- Sender Code

ZDA Sentence Formatter

hhmmss.sss Hours, minutes, seconds, and decimal seconds

XX Day, 0to 31

XX Month, 01to 12

XXXX Year

XX Local Zone hours 00to +13
XX Local Zone minutes 00 to 59
*hh Terminator and checksum
<cr><If> return plus linefeed

Supported Input Format

$GPZDA,162408.00,02,04,2007,,*6C

MUST be UTC
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D.10 Navigation (Nav) Data

The navigation (Nav) data message is the generic navigation output fromSPRINT 300/500/700 AINS
and is closely related the navigation quality message (NavQual); see Section D.11 "Navigation Quality
Estimate (NavQual)".

Note

Nav and NavQual are intended for advanced users including internal (Sonardyne) and external
system integrators. Nav values are valid for vehicle CRP / frame, except acceleration which is valid for
the IMU zero point but expressed in vehicle frame. For best accuracy it is recommended to use
CRP=IMU zero point. AINS algorithm is the only source for the NAV message.

Table D-10 Navigation Data

Byte# Field Unit (LSB) Data Note
name type
0-5/6 timeTag 1e-6 sec Uint48 |Systemtime
6-9/4 lat 27-31*90 x° [-90;90] Int32 +North (LSB ~= 0.5cm)
10-13/4 |lon 2/-31*180° [-180; 180] Int32 +East (LSB ~= 1cm @ Equator)
14-17/4 |depth 1e-3m Int32
18-19/2 |altitude 1e-2m Uint16 | Height above seabed (from DVL)
20-21/2 |roll 2-15*180° [-180; 180] Int16 Angle between y and horizontal. Roll is

positive wheny is pointed below the
horizontal (starboard down)

22-23/2 |pitch 2/-15*180° [-90;90] Int16 Angle between x and horizontal. Pitch is
positive when x is pointed above the
horizontal (bow up)

24-25/2  |heading 21-15*180° [0;360] Uint16 | Angle between North and projection of X
onto the horizontal (measured about down).
26-27/2 |vN 1e-3m/s Int16 Vehicle North-velocity (max 32 m/s)
28-29/2 |vE 1e-3m/s Int16 Vehicle East-velocity (max 32 m/s)
30-31/2 |vDwn 1e-3m/s Int16 Vehicle Down-velocity (max 32 m/s)
32-33/2  |wx 1e-2°/s Int16 Angular rate about x axis (max ~327°/s)
34-35/2  |wy 1e-2°/s Int16 Angular rate about x axis (max ~327°/s)
36-37/2 |wz 1e-2°/s Int16 Angular rate about x axis (max ~327°/s)
38-39/2 |ax 1e-3 m/s"2 Int16 X-acceleration (max ~ 3.2 G)
4041/2 |ay 1e-3 m/s"2 Int16 X-acceleration (max ~ 3.2 G)
42-43/2 |az 1e-3 m/s"2 Int16 X-acceleration (max ~ 3.2 G)
44-45/2 |mode N/A Bit16 Logical. Bit#
0: data valid
1:INS initialised

2: INS application not enable
3-14: Reserved
15: System failure
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Note

Altitude = 0 imply invalid.

D.11 Navigation Quality Estimate (NavQual)

The navigation quality message reports the expected accuracy of the data given in the “nav’ message.

Notes

Horizontal position 1DRMS = sqrt(posMajor*2 + posMinor”2)
CEP(50%) ~= 0.589 * (posMajor + posMinor).
Error ellipse (1 sigma) is 39.4% probability (i.e. 39.4% likelihood that true value is within ellipse).

95% percent probability error ellipse is 2.447 * 1 sigma error ellipse.
Roll, pitch 1 sigma ~= max(stdLevN,stdLevE) for roll, pitch << 45deg.
Velocity rms = sqrt(velMajor*2+ velMinor”2).

Table D-11 Navigation Quality Estimate — Rate: 1 Hz

Byte# Field name |Unit (LSB)/ Data Note
range type
0-5/6 timeTag 1e-6 sec Uint48 |Systemtime
6-9/4 posMajor m Float32 |Position (horizontal) error ellipse:
- semi-major axis (1 sigma)
10-13/ 4 posMinor - Float32 |- semi-minor axis (1 sigma)
14-17/4 dirPMajor deg [0;360[ Float32 |- direction of semi-major axis
18-21/4 stdDepth m Float32 |Depth (1 sigma)
22-25/4 stdLevN deg Float32 |Level error about North (1 sigma)
26-29/4 stdLevE deg Float32 |Level error about East (1 sigma)
30-33/4 stdHeading |deg Float32 |Heading (1 sigma)
34-37/4 velMajor m/s Float32 |Velocity (horizontal) error ellipse: - semi-major axis
(1 sigma)
38-41/4 velMinor m/s Float32 |- semi-minor axis (1 sigma)
42-45/4 dirVMajor deg [0;360[ Float32 |- direction of semi-major axis
46-49/4 velDown m/s Float32 |Down velocity (1 sigma)
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D.12 Time System Data

The Time System data format is defined below.

Note

Source of RTC to UTC update; 0 = NO SOURCE; 1 = SPRINT 300/500/700 RTC; 2 = Standalone
GPZDA; 3 = Standalone GPGGA; 4 = GPZDA 1PPS.

Fields in italic are for advanced users only and are subject to change.

Table D-12 Time System Data

Field# | Byte# Size Field name Unit/LSB |Data |Notes
(from 0) | (bytes) type
1 0-5 6 sysTime 1e-6sec |Uint48 |System time (and message timeTag)
2 6-13 8 utcTime 1e-6sec |Uint64 |UTC time —seconds since midnight
1970.01.01
3 14-19 6 timeSinceUpdate |1e-6 sec |Uint48 | Time since last accepted UTC time
update, e.g. from ZDA/PPS
4 20-23 4 stdDev sec Float32 | Expected standard deviation of UTC
time field
24 1 Source logical Uint8 | Currently used source of UTC sync
25 1 ppsRising logical Uint8 |0: PPS valid on falling edge
(low to high voltage).

1: PPS valid onrising edge.

26 1 zdaCount # Uint8 |[LS byte of ZDA message count

27 1 ppsCount # Uint8 |LS byte of PPS message count

28 1 zdaRejCount # Uint8 | LS byte of ZDA message rejection count
10 29 1 ppsRejCount # Uint8 |LS byte of PPS signal rejection count
11 30 1 ppsZdaProcCount | # Uint8 |LS byte of accepted PPS/ZDA pairs
12 31 1 filtResetCount # Uint8 |[LS byte of UTC filter reset count

Example: Converting IMU time tag from [sys] to [utc]

imu.timeTag[sys] = 1234567890 usec

Get the preceding time system message:

timeSys.sysTime = 1234101010 usec

timeSys.utcTime = 1254273030984001 usec

timeSys.stdDev = 0.0000124 sec low std.dev. => UTC can be trusted

imu.timeTag [utc] = imu.timeTag[sys] + (timeSys.utcTime - timeSys.sysTime)

= 1234567890 + (1254273030984001 - 1234101010) usec

=1254273031450881 usec = 20090930T011031 (ISO 8601) = 2009-09-30 01:10:31
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D.13 Midas SVX2 Depth

Description
This message is tab delimited and provides Sound Velocity, Depth, Temperature and conductivity.
Format

ssss.sss<tab>uuuu<tab>dddd.ddd<tab>xxxx<tab>tttt.ttt<tab>xxxx<tab>cccc.ccc<tab>zzzz<tab><c
r><l|f>

Table D-13 Navigation Data

Field Description

$SSS.8SS Sound Velocity in metres per second
uuuu Sound Velocity Units (M/SEC)
dddd.ddd Depth

XXXX Depth Units (DBAR)

tttt.ttt Temperature

XXXX Temperature Units (C)

ccee.cce Conductivity

zzzz Conductivity Units (MS/CM)
<cr><If> return plus linefeed

Supported Input Format

Tah
Delimited

%

1483.576 H}'SEC 0021.291 C 0000.142 MS/CM

Depth Depth
Measurement Lnits
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D.14 Proprietary XPOS Report

Description

This proprietary message provides an external position and depth.

Format

$XPOS,hhmmss.sss, llILIIILa,yyyyy.yyyyyy,a,x.xxx,x.xxx,x.xxx,d.ddd,d.ddd,aa*hh<cr><I|f>

Table D—14 XPOS Format

Field Description Units

$XPOS Start Character n/a

hhmmss.sss |UTC

[ Latitude: 2 fixed digits degrees, 2 fixed digits minutes, minimum 6 digits of decimal |Degrees
minutes (2mm resolution or better). [0;90]

a N/S

YYYYY.yyyyyy |Longitude, 3 fixed digits degrees, 2 fixed digits minutes, minimum 6 digits of Degrees
decimal minutes. [0;180]

a E/W

X. XXX posMajor — if not used then field will be null Metres

X. XXX posMinor — if not used then field will be null Metres

X. XXX dirPMajor — if not used then field will be null Degrees

d.ddd Depth —if not used then field will be Null Metres

d.ddd stdDepth —if not used then field will be Null Metres

aa Spare* n/a

*hh Terminator and Checksum

<cr><If> Carrier return and line feed

Supported Input Format

$XPO'S,215843.2535119.836684,N,17520.141409,B5 0.432,0.232,341..218,"3A<CR>{L>

N

Position

AN

Depth
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D.15 Proprietary XDepth Report

Description

This purpose of this string is to support an external depth input into Sonardyne software and
instruments from a non-specific source.

Format
$XDEPTH,hhmmss.sss,d.ddd,x.xxx,aa*hh<cr><If>

Table D-15 XDepth Formatting

Field Description

$XDEPTH Start Character

hhmmss.sss uTC...

d.ddd Depth in metres

X. XXX Depth Standard Deviation in metres
aa Spare

<cr><If> return plus linefeed

Supported Input Format

$XDEPTH,121 nﬁ.ssﬁ. 5.4, “05<CR><LF>

Depth
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D.16 Proprietary PSONNAV

Description

The purpose of this proprietary message provides output navigation which consists ofa UTC
timestamp, position, depth, attitude and heading with associated accuracy estimates.

Format
$PSONNAV,hhmmss.sss, llILIILa,yyyyy.yyyyyy,a,Xx.Xxx,X.XxX,X.Xxx,a,d.ddd,x.xxx,r.rrr,p.ppp,h.hhh,x.
XXX,a,aaaaaaa, , , , , ,*hh<cr><If>
Table D-16 Digiquartz Formatting

Field Description

& Start character

PSONNAV Address

hhmmss.sss UTC Timestamp

., a Latitude

YYYyyy.yyyyyy.a |Longitude

X. XXX Major Axis position error ellipse

X. XXX Minor Axis position error ellipse

X. XXX Direction of major Axis position error ellipse
a Position Status

d.ddd Depth

X. XXX Depth standard deviation

r.rer Roll

p.-pPpPpP Pitch

h.hhh heading

X. XXX Heading standard deviation

a Orientation status

aaaaaaa Sensor status

Crraas Null fields for future use

<cr><If> return plus linefeed

Supported Input Format

$PSONNAV,153239.443,5119.838453,N,00050.141452,W,0.155,0.155,1.861,A -
0.040,0.218,0.798,0.079,279.846,0.133,A Al,,,,,, *46<cr><If>
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D.17 LNav/LNavUTC

Description

The long navigation (LNav) and long navigation UTC (LNavUTC) data messages are two generic
navigation outputs from Lodestar INS / AHRS that differ in only what time is represented in the
timeTag field of the message. LNav contains System Time, whilst LNavUTC contains UTC. The
remaining message content is essentially the combination of the Nav and NavQual messages.

Table D—17 LNav/LNavUTC Data

Byte# Size Field Units Optional Data |Notes
(from 0) |(bytes) [name type
1-6 6 Time Tag |10 seconds No Uint48 |System Time (LNav).
(LNav)
UTC (LNavUTC), Note 1
10-® seconds
(LNavUTC)
6-10 4 Latitude  [2-31x90 deg Yes,see |Int32 |Latitude, Note 2
Note 12
11-14 4 Longitude |231x180 deg Yes,see |Int32 |Longitude, Note 3
Note 12
15-18 4 Depth 103 metres Yes, see Int32 | Depth below sea level, Note 4
Note 12
19-20 2 Altitude 102 metres Yes, see Uint16 |Height above seabed, Note 5 &
Note 12 Note 13
21-22 2 Roll 2-15x180 deg No Int16  |Note 6
23-24 2 Pitch 2-15x180 deg No Int16 |Note 7
25-26 2 Heading |2'5x180 deg No Uint16 |Note 8
27-28 2 vN 103 m/s Yes, see Int16 | Vehicle North-velocity
Note 12
29-30 2 VvE 103 m/s Yes, see Int16 | Vehicle East-velocity
Note 12
31-32 2 vDwn 103 m/s Yes, see Int16 | Vehicle Down-velocity
Note 12
33-34 2 wFwd 102 deg/s No Int16 | Angular rate about Vehicle Fwd
axis
35-36 2 wStbd 102 deg/s No Int16 | Angular rate about Vehicle Stbd
axis
37-38 2 wDwn 102 deg/s No Int16 | Angular rate about Vehicle Dwn
axis
39-40 2 aFwd 1073 m/s? No Int16 | Vehicle Fwd-acceleration
41-42 2 aStbd 10-3 m/s? No Int16 | Vehicle Stbd-acceleration
43-44 2 aDwn 103 m/s? No Int16 | Vehicle Dwn-acceleration
45-48 4 posMajor | Metres Yes, see Float32 | Horizontal position 1o error
Note 12 ellipse (Note 9):
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Table D-17 LNav/LNavUTC Data (continued)

Byte# Size Field Units Optional Data |Notes
(from 0) |[(bytes) [name type
- semi-major axis
49-52 4 posMinor | Metres Yes, see Float32 | - semi-minor axis
Note 12
53-56 4 dirPMajor |Degrees Yes, see Float32 | - direction of semi-major axis
Note 12
57-60 4 stdDepth | Metres Yes, see Float32 | 10 depth error
Note 12
61-64 4 stdLevN Degrees Yes, see Float32| 1o level error about North (Note
Note 12 10)
65-68 4 stdLevE Degrees Yes, see Float32| 1o level error about East (Note
Note 12 10)
69-72 4 stdHeading | Degrees Yes, see Float32 | 10 heading error
Note 12
73-76 4 velMajor |m/s Yes, see Float32 | Horizontal velocity 10 error
Note 12 ellipse (Note 11):
- semi-major axis
77-80 4 velMinor |m/s Yes, see Float32 | - semi-minor axis
Note 12
81-84 4 dirVMajor |Degrees Yes, see Float32 | - direction of semi-major axis
Note 12
85-88 4 velDown |m/s Yes, see Float32 | 10 down velocity error
Note 12
89-90 2 Status N/A No Bit16 |Note 14

Note 1 — For the LNavUTC the time is the time since 15t Jan 1970 with a resolution of 0.01ms.

Note 2 — Latitude, north is positive. 0.5cm resolution.
Note 3 — Longitude, east is positive. 1cm resolution at equator.
Note 4 — Depth, down is positive.

Note 5 — Approximate vertical distance from the DVL to the seabed, assuming small vehicle roll / pitch
and a flat seabed. Altitude is calculated from the last received message from the DVL: Valid beam
ranges are averaged whilst taking their direction relative to DVL down into account. Vehicle roll / pitch
and non-zero DVL mounting angles are not compensated for.

Note 6 — Roll is the angle between the Stbd-axis and horizontal. Roll is positive when Stbd is pointed
below the horizontal (starboard down).

Note 7 — Pitch is the angle between the Fwd-axis and horizontal. Pitch is positive when Fwd is pointed
above the horizontal (bow up).

Note 8 — Heading is the angle between North and projection of the Fwd-axis onto the horizontal
(measured about the down direction).

Note 9 —
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« Horizontal position 1DRMS = sqrt(posMajor*2 + posMinor”2)
« CEP(50%) ~= 0.589 x (posMajor + posMinor)
« Errorellipse (10) is 39.4% probability (i.e. 39.4% likelihood that true value is within ellipse)
« 95% percent probability error ellipse is 2.447 x 10 error ellipse
Note 10 — Roll & pitch 16 ~= max(stdLevN,stdLeVvE) for roll, pitch << 45deg.
Note 11 —Velocity RMS = sqgrt(velMajor*2+ velMinor’2)

Note 12 — Will be populated with zero values if data unavailable (e.g. INS is not initialised / DVL data
invalid)

Note 13 — Altitude is referenced from the DVL’s measurement point. It doesn’t reflect any lever arms
setup between DVL-IMU/CRP, or Remote Point setup for generation of the contents for this
message.

Note 14 - The status bits are described below (if bit = 0 then status is OK):
Table D—18 LNav/LNavUTC Status

Status | Field name Notes/Bit Set

Bit

0 bOrientationStatus | Orientation Invalid (e.g. AHRS not OK or unsettled)

1 bPosStatus Position (& Velocity) Invalid (e.g. INS not OK or not initialised)

2 bAltitudeStatus 0 indicates that the altitude field has been updated in this message compared to

the last time the LNAV message was sent. 1 indicates that the altitude data is
either old (no update from DVL since last LNAV message sent) or invalid.

Not Used Reserved for future use

bOrientationSource |0 indicates Orientation source = AHRS, 1 indicates Orientation source = INS

bSubseaUSBLUsed |0 indicates data received and some or all used within the last second, otherwise
1

6 bDepthUsed 0 indicates data received and some or all used within the last second, otherwise
1

7 bDVLUsed 0 indicates data received and some or all used within the last second, otherwise
1

8 bLBLUsed 0 indicates data received and some or all used within the last second, otherwise
1

9 bZUPTUsed 0 indicates data received and some or all used within the last second, otherwise
1

10 bXPOSUsed 0 indicates data received and some or all used within the last second, otherwise
1

11 bGPSUsed 0 indicates data received and some or all used within the last second, otherwise
1

12 bZMDUsed 0 indicates data received and some or all used within the last second, otherwise
1

13 bUSBLUsed 0 indicates data received and some or all used within the last second, otherwise
1

14-15 |Not Used Reserved for future use
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Appendix E — AHRS Message Definitions
E.1 PRDID

Description
This Proprietary ADCP (RDI) telegram consists of pitch roll and heading

Format
$PRDID,PPP.PP,RRR.RR,hhh.nh*hh*hh<CR><LF>

Field Description
$PRDID Header
Pitch Pitch, -30.0 to +30.0, degrees
Roll Roll, -30.0 to +30.0, degrees
Heading True Heading, 0 to 359.99, degrees
*hh Terminator and checksum
<CR><LF> Terminator, retumn plus linefeed
Notes

« The data string has variable length with leading zeros and minus signs added where necessary.
« Positive roll is port-side up, starboard down. Positive pitch is bow up, stern down.
« The attitude measurements contained in the data string will be in real time.

« Thereis no status indicator in the data string. This data string does include the optional checksum allowed
within the NMEA 0183 standard.

« The data string will include gyro heading information only if it is available. If there is no heading information
available, the heading field will be null.

Example
$PRDID,-0.17,-0.59,172.66*77
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E.2 TSS1

Description
The TSS proprietary string outputs accelerations, heave and roll and pitch.

Format
‘XXAAAASMHHHHQMRRRRSMPPPP<CR><LF>

Field Description
Start character
XX Horizontal Acceleration (not populated by SPRINT 300/500/700)
AAAA Vertical Acceleration, vehicle frame
S Space
M Space if positive, minus if negative
HHHH Heave
Q Status Flag, H,h,F,f. Heading or Fully aided, settled or settling
M Space if positive, minus if negative
RRRR Roll
S Space
M Space if positive, minus if negative
PPPP Pitch
<CR><LF> Terminator, retumn plus linefeed
Notes

« Vertical acceleration is positive in the up direction.
« Horizontal acceleration is not populated by the SPRINT 300/500/700.

« The motion measurements contained in the data string will be in real time, valid for the instant when the
system begins to transmit the string.

« Motion measurements include ASCII-coded decimal values.
« Heave measurements are in cm in the range —99.99 to +99.99 metres. Positive heave is above datum.

« Roll and pitch measurements are in degrees in the range —99.99° to +99.99°. Positive roll is port-side up,
starboard down. Positive pitch is bow up, stern down.

« Status flag H — The system is using heading from the settled gyrocompass.
« Status flag h— The gyrocompass heading is not settled.

« Status flag f — The system is receiving aiding data from both GGA and VTG NMEA messages but the
gyrocompass is not settled.

« Status flag F — The system is receiving aiding data from both GGA and VTG NMEA messages and the
gyrocompass is settled.

Example
:003D04 0000H-0058 -0017
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E.3 TSS2

Description

This TSS proprietary string outputs heading, heave, roll and pitch.

Format

:DDDDDSMHHHHQMRRRRSMPPPPE<CR><LF>

Field Description

: Start character

DDDDD Heading x 100 degrees

S Space

M Space if positive, minus if negative

HHHH Heave in centimetres

Q Status Flag, H,h,F,f. Heading or Fully aided, settled or settling
M Space if positive, minus if negative

RRRR Roll x 100 degrees

S Space

M Space if positive, minus if negative

PPPP Pitch x 100 degrees

E Heading status flag, as for other TSS messages
<CR><LF> Terminator, return plus linefeed

Notes

« The angle measurements are in hundredths (i.e. x 100)

« The motion measurements contained in the data string will be in real time, valid for the instant when the
System begins to transmit the string.

» Motion measurements include ASClI-coded decimal values.
« Heave measurements are in cm in the range —99.99 to +99.99 metres. Positive heave is above datum.

« Roll and pitch measurements are in degrees in the range —99.99° to +99.99°. Positive roll is port-side up,
starboard down. Positive pitch is bow up, stern down.

« Status flagis as for TSS1
o Status flag H — The system is using heading from the settled gyrocompass.
o Status flag h— The gyrocompass heading is not settled.

o Status flag f — The system is receiving aiding data from both GGA and VTG NMEA messages but the
gyrocompass is not settled.

o Status flag F — The system is receiving aiding data from both GGA and VTG NMEA messages and the
gyrocompass is settled.

« Heading Status flag can take the following values:
o A-—If Status flag above is H or h
o f—if Status flag above is f
o F —if Status flag above is F

Example

17263 0001H-0058 -0017A
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E.4 TSS3
Description
The TSS proprietary string outputs remote heave, heave, roll and pitch.

Format
:RMhhhhSMHHHHQMRRRRSMPPPP<CR><LF>

Field Description

‘R Start character and format identifier
M Space or minus sign

hhhh Remote Heave

S Space

M Space if positive, minus if negative
HHHH Heave

Q Status Flag, H,h,F,f. Heading or Fully aided, settled or settling
M Space if positive, minus if negative
RRRR Roll

S Space

M Space if positive, minus if negative
PPPP Pitch

<CR><LF> Terminator, return plus linefeed
Notes

« Afterthe start character (a colon, ASCII 3Ah) the TSS3 data string includes an upper case ‘R’ to identify the
string as using TSS3 remote heave format.

« The motion measurements contained in the data string will be in real time, valid for the instant when the
System begins to transmit the string.

« Motion measurements include ASCII-coded decimal values.
« Heave measurements are in cm in the range —99.99 to +99.99 metres. Positive heave is above datum.

« Roll and pitch measurements are in degrees in the range —99.99° to +99.99°. Positive roll is port-side up,
starboard down. Positive pitch is bow up, stern down.

« Status flag H — The system is using heading from the settled gyrocompass.
«» Status flag h — The gyrocompass heading is not settled.

« Status flag f — The system is receiving aiding data from both GGA and VTG NMEA messages but the
gyrocompass is not settled.

« Status flag F — The system is receiving aiding data from both GGA and VTG NMEA messages and the
gyrocompass is settled.

« Status flag A — General alarm

Example
:R 0001 0001H-0059 -0017
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E.5 EM1000

Description

Format suitable for use with Simrad EM series multibeam sonars.

Format
ABRRPPAAHH bytes 0-9

Byte Field Field

0 A MSB Header, 0x00

1 BB LSB Header, 0x90

2 RR LSB Roll, Range +/- 20 deg. Units 0.01 deg.
3 MSB

4 PP LSB Pitch, Range +/- 20 deg. Units 0.01 deg.
5 MSB

6 AA LSB Heave +/- 20m, units 1 cm

7 MSB

8 HH LSB Heading Range 0-359.99 deg. Units 0.01 deg.
9 MSB

Notes

« MSB = most significant byte, LSB = least significant byte

« Thedata string is a 10-byte message of 16-bit 2’s complement numbers, each expressed as two binary-
coded digits.

« Positive heave is above datum. Positive roll is port-side up, starboard down. Positive pitch is bow up, stern
down.

« The motion measurements contained in the data string will be in real time.
« The data string does not include a status flag.

« The system updates the heading field in the data string only when it receives new heading information from
the gyrocompass. Depending on the transmission rate of the gyrocompass there may therefore be a
difference between the instantaneous heading and the value included in the data output string.

« The gyro headingis NOT a 2's complement number.

Example
00900200FF730000 hex
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E.6 EM3000

Description

Format suitable for use with Simrad EM3000 series multibeam sonars.

Format
ABRRPPAAHH bytes 0-9

Byte Field

A Header, MSB, 0x00

B Header LSB, 0x90 when settled or 0x91 when unsettled
RR Roll, Range 0-359.99 deg. Units 0.01 deg.

PP Pitch, Range 0-359.99 deg. Units 0.01 deg.

AA Heave +/- 20m, units 1 cm

HH Heading Range 0-359.99 deg. Units 0.01 deg.

Notes

« MSB = most significant byte, LSB = least significant byte

» Thedata string is a 10-byte message of 16-bit 2’'s complement numbers, each expressed as two binary-
coded digits.

« Positive heave is above datum. Positive roll is port-side up, starboard down. Positive pitch is bow up, stern
down.

« The motion measurements contained in the data string will be in real time.
o The Status byte = 91h for an unsettled unit or 90h for a settled unit.

« The system updates the heading field in the data string only when it receives new heading information from
the gyrocompass. Depending on the transmission rate of the gyrocompass there may therefore be a
difference between the instantaneous heading and the value included in the data output string.

» The gyrocompass heading is NOT a 2’'s complement number.

Example
00900200FF 730000 hex
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E.7 PHTRO

Description

This proprietary Octans telegram consists of pitch and roll. This is similar to the NMEA 0183 standard.
The units for the measurements are degrees; the angles are as described below.

Format
$PHTRO,x.xx,a,y.yy,b*hh<CR><LF>

Field Description

$PHTRO Header

X.XX X.xX is the pitch in degrees

: comma

a ais ‘M’ for bow up, ‘P’ for bow down
, comma

y.yy y.yy is the roll in degrees

, comma

b bis ‘B’ for port down, ‘T’ for port up
*hh Terminator and checksum
<CR><LF> Carriage retum and linefeed characters
Notes

« The data string has variable length with a leading zero if magnitude < 1 and minus signs added where
necessary e.g. —0.59.

« By default, positive roll is port-side up, starboard down, positive pitch is bow down, stern up. The “a” and “b”
codes will be “P” and “T” respectively.

« The attitude measurements contained in the data string will be in real time, valid for the instant when the
system begins to transmit the first byte of the string.

« Thereis no status indicator in the data string.

Example
$PHTRO,-0.17,P,-0.56,B*46
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E.8 HDT

Description

NMEA True Heading

Format
$SHEHDT ,x.x,T*hh<CR><LF>

Field Description

$ Start Character

HE Talker identifier

HDT Mnemonic for true heading

, Comma separator

XXX. XXX Heading in degrees and decimal fraction
, Comma separator

T Heading Type True/Grid/Magnetic
*hh Checksum

<CR><LF> Terminator, return plus linefeed
Notes

« The Heading type indicator is always ‘T’ when transmitted by the SPRINT 300/500/700, to indicate that
heading information is with respect to true north.

Example
$HEHDT,172.597,T*20
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E.9 THS

Description

This telegram is the NMEA defined “True heading and status” telegram - actual vessel heading in

degrees true produced by any device or system producing true heading.

Format

$_ THS,XX.XX,a*hh<CR><LF>

Field Description

Field Description

$ Start Character

_ Talker identifier (HE)

THS Mnemonic for true heading and status
, Comma separator

XX XX Heading in degrees and decimal fraction
, Comma separator

a Mode indicator

*hh Checksum

<CR><LF> Terminator, return plus linefeed
Notes

« This sentence includes a “mode indicator” field providing critical safety related information about the
heading data, and replaces the deprecated HDT sentence. The sender code for a north seeking
gyrocompass is “HE”. For inertial navigation systems “IN” is used, though IN is for integrated navigation
systems, see ISO 61162-1 for details.

« Mode indicator states:
o A= Autonomous (aided with GGA and VTG)

o E = Estimated (dead reckoning, neither GGA and VTG are present)
o M = Manual input
o S = Simulator mode

o V = Data not valid (including standby)

Example
$SHETHS,172.59,E*11
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E.10 MDL

Description

This message provides heading, pitch and roll in degrees

Format

HaaaaPbccccRdeeee<CR><LF>

Field Description

H Heading start character

aaaa Heading in tenths of degrees i.e. aaa(deg).a(decimal)
P Pitch start character

b [+] bow down or [-] stern down

ccce Pitch in hundredths of degrees i.e. cc(deg).cc(decimal)
R Roll start character

d [+] port down or [-] starboard down

eeee Roll in hundredths of degrees i.e. ee(deg).ee(decimal)
<CR><LF> Terminator, return plus linefeed

Example

H1726P-0016R-0058
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E.11 TEMP

Description

This format provides the temperature of the x, y and z sensors and the x, y and z sensor cases, using
the NMEA TXT sentence.

Format
$HETXT,d,d,dd,dd,dd,dd,dd,dd,dd*hh<CR><LF>

Field Description

$ Start Character

HE Talker identifier

TXT Mnemonic for text message

d Total number of messages (01 - 99)

d Message number (01 —99)

d Text identifier (01 - 99)

dd.d X sensor temperature, degrees Celsius
dd.d Y sensor temperature, degrees Celsius
dd.d Z sensor temperature, degrees Celsius
dd.d X case temperature, degrees Celsius
dd.d Y case temperature, degrees Celsius
dd.d Z case temperature, degrees Celsius
*hh checksum

<CR><LF> Terminator, return plus linefeed

Notes

« This message follows the standard spec forthe  TXT message, where the first number is the total number
of messages, the second number is the message number and the third the text identifier.

« Following this there are 6 integer numbers and a checksum.

Example
$HETXT,1,1,66,43.1,43.5,42.9,43.8,42.9,43.9*7C
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E.12 TXT

Description

For the transmission of short text messages. Longer text messages may be transmitted by using
multiple sentences. Used particularly for additional information following an alarm condition. This
sentence is used to provide more detailed information on the cause of an alarm condition reported by a
device.

Format
$  TXT,xx,xx,xx,c—c*hh<CR><LF>

Field Description

$ TXT Header with sender code

XX Total number of sentences

XX Sentence number

XX Text identifier

cce ccc = Textual information on alarm source
*hh Checksum

<CR><LF> Terminator, return plus linefeed

Notes

« The sender code for a north seeking gyrocompass is “HE”. For inertial navigation systems “IN” is used,
though IN is for integrated navigation systems, see ISO 61162-1 for details.

Example
:0003ADA31BA8,{$INTXT,01,01,3,External Power Supply was Not Good, now cleared*2C}*55
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E.13 ALR

Description

This telegram indicates the local alarm condition and status

Format
$ ALR,hhmmss.ss,xxx,A,B,c---c*hh<CR><LF>

Field Description

$HEALR Header with compass sender code

hhmmss.ss Time of Alarm condition, UTC

XXX Unique alarm condition number (identifier) at alarm source, default 99
A Alarm condition (A = threshold exceeded, V = not exceeded)

B Alarm’s acknowledge state (A = acknowledged, V = unacknowledged)
c—cC Alarm’s description text (e.g. “External Power Supply Failed”)

*hh Checksum

<CR><LF> Terminator, return plus linefeed

Notes

« This sentence is used to report an alarm condition on a device and its current state of acknowledgement. In
particular for the SPRINT 300/500/700 it will indicate if the external power supply has failed and the unit is
running under the backup battery. When the external power is restored, the ALR report will also be sent.

« The sender code for a north seeking gyrocompass is “HE”. For inertial navigation systems “IN” is used,
though IN is for integrated navigation systems, see ISO 61162-1 for details

« The message is repeated either when the cause of the alarm changes, when an acknowledgement is
received or after 60 seconds, whichever is the sooner.

« If an acknowledgement is received, this is retained in the repeated alarm message as long as the cause of
the alarm message does not change.

Example
:0003E482E0A7,{$INALR,150951.00,099,A,V,Alarm: Status = 0x00000004*78}*7
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E.14 SON2

Description

The SPRINT 300/500/700 provides a Sonardyne proprietary SON2 telegram, consisting of UTC time,
pitch, roll and heading with an estimated heading error. The heading error of the gyro-compass
algorithm can not be measured, only estimated from the sensor noise.

Format

$PRDID,PPP.PP,RRR.RR,hhh.hh*hh*hh<CR><LF>

Field Description

Start character
hhmmsssss UTC time, hours, minutes, seconds and milliseconds
M Space if positive, minus if negative
RRRRRR Roll x 1000 degrees
M Space if positive, minus if negative
PPPPPP Pitch x 1000 degrees
M Space if positive, minus if negative
HHHHHH Heading x 1000 degrees
M Space separator
VVV Estimated variance
S Status Flag, U,u,A,a,V,v,G,g
<CR><LF> Terminator, return plus linefeed
Notes

« Positive roll is starboard down, port up.

« Positive pitch is bow up, stern down.

« The SON2 data string contains 39 characters in six data fields.

o Thetimeis UTC time expressed as time of day hours, minutes, seconds and milliseconds.
« The angle measurements are in thousandths (i.e. x 1000 degrees)

« The motion measurements contained in the data string will be in real time, valid for the instant when the
System begins to transmit the string.

« Due to the definition of the angles, the actual range of roll and pitch together are restricted. But the format
allows for roll and pitch in degrees in the range —179.999° to +180.000°. Positive roll is port-side up,
starboard down. Positive pitch is bow up, stern down.

« The precision of the heading estimate is tan-1(0/15) secant latitude rms when the filter time constant is 1
hr. o is the angular random walk ( °/v/ hr). After half an hour after start up the filter time constant is
effectively % hr and so the result is root 2 times worse. If allowed to run for 2 hours the result is \2 times
better than the 1 hour case. Note that the number is rms so only 95 % of the time is the heading precision
within 2 times the figure. An optimist would say that o is 0.007°/¥ hr. So be aware of the cost of cutting
short the settling time.

« The Status flag can take one of the following values:

o Ifthereis both VTG and GGA the status is Aora

o Ifthereis VTG only the status is V orv

o If there is GGA only the status is Gorg

o If thereis neither VTG nor GGA the status is U oru
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« Upper case denotes the Gyros have settled, lower case denotes the Gyros are settling.

« If outputting u or U status, as soon as a VTG and/or GGA is received the status changes appropriately.
However if VTG and/or GGA is not seen, it takes 5 seconds for the new (lesser) status to be updated on
the message.

Example
1152359000 000222-000022 359999 1234S

E.15 POSMV GROUP 111 Heave and True Heave

Description

This telegram contains data for delayed heave calculations along with time matched real-time heave
data. Heave sign is positive down.

Format

Byte Field Format Description / value

14 Start char $GRP

5-6 ID ushort 111

7-8 Byte count ushort 76 (Bytes)

9-16 Time 1 double seconds

17-24 Time 2 double seconds

25-32 Distance tag double metres

33 Time type byte Bit2 set = Time1 UTC time (fixed)

Bit4 set = Time2 POS time (fixed)

34 Distance type byte 0= N/A (fixed)

35-38 True heave float (,) metres

39-42 True heave RMS float [0,) metres

43-46 | Status Ulong Bit0 set = True heave valid

Bit1 set = realtime heave valid

47-50 Heave float (,) metres

51-54 Heave RMS float [0.) metres

55-62 Heave time 1 double seconds

63-70 Heave time 2 double seconds

71-74 Rejected IMU data count ulong [0,)

75-78 | Out of range data count ulong [0,)

79-80 Pad byte 0

81-82 Checksum ushort

83-84 | Group end char S#
Notes

« Time 1is the system time of validity for the data. The type of data is indicated in the time type field. UTC
time is the seconds of the week.
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« Time 2 is the system time of validity for the data. The type of data is indicated in the time type field. POS
time is the time in seconds since power on.

» The checksum is calculated so that the sum of short pairs (16 bits) over the complete telegram has a sum of
zero.

« Byteis 8 bits MSB first.

« Shortis the INTEL format 16 bits MSB first.

« Longis 32 bits MSB first.

o Floatis INTEL format from IEEE-754 floating point definition.
« Double is 8 bytes, MSB first.

« MSB = Most Significant Bit, LSB = Least Significant Bit

E.16 POSMV GROUP 113 Heave and True Heave

Description

This telegram contains quality data for delayed heave calculations.

Format

Byte Field Format Description / value

1-4 Start char $GRP

5-6 ID ushort 113

7-8 Byte count ushort 68 (Bytes)

9-16 Time 1 double seconds

17-24 Time 2 double seconds

25-32 Distance tag double metres

33 Time type byte Bit2 set = Time1 UTC time (fixed)

Bit4 set = Time2 POS time (fixed)

34 Distance type byte 0= N/A (fixed)

35-42 Heave time 1 double Seconds

43-50 Quality control 1 double 0 (fixed)

51-58 Quiality control 2 double 0 (fixed)

59-66 Quiality control 3 double 0 (fixed)

67-70 Status Ulong 0 (fixed). Quality control not used.
71-72 Pad byte 0

73-74 Checksum ushort

75-76 Group end char S#
Notes

« Time 1is the system time of validity for the data. The type of data is indicated in the time type field. UTC
time is the seconds of the week.

« Time 2is the system time of validity for the data. The type of data is indicated in the time type field. POS
time is the time in seconds since power on.

« The checksum is calculated so that the sum of short pairs (16 bits) over the complete telegram has a sum of
zero.

« Byteis 8 bits MSB first.
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« Shortis the INTEL format 16 bits MSB first.

o Longis 32 bits MSB first.

« Float is INTEL format from IEEE-754 floating point definition.
« Double is 8 bytes, MSB first.

« MSB = Most Significant Bit, LSB = Least Significant Bit

E.17 VTG

Description
This NMEA string outputs speed and course over ground (SOG & COG)

Format
$--VTG,x.x, T.x.x,M, x.x,N,x.x,K,a*hh<CR><LF>

Field Description

$ Start character

- Sender Code (e.g. GP, HE or IN )
VTG Sentence Formatter

XX, T COG, degrees True

X.X,M, COQG, degrees Magnetic
x.X,N, SOG, knots

x.x,K SOG, km/hr

a Mode Indicator

*hh Terminator and checksum
<CR><LF> Terminator, return plus linefeed
Notes

« The Mode indicator can have any of the following values:
o A= Autonomous

o D = Differential

o E = Estimated (dead reckoning)
o M = Manual input

o 8= Simulator

o N = Data not valid
Example
$GPVTG,,T,,,,N,,K*03
$GPVTG,000.00,T,,M,0.00,N,0.0,K*60
$GPVTG,000.00,T,000.00,M,20.00,N,37.04,K*4C
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Appendix F — SPRINT 300/500/700 Wiring Diagram

Figure F—1 Typical SPRINT 300/500/700 Wiring Diagram (Standard Seacon Endcap)

NEW SPRINT/SPRINT Connector/ Pin-Outs:

———— o ———————

/ SPRINTCP +E1
Power, Serial RS232 to Topside/ROV, Ethernet to Topside/ROV. Trigger In

A

I |

' |

|

| (Pin2 24V + ROV 24v+ |

| Pin1: OV (Ground) ——— ROV 0V |

| Pin11: SPRINT Rx —— ROV Tx |

| Pin 13: SPRINT Tx ROV Rx |
' Pin 8: R5232 Select ;

I }_ ROV Signal '

| Pin 3: Signal Ground Groundg :

} Pin 12 SPRINT TD+ (Join pins for RS232) :

| Pin7: SPRINT TD- One of either an RS232 Serial | |

| Pin 15: SPRINT RD+ OR an Ethemet connection to | |

| Pin 10: SPRINT RD- SPRINT topside software is [

FPin6: Trigger In + (Optional) gu:‘md. :;efof?ﬁgzogvmay :

in 9 Tri 1PPS timing connecled o : '

\fm 3. Trigger Ground triggerto SPRINT }

&

" SPRINT T2 ™

Power Out. Trigger Out & RS232/485 (e.g. LBL Tcvr)

Pin6: SPRINT Rx / TX+

Pin 5. SPRINT Tx / TX-

Pin 3: Trigger Out +

Pin 2: Trigger / Comms Ground

Pin 7: 24V + (Pass through from input)
Pin 4: 0V (Ground)

——— -

e

_—————————_— - - - —_————————————————————

SPRINT T4 ®
Power Out, Trigger Out & R5232/485 (e.g. DVL)

Pin 6. SPRINT Rx / TX+

Pin 5. SPRINT Tx / TX-

Pin 3: Trigger Out +

Pin 2: Trigger / Comms Ground

Pin 7: 24V + (Pass through from input)
Pin4: 0V {Ground) ’

e

SPRINTC1 ~,
Power Out. Trigger In & R5232 (e.q. Depth Sensor)

Pin 6: SPRINT Rx

Pin 5: SPRINT Tx

Pin 3: Trigger In +

Pin 2: Trigger / Comms Ground

Pin 7: 24V + (Pass through from input)

Pin 4: 0V (Ground) /
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Appendix G — SPRINT 300/500/700 Installation and Setup
Check List

Post-Transit Yes |No |Notes
Checks
Prior to installation on the vehicle has the SPRINT been powered and
connected to the SPRINT topside (PC & LCH) to check operation and
basic communication?
Vehicle Checks Yes |No |[Notes
Vehicle Vehicle CRP defined and identifiable?
Is Lodestar mounted rigidly and away from any source of vibration or (non-
vehicle frame) independent movement?
[Serial] Vehicle MUX connection configured/available @ 115,200 baud
rate?
[Ethernet] Vehicle MUX connection configured/available @ 100 Mbit?
Cable connection wired as per system wiring diagram?
[Serial] 232/485 select pin wired correctly?
Powered by 24 v?
Offsets from vehicle CRP to Lodestar 'Centre of Axis' measured (Metres)? Forward
Starboard
Down
Mounting Angles from vehicle frame to Lodestar frame measured Forward
(Degrees)? Starboard
NB: Notrequired if Lodestar mounted nominally: Connectors are Down
uppermost on Lodestar and 'X' orientation mark is aligned with forward
direction of vehicle body
USBL Offsets from vehicle CRP to USBL beacon (centre of transducer) Forward
measured (Metres)? Starboard
Down
If multiple USBL beacons present, has acoustic check been run on the
SPRINT aiding beacon to confirm correct address and offsets?
If SPRINT aiding beacon is responder, has responder trigger been
checked?
Depth Offsets from vehicle CRP to depth sensor (point of measurement) Forward
measured (Metres)? Starboard
Down
Cable connection wired as per system wiring diagram?
Sensor powered?
If multiple depth sensors present, has check been run on the SPRINT
aiding sensor to confirm correct offsets?
Has output format been checked (for compatability) prior to connection Format
with Lodestar or SPRINT? Units
Have serial settings been checked? Baud Rate
Data Bits
Stop Bits
Parity
LBL Offsets from vehicle CRP to the LBL Transducer measured (Metres)? Forward
Starboard
Down
Cable connection wired as per system wiring diagram?
Sensor powered?
If LBL transducers present, has check been run on the SPRINT aiding
sensor to confirm correct offsets?
DVL Offsets from vehicle CRP to DVL (centre of transducer faces) measured Forward

Appendix G— SPRINT 300/500/700 Installation and Setup Check List

199



User Manual for Type 8253 SPRINT 3rd Generation

UM-8253-SPRINT
Issue A3

(Metres)? Starboard
Down
Cable connection wired as per system wiring diagram?
DVL facing down with alignment mark facing forward on the vehicle?
NB: Misalignments can be calculated by the DVL calibration procedure
Is DVL triggered by Lodestar? (If no then DVL will be free-
running/untriggered)
DVL powered ?
If multiple DVLs present, has check been run on the SPRINT aiding DVLto
confirm correct offsets?
Can DVL be auto-configured by SPRINT (customer does have a specific
output requirement?)
If No:
Has configuration been checked (for compatability) prior to connection Format
with Lodestar? Units
Have serial settings been checked? Baud Rate
Data Bits
Stop Bits
Parity
Remote Output Is position output from SPRINT required from a point other than the
Points vehicle CRP?
If Yes:
Offsets from vehicle CRP to remote point(s) measured (Metres)? Forward
Starboard
Down
Topside Checks Yes [No |Notes
LCH IsLCH powered?
IsLCH connected to the SPRINT PC?
Can the LCH Admin Page be opended?
Lodestar [Serial] Is Lodestar connected to serial port 1 onthe LCH?
[Ethernet] Is Lodestar connected to Ethernet port 2 on the LCH?
Has the default/work site Latitude been setin the SPRINT software
(Lodestar)?
Has the Lodestar shutdown delay been checked in the SPRINT Software
(Lodestar)?
Have the Lodestar offsets been configured in the SPRINT Software
(Lodestar)?
Have the Lodestar mounting angles been configured in the SPRINT
Software (Lodestar)?
Time Synch Has output format been checked (for compatability) prior to connection Format (GPZDA)
with SPRINT?
Have serial settings been checked? Baud Rate
Data Bits
Stop Bits
Parity
Has the LCH ZDA serial port been checked/configured with the correct
serial settings?
Is GPZDA output @ 1Hz?
Does GPZDA message contain UTC time and date?
Is the latency between the GPZDA and the actual UTC time known?
Has the Time Synch been configured in the SPRINT software (Time
Synch)?
USBL Has output format been checked (for compatability) prior to connection Format
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Topside Checks

Yes

No

Notes

with SPRINT?

Have serial settings been checked?

Baud Rate
Data Bits
Stop Bits
Parity

Has the LCH USBL serial port been checked/configured with the correct
serial settings?

Is USBL position in WGS84 Latitude Longitude?

Is the USBL position the 'raw' USBL position and not corrected for offsets
or filtered/smoothed?

Does USBL message contain UTC timestamp?

Does USBL message contain USBL quality?
NB: Quality field in PSIMSSB message or in certain applications HDOP
field in USBL GGA message is populated with USBL quality

IfNo:

Has the manual USBL quality value been configured in the SPRINT
Software (USBL Input)?

Does USBL feed contain messages for multiple beacons identified by
beacon ID?

NB: Beacon ID field in PSIMSSB message or in certain applications
reference station ID in USBL GGA message is populated with beacon ID

If Yes:

Has the USBL beacon ID filter been configured in the SPRINT Software
(USBL Input)?

Have the USBL beacon offsets been configured in the SPRINT Software
(USBL Input)?

Has the USBL type been configured in the SPRINT Software (USBL
Input)?

Depth

Has output format been checked (for compatability) prior to connection
with Lodestar or SPRINT?

Format
Units

If Depth sensor feed is connected to Topside (not Lodestar):

Have serial settings been checked?

Baud Rate
Data Bits
Stop Bits
Parity

Has the LCH USBL serial port been checked/configured with the correct
serial settings?

Has the correct port been specified and configured if depth sensor is
connected directly to the Lodestar?

Does a surface correction need to be applied?

Have the depth sensor offsets been configured in the SPRINT Software
(Depth Input)?

Has the Depth type and units been configured in the SPRINT Software
(Depth Input)?

DVL

Has the correct Lodestar port been specified in the SPRINT software
(DVL)
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Topside Checks Yes [No |Notes
Has the DVL been auto-configured by the SPRINT software?
Yes
Has the DVL been 'deployed' after the auto-configuration?
No
Have the Lodestar port settings been configured to match the DVL serial
settings?
Has the correct 'triggered by Lodestar’ setting been configured in the
SPRINT Software (DVL)
Has the correct 'Binary or Hex ASCII' setting been configured in the
SPRINT Software (DVL)
If a new installation, have the default DVL mounting angles been Heading__135
configured in the SPRINT software (DVL) Pitch 0.0
Roll__-179.9
If a new installation have the latency and scale factor values been set to
zero (default) in the SPRINT software (DVL)
Have the DVL offsets been configured in the SPRINT Software (DVL)?
Sound Velocity Has the correct Sound Velocity type been specified in the SPRINT
software (Sound Velocity)?
Yes (automatic DVL derived to be used)
Has the salinity value been checked/set in the SPRINT software (Sound
Velocity)?
Yes (Manual)
Has the manual sound velocity be set in the SPRINT software (Sound
Velocity)?
Yes (Sound velocity message feed to be used)
Has input format been checked (for compatability) prior to connection with Format
SPRINT?
Have serial settings been checked? Baud Rate
Data Bits
Stop Bits
Parity
Has the LCH serial port been checked/configured with the correct serial
settings?
Sound Velocity sensor offsets are optional - have they been configured in
the SPRINT Software (Sound Velocity)?
LBL Have the serial settings for the INS port been checked in the Fusion Baud Rate
software? Data Bits
Stop Bits
Parity
Have the serial settings for the Fusion INS port been checked in the As above
SPRINT software?
Have the serial settings for the LBL port been checked in the Fusion Baud Rate
software? Data Bits
Stop Bits
Parity
Have the serial settings for the Fusion LBL port been checked in the As above
SPRINT software?
Have the LBL transceiver AND Lodestar offsets been configured in the
Fusion Software?
Has the transceiver Comms Reset been set to "None" in the Fusion
software (Transceiver Advanced)?
Has the transceiver connection been tested in Fusion (Get or Get All)?
Remote Output Is position output from SPRINT required from a point other than vehicle
Points the CRP?
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Topside Checks

Yes

No

Notes

If Yes:

Have remote point(s) offsets been configured in the SPRINT software
(Remote Points)

Outputs Have Lodestar (direct) outputs been configured in the SPRINT software
(Lodestar Outputs)?

Have PC/LCH outputs been configured in the the SPRINT software
(PC/LCH Outputs)?

INS Have the correct INS aiding options been specified in the SPRINT
software (INS Aiding)?
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Appendix H — Pressure to Depth Conversion

Pascal to Metres of head: 0.00009938710
PSIto Pascals: 6894.75729
Metres to PSI: 1.42233433
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Definitions

Term Definition

6G® Sonardyne's sixth generation technology hardware platform

AAINS Acoustically Aided Navigation System

AC Alternating Current

Accelerometer A sensor that measures changes in velocity (acceleration)

AHRS Attitude and Heading Reference System. An inertial sensor that provides outputs of
heading, pitch and roll

CRP Common Reference Point

DC Direct Current

DVL Doppler Velocity Log

FOG Fibre Optic Gyroscope

FWD Forward

GNSS Global Navigation Satellite System

IMU Inertial Measurement Unit

INS Inertial Navigation System . A navigation aid that uses inertial sensors to continuously
calculate the position, orientation and velocity of a moving object

ISA International Sensor Assembly

LBL Long Baseline

LCH Lodestar Communication Hub

LED Light Emitting Diode

Lodestar Lodestar is a combined solid state Attitude and Heading Reference System (AHRS)

MTBF Mean Time Between Failure

MWSK Mid Water Station Keeping

PC Personal Computer

RLG Ring Laser Gyroscope, A sensor that measures rotation

RMS Root Means Square

ROV Remotely Operated Vehicle

Sonardyne Sonardyne International Limited and its affiliates.

Sonardyne 6G® transponders and transceivers use Sonardyne Wideband® 2 ultra-wide bandwidth

Wideband®2 signals giving a faster and robust transmission of data, more precise ranging and mit-
igation from multipath in shallow water and amongst steel structures in deep-water.

SPRINT An Acoustically aided inertial navigation system for subsea vehicles. The system
extends the operating limits of USBL and improves the operational efficiency of LBL by
using sparse arrays

STBD Starboard

USBL Ultra-Short Baseline

uTC Universal Coordinated Time
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UTM Universal Transverse Mercator. A Projection system that is used to transform geodetic
co-ordinates into an orthogonal two-dimensional system suitable for representation on a
plane such as a chart. Normally the co-ordinates are called eastings and northings,
which are equivalent to x and y respectively. The UTM system is a worldwide system.
Each projection covers 6 degrees of longitude with the central meridian at 3, 9 degrees
etc. east of Greenwich and from 84 degrees north to 80 degrees south. The scale factor
on a central meridian is 0.9996 (with some exceptions).
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